# Contents

## Preface

### About This Guide

- Audience and Scope  
- Related Guides  

### About Digital Customer Service

- Overview of Digital Customer Service  
- Digital Customer Service Terminology  
- Digital Customer Service Roles  
- Overview of Self-Service Optimization  
- Benefits of Self Service Optimization  
- The Proxy User  
- Self-Service Optimization Architecture  
- Self-Service Optimization Security  
- Technical Compatibility  

### Mandatory Setup Tasks

- Overview of Mandatory Setup Tasks  
- Activate Digital Customer Service  
- Set Up Oracle Identity Cloud Service  
- Set Up Oracle B2B Service  
- Set Up Administrators and Developers  
- Set Up Oracle Visual Builder  

### Create a Basic Digital Customer Service Application

- Create a New Digital Customer Service Application  
- Add Mappings to User Roles  
- Set Up Authentication for Your Application  
- Stage and Publish the Digital Customer Service Application
5 Develop Your Digital Customer Service Application

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Developing Your Digital Customer Service Application</td>
<td>33</td>
</tr>
<tr>
<td>Configure Profile Options</td>
<td>33</td>
</tr>
<tr>
<td>Configure Git for Application Source Control</td>
<td>38</td>
</tr>
<tr>
<td>Secure Pages</td>
<td>39</td>
</tr>
<tr>
<td>Assign Custom Job Roles</td>
<td>39</td>
</tr>
<tr>
<td>Application Configuration Settings</td>
<td>40</td>
</tr>
<tr>
<td>Apply Themes to your Digital Customer Service Application</td>
<td>43</td>
</tr>
<tr>
<td>Change the Appearance of your Digital Customer Service Application</td>
<td>44</td>
</tr>
<tr>
<td>Custom Objects</td>
<td>44</td>
</tr>
</tbody>
</table>

6 Additional Feature Configuration

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Multiple Business Units with Digital Customer Service</td>
<td>45</td>
</tr>
<tr>
<td>Configure Reschedule Work Order Functionality</td>
<td>46</td>
</tr>
<tr>
<td>Configure Cobrowse</td>
<td>47</td>
</tr>
<tr>
<td>Integrate Chat in Your Digital Customer Service Application</td>
<td>49</td>
</tr>
<tr>
<td>Map Roles for Digital Customer Service</td>
<td>51</td>
</tr>
<tr>
<td>Set Up Products, Categories and Knowledge Articles</td>
<td>51</td>
</tr>
<tr>
<td>Create a Digital Customer Service Icon in Oracle B2B Service</td>
<td>52</td>
</tr>
<tr>
<td>Configure Proactive Knowledge</td>
<td>54</td>
</tr>
<tr>
<td>Configure the Self-Service Registration Object</td>
<td>55</td>
</tr>
<tr>
<td>Set Up Visual Navigator</td>
<td>58</td>
</tr>
<tr>
<td>Automatically Populate Key Information in Pre-Chat Form</td>
<td>62</td>
</tr>
<tr>
<td>Set Up Vanity URLs</td>
<td>63</td>
</tr>
<tr>
<td>Post-Configuration Verification Tasks</td>
<td>65</td>
</tr>
<tr>
<td>Add a B2B Service Field to the Service Request Page</td>
<td>68</td>
</tr>
<tr>
<td>Enable Your Own Sign In Pages</td>
<td>70</td>
</tr>
<tr>
<td>Configure Custom Password Reset in Identity Cloud Service</td>
<td>71</td>
</tr>
<tr>
<td>Localize Digital Customer Service for Multilingual Support</td>
<td>73</td>
</tr>
</tbody>
</table>
## 7 Users and Accounts

- Self-Service Registration .......................................................... 77
- Set Up Self-Service Registration without an Account Key Requirement .......................................................... 77
- Assign Roles to Digital Customer Service Users ......................................................................................... 78
- Set Up Customer Accounts ............................................................. 78
- Manage Registration Requests ......................................................... 83
- Manage Self-Service Users .............................................................. 84
- Import Self-Service Users .............................................................. 84
- Self-Service Contact or Account Merge ......................................................................................................... 90

## 8 Components

- Overview of Components ............................................................. 93
- Interaction Methods Components ................................................. 94
- Product and Category Components ............................................... 94
- Knowledge Management Components ......................................... 95
- Service Requests Components ........................................................ 96
- Work Order Components .............................................................. 97
- Sign In and Sign Out Components .................................................. 97
- User Components ........................................................................ 98
- Integrate Composite Component Architecture Components .............................................................. 99
- View Information about Components .............................................. 99

## 9 Life Cycle Management

- Determine Component Versions ..................................................... 101
- Determine Template Version .......................................................... 101
- Move Configuration Data from Stage to Production ........................................................ 101

## 10 Migrating to Self-Service Optimization

- Overview of Migrating Users to Self-Service Optimization .............................................................. 103
- Pre-Migration Tasks ..................................................................... 103
- User Migration ............................................................................ 106
- Post-Migration Tasks ................................................................... 114
11 Alternative Implementation Options

Implement Your Digital Customer Service Experience with REST APIs 115
Implement Chat Inlay 125
Create an Application for Self-Service Optimization with Pre-20C Template 129
Create an Application with the Standard Digital Customer Service Configuration with a 20C Template or Later 132

12 Performance

Performance Tuning Checklist 135
Optimize Your Application for Deployment 137

13 Troubleshooting

Troubleshooting 139
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 About This Guide

Audience and Scope

This guide outlines the implementation and configuration steps required to develop, configure, manage, and administer Digital Customer Service in Oracle B2B Service. To set up and work with the additional features of Oracle B2B Service, see Oracle CX Sales and B2B Service documentation on Oracle Help Center at https://docs.oracle.com.

This implementation guide is designed to be used as a starting point that shows how Digital Customer Service in Oracle B2B Service can be developed and implemented using Oracle Visual Builder. An implementor can use the documented development and configuration information in this guide to successfully deploy Digital Customer Service.

Each implementation of Oracle B2B Service is unique, and leads to the development of customer-specific applications that support their unique business requirements.

This guide describes how to deploy and configure Oracle Digital Customer Service in conjunction with Oracle Visual Builder Visual Applications. If you're using Oracle Visual Builder Classic Applications for your Digital Customer Service application (even if your Oracle version is 18B or later), refer to Implementing Digital Customer Service in Engagement Cloud Release 13 (Update 18B). The Implementing Digital Customer Service in Engagement Cloud Release 13 (Update 18B) is the documentation that’s pertinent to the Classic Applications development model.

Note: This document describes features available to users under Oracle CX Sales, Oracle B2B Service, and Oracle Engagement Cloud licensing agreements.

Related Guides

To understand more about the information covered in this guide, refer to the list of guides in the following table.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Cloud Developing Applications with Oracle Visual Builder</td>
<td>Describes how to use a web-based visual development tool to create and publish custom web and mobile applications that can integrate business objects and applications REST services to extend SaaS services.</td>
</tr>
<tr>
<td>Using Service</td>
<td>Contains information to help service managers, service personnel, and other service end users to perform day-to-day business tasks using Oracle Cloud.</td>
</tr>
<tr>
<td>Using Knowledge</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Knowledge.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Implementing Service</td>
<td>Describes how to set up Service Request Management.</td>
</tr>
<tr>
<td>Getting Started with Your Sales</td>
<td>Describes your initial implementation procedures, based on a simple sales-force-automation use case.</td>
</tr>
<tr>
<td>Implementation</td>
<td></td>
</tr>
<tr>
<td>Implementing Sales</td>
<td>Contains conceptual information and procedures needed to implement components and features.</td>
</tr>
<tr>
<td>Securing Sales and Service</td>
<td>Contains information to help setup users and sales administrators configure access to functionality and data.</td>
</tr>
<tr>
<td>Security Reference</td>
<td>Lists the predefined security data that's included in the offering.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Oracle Help Center
2 About Digital Customer Service

Overview of Digital Customer Service

Oracle Digital Customer Service is an offering within Oracle B2B Service that lets you provide your customer account users self-service access to their service requests and relevant knowledge articles through a web interface.

You can configure the Digital Customer Service application user interface to reflect a company brand. Using Oracle Visual Builder, you define root pages and styles, and include various UI components, depending on your business needs.

**Note:** To use Chat inlays in Oracle B2B Service, you must configure some profile options. For more information, see "Configure Chat Inlay" in Oracle CX Service Implementing Digital Customer Service.

Once configured and deployed, your customers can self-serve through the application and search for knowledge articles to solve their problems. Additionally, your customers can register as Digital Customer Service self-service users so they can interact with your customer service representatives through service requests, work orders, by chatting, or by cobrowsing.

Here are general overviews of the design time and of the run time architecture. The Digital Customer Service application relies on the following APIs:

- **crmRestApi.** Provides the connection to B2B Service.
- **fscmRestApi.** Provides the connection to the Oracle Application Cloud topology manager and functional setup.
- **idcsRestApi.** Provides the connection to Oracle Identity Cloud Service.
- **knowledge-service.** Provides the connection to knowledge content and search.

At design time, when developing a Digital Customer Service application, the developer logs into Oracle Identity Cloud Service to access the Visual Builder Designer and selects available application templates and components from the Component Exchange. The source code for the application can be maintained in a Git repository provided through the
Visual Builder Studio (formerly known as Developer Cloud Service). The application is built to interact with various REST services from the associated B2B Service instance. Here's a look at the design time architecture:

**Digital Customer Service Design Time Architecture**

At run time, a self service user interacts with the Digital Customer Service application that's served up from the Visual Builder runtime environment, and can make requests for a self-service account that's created for the user on Oracle Identity Cloud Service. The user can then log in to Oracle Identity Cloud Service to get authenticated access to the application and use the full functionality of the application enabled by the various REST services from B2B Service. The application may also expose Chat functionality and the ability to Cobrowse the customer's website with a customer service representative. Here's a look at the run time architecture:
Digital Customer Service Terminology

Here’s an overview of some Digital Customer Service terminology.

- **Oracle Visual Builder**: A cloud-based visual development tool that gives you easy access to data from any REST-based service. You can create and test responsive web applications and native mobile applications without installing any additional software. The visual designer lets you quickly lay out pages in your applications by dragging and dropping UI components, configuring their attributes and defining their behavior.
• **Root Page:** A page that contains the shell of your application including the header and footer and navigation components. An application can have multiple root pages.

• **Service APIs:** The REST APIs with which your Digital Customer Service application interacts.

• **Digital Customer Service Application:** The application that you build using Oracle Visual Builder that acts as the web interface for your users. The Digital Customer Service application is built using the Digital Customer Service Reference Implementation template.

• **Digital Customer Service Users:** Your customer account users who have successfully registered to use the Digital Customer Service application as self-service users. These users can have a variety of roles.

• **Digital Customer Service Templates:** The available templates you can select while creating your Digital Customer Service application. These application templates include component extensions, themes, and predefined pages and actions.

• **Digital Customer Service Reference Implementation:** This template includes several pages and business components that enable a basic support experience including: knowledge search, service request creation and management, display of work orders, chat, and self-service user management capabilities for the account administrator. The account administrator manages all of the users and roles.

**Related Topics**

• Developing Applications with Oracle Visual Builder

---

**Digital Customer Service Roles**

You can grant different roles to Digital Customer Service users in B2B Service and Oracle Identity Cloud Service. Here are some details about the privileges granted with each role in B2B Service.

**User**

The User application role is mapped to the Customer Self-Service User job role in Identity Management. The role grants the privileges to view and edit service requests created by the user, and to create service requests. The role also grants the privileges to view and update work orders on which the user is the contact. Removing this role causes the removal of all privileges. The only way to restore the privileges is to submit a new registration request.

**Account Manager**

The Account Manager role grants the privileges to view and edit all service requests and view and edit all work orders for a specific customer account. Additionally, users with the Account Manager role can create service requests. The user can perform these tasks only on accounts that they're the Account Manager for.

**Account Administrator**

The Account Administrator application role is mapped to the Customer Self-Service Account Administrator job role in Identity Management. The role grants the privileges to view and approve registration requests in the customer account for which they're the Account Administrator. Additionally, the role permits the user to assign and remove the Account Administrator and Account Manager roles, and remove user roles in user accounts that they're the Account Administrator for.

**Related Topics**

• Manage Self-Service Users
Overview of Self-Service Optimization

From the 20C release, Oracle introduced the Self-Service Optimization feature that addresses certain limitations with the previous approach.

For instance, prior to the 20C release, B2B Service used its own identity provider for authentication and authorization. As a result, Digital Customer Service self-service users who had to access data in B2B Service were required to have an account in both Oracle Identity Cloud Service and in the B2B Service identity store. The self-service registration process had to create user accounts in the B2B Service identity store, and then synchronize them to Identity Cloud Service. You also couldn't configure the B2B Service login page to match your corporate brand requirements.

Along with these limitations, the B2B Service identity provider is limited in its ability to scale as it was designed more for B2B applications rather than B2C applications. Many of the implementations oriented more to B2C require more scalability.

This is why the Proxy User Data Service makes sense. Using this implementation, users can access data in B2B Service using accounts that reside solely in Identity Cloud Service. The way it works is the individual account is created in Identity Cloud Service, and is then mapped to proxy users which you predefine in B2B Service. The user still self registers in exactly the same way from the CX Service (B2B Service and B2C Service) application. Approval in the CX Service application is still required, but the user record is created in Oracle Identity Cloud Service and a simple contact record is created in CX Service. Once the user has been approved, the contact record is created in Identity Cloud Service and a welcome email is sent out from Identity Cloud Service to the user at which point the user can create their own password.

When the user logs in to the application the only login option is by way of Identity Cloud Service. The log in information can be configured by the user. All management of users is done using the Identity Cloud Service administrations console. There's no need for user synchronization for self service users as they're already present in Identity Cloud Service.

**Caution:** Authenticated Intelligent Advisor interviews aren't supported when Digital Customer Service customers are using Self-Service Optimization. Specifically, interviews that require the user to be a known contact, or require data to be loaded or saved to CX Sales and B2B Service from Intelligent Advisor are incompatible with Self-Service Optimization. Anonymous advice interviews are supported.

Benefits of Self Service Optimization

Self-Service Optimization gives you the following benefits:

- A log in page that you can configure to match your corporate identity.
- B2B Service is still the identity provider for B2B Service users.
- A local identity provider created in IDCS for ODCS self-service users.
- Self-service users log in using ODCS through IDCS.
- Self-service users are created in IDCS rather than in B2B Service.
- There's no need for user sync from B2B Service to IDCS, thereby allowing users to log in immediately after self-service registration approval.
- User accounts no longer need to be created in B2B Service.
• There are only a small number of proxy users representing all self-service users in B2B Service.
• Self-service users are still represented as customer contacts in B2B Service.

The Proxy User

You define proxy users in B2B Service. In general, there should be one proxy user per self-service persona in B2B Service. For example, the ODCS application can be used by either Customer Self-Service users or Customer Self-Service Account Administrators. Since there are two personas, two proxy user accounts must be created and configured. You must also create an anonymous proxy user. The two proxy users that correspond to DCS application roles are:

• Customer Self-Service Users.
• Customer Self-Service Account Administrators

So, a proxy user account created for the Customer Self-Service Users role is given the Customer Self-Service User role and a proxy user account created for the Customer Self-Service Account Administrators persona is given the Customer Self-Service User and Customer Self-Service Account Administrator roles.

You give the proxy user all the function privileges or roles required by the persona. If you create a proxy user account for the Customer Self-Service Users persona give that account the Customer Self-Service User role. When you create a proxy user account for the Customer Self-Service Account Administrators persona give the account the Customer Self-Service User and Customer Self-Service Account Administrator roles.

A proxy user account is used by multiple actual users to perform REST operations in B2B Service. An actual user accessing data gets the functional privileges from the proxy user but the data privileges are based on the GUID of the actual user in IDCS. This ensures that a given user will be able to see relevant data.

Functional privileges are those that relate to actions a user can perform in user interface pages, whereas data privileges are those which concern which data a user can access.

Self-Service Optimization Architecture

Self-Service Optimization gives you greater flexibility by using proxy users in B2B Service. Whereas both a contact and a user were formerly created in B2B Service, now only a contact record is created in B2B Service, and users, created in IDCS, map to proxy users that are few in number and created during initial setup.

The proxy users define the functional privileges that are accessible to the users. A distinct proxy user represents each persona using the application.

Self-Service Optimization Security

When the user is created in Identity Cloud Service a GUID attribute is created. This attribute maps to a GUID field in the B2B Contact record.

Here’s how authentication works:

• Identity Cloud Service is the identity provider for self-service users. Identity Cloud Service uses a local identity provider to authenticate the self-service users.
• Self-service user accounts are only created in Identity Cloud Service. You just need to set the SVC_CSS_USE_FA_AS_IDP profile option to False to control this behavior. For more information, see the link to the Set Profile Options topic in Related Topics.

• You have one proxy user for each application persona. The Customer Self Service User and the Customer Service Administrator are two personas, and two separate roles.

• Each self-service user is associated with a customer contact record in B2B Service. The GUID field in the Identity Cloud Service user record maps to the GUID field in the B2B Service contact record.

• Data in B2B Service is accessed using a proxy user account with appropriate functional privileges. Proxy user data service manages access to data in B2B Service with the appropriate proxy user.

Functional Privileges of the Proxy User
Here's an overview of the functional privileges of the proxy user.

• Has all the functional privileges given to the proxy user role.

• Has the FND_IDP_PROXY_USER_PRIV privilege allowing it to act as a proxy user.

Data Privileges of the Proxy User
Data privileges given to the proxy user vary dynamically based on the actual user session. The data privilege of the proxy user is determined by using the proxy user authentication mechanism:

• The GUID of the authenticated user is taken from the HTTP header and stored into the session in B2B Service.

• The GUID is used to look up the PARTY_ID of the appropriate contact.

• Data security policy predicates are based on the PARTY_ID of the contact.

Related Topics
• Set Profile Options for Self-Service Optimization

Technical Compatibility
This topic describes the software versions that are compatible with this release of the Oracle Digital Customer Service offering.

Oracle Digital Customer Service is a cloud service. Oracle Digital Customer Service is delivered as a reference implementation application template on Oracle Visual Builder Cloud Service. When you create a new application for Oracle Digital Customer Service, use the template that matches the version of your Oracle B2B Service. For instance, if your environment is Oracle B2B Service 20C, when you create a new app use the 20C template, and if your B2B Service version is 20B, then use the 20B template, and so on.

• The Oracle Identity Cloud Service license provided with Digital Customer Service is Oracle Identity Cloud Service Foundation. For more details, see the Related Topics section.

• Oracle JavaScript Extension Toolkit (Oracle JET). Oracle Visual Builder includes Oracle JET bundled in with it and updates the version to uptake new features periodically. Oracle Digital Customer Service is compatible with the Oracle JET versions bundled with the corresponding versions of Visual Builder.

• Browsers supported by Oracle Visual Builder are listed in the Supported Browser topic in the Oracle Cloud Known Issues for Oracle Visual Builder. See the Related Topics that follow.
• Oracle Digital Customer Service isn't Break-Glass compliant as it depends on Oracle Identity Cloud Service.
• Digital Customer Service isn't supported with Symantec Blue Coat Cloud Data Protection Gateway.

How to Determine the Version of Oracle B2B Service

To determine the version of B2B Service that you have installed:

2. Select the menu next to the name of the signed-in user.
   The Settings and Actions menu appears.
3. Click About This Application.
   The About This Application dialog box is displayed. The version number appears after the word Revision.

Related Topics

• About Oracle Identity Cloud Service Pricing Models
• Oracle REST API for Oracle Engagement Cloud
• Oracle Cloud Known Issues for Oracle Visual Builder
• Determine Component Versions
3 Mandatory Setup Tasks

Overview of Mandatory Setup Tasks

Here are the mandatory tasks that are covered sequentially in this chapter. You can use these steps, like a checklist, to get your Digital Customer Service application set up:

1. Activate Digital Customer Service
2. Set Up Oracle Identity Cloud Service
   a. Locate the Oracle Identity Cloud Service URLs
   b. Set up Oracle Identity Cloud Service for Authentication
   c. Create the Application Client
   d. Create Groups in Oracle Identity Cloud Service
   e. Configure the Resend Welcome and Password Recovery Email Templates
   a. Enable Digital Customer Service
   b. Configure a User Category for Proxy Users
   c. Create the Proxy Users
   d. Set Profile Options for Self-Service Optimization
   e. Set the Oracle Identity Cloud Service Endpoint
   f. Configure the Client ID and Client Secret
   g. Manage the Proxy User Configuration Data
   h. Set Proxy User Credentials
4. Set Up Administrators and Developers
   a. Overview of Digital Customer Service Developer Roles
   b. Create an Internal Customer Account
   c. Create the Developer APPID User
   d. Create a Self-Service User Account for the Developer Through REST API
   e. Approve the User
   f. Add Visual Builder Roles
5. Set Up Oracle Visual Builder
   a. Retrieve the Oracle Visual Builder Designer URL
   b. Verify Your Oracle Visual Builder Settings

Activate Digital Customer Service

After ordering Oracle Digital Customer Service, you receive a welcome email from Oracle. Use the instructions in this email to activate your new service, Oracle Digital Customer Service.

1. Open the email you received from Oracle Cloud.
2. Review the information about your service in the email, then click Activate.

3. Enter any required information in the form, then click Create Account to submit your request for an Oracle Cloud account.

4. If you don't have the Welcome email, use the following instructions to activate your service:
   a. In your browser, enter: https://www.oracle.com/.
   b. Click View Accounts, then click Sign in to Cloud.
   c. Enter the name of your Cloud Account if you're signing in to a Cloud Account with Identity Cloud Service.
   d. Make a note of your Cloud Account URL, or bookmark it.
   e. Once logged in, click on the Manage Accounts tile.
   f. Click the Activate link, then select Digital Customer Service.
   g. Activate the service by completing the form.

If you don't know your Cloud Account name, then click Get help and enter the email address associated with the Cloud Account. Oracle will then send you an email with a summary of your account information.

| Note: This isn't a Traditional Cloud Account and typically correlates to your CX Service instance name. |

Set Up Oracle Identity Cloud Service

Locate the Oracle Identity Cloud Service URLs

After activating your new Oracle Cloud account, here’s how you locate your Identity Cloud Service URLs.

1. Log in to your Oracle Cloud account by navigating your browser to: https://www.oracle.com. This account is also known as your Administrator Account.
2. Click View Accounts, then Sign in to Cloud.
3. Enter the Cloud Account name if known, otherwise click Forgot Your Cloud Account Name? Get Help.

| Note: The Cloud Account often corresponds to the name of the production pod |

4. Now, click the Identity Cloud tile on the My Services dashboard. The Identity Cloud Service instances correspond to each CX Service applications pod by name.

   On the My Oracle Services page, the Identity Cloud Service URLs that correspond to each CX Service applications pod are listed by name.
5. Click the tile or link for the Identity Service Instance that corresponds to the pod name and log in using your Oracle Identity Cloud Service Administrator credentials.

Set Up Oracle Identity Cloud Service for Authentication

The login is set to use B2B Service by default. This task will show you how to configure Identity Cloud Service for authenticating your VBCS application.

1. Login to Identity Cloud Service as the Administrator user.
2. Click the Navigation drawer and then expand the Security list.
3. Click IDP Policies.
4. Click Add.
5. In the **Policy Name** field, enter a policy name, such as VBCS Login Policy, and click the **Next** icon.

6. On the **Add Identity Provider Roles** page, click the **Add Rules** button.

7. In the **Rule Name** field, enter a rule name, then click the **Assign Identity Provider** field and choose an identity provider.

   If you use B2B Service as your identity provider you will use Single Sign On (SSO) authentication. If you choose user-password you will use Oracle Identity Cloud Service.

8. Click **Save**.

9. Click the **Next** icon.

10. On the Apps page, click the **Assign Apps** button to add the VBCS application.

11. Select the application starting with **VBINST_** and click **OK**.

12. Click **Finish** to complete and save the settings.

### Create the Application Client

B2B Service must be configured with the credentials of an application client it will use to interact with IDCS. Use the IDCS Administrator Console to obtain appropriate application client credentials. You will either create an application client or get the Client ID and Client Secret of an existing client application.

Assuming you need to create an application to use, follow these steps:

1. Login to IDCS as the Administrator user.

2. Click the Navigation drawer and then expand the **Applications** list.

3. Click the **Add** icon.

4. Choose **Confidential Application**.

5. In the Name field enter **Proxy User Data Service App** and click **Next**.

6. Select **Configure this application as a client now** option.

7. In the Authorization area, select the **Client Credentials** option for Allowed Grant Types.

8. In the Token Issuance Policy area, for **Grant the client access to Identity Cloud Service Administrator APIs**, click **Add**.

9. In the **Add App Role** dialog box, select **User Administrator**, and click **Add**.

10. Click **Next**, and then on the Resources page, click **Next** again.

11. In the **Web Tier Policy** page, click **Next** again.

12. On the **Authorization** page, click **Finish**.

13. From the **Application Added** dialog box, record the **Client ID** and **Client Secret** and then click **Close**.

14. Click **Activate**, and then in the confirmation dialog box, click **OK** to activate the application.

### Create Groups in Oracle Identity Cloud Service

Use this task only if required. The groups shown in this task may already be in place. The groups will be in place if you have previously run the Identity Cloud Service user import job. If the groups are present, validate them before proceeding.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>External ID</th>
<th>Related Profile Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Self-Service User</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_USER</td>
<td>SVC_CSS_USER_ROLE_COMMON_NAME</td>
</tr>
</tbody>
</table>
### Role Name | External ID | Related Profile Option
---|---|---
Customer Self-Service Account Administrator | ORA_SVC_CUSTOMER_SELF_SERVICE_ACCOUNT_ADMINSTRATOR_ABSTRACT | SVC_CSS_ACCT_ADMIN_ROLE_COMMON_NAME

**Note:** If you have changed the value of the profile options listed in the last column of the following table, then the external ID shown in the table should not be used, instead the external ID will depend on the value of the profile option.

Use the following CURL command to get the access token.

**Note:** We recommend that you import the CURL command into POSTMAN as raw text and execute it from there.

The data returned is in JSON format. Copy the value of the access_token attribute and use it with the curl commands used to create the groups.

**Note:** Refer to the previous section Create the Application Client and use the Client ID and Client Secret that were recorded in that task for the following command.

```bash
curl --location --request POST 'https://{{IDCS HOST}}/oauth2/v1/token' 
-u '{{CLIENT_ID}}:{{CLIENT_SECRET}}' 
--header 'Content-Type: application/x-www-form-urlencoded' 
--data-urlencode 'grant_type=client_credentials' 
--data-urlencode 'scope=urn:opc:idm:__myscopes__'
```

By default, the related profile options reflect the preceding table. If custom roles are used, the Role Name and Display Name values must match the value of the relevant profile option. Here’s an example of the REST API call:

```json
curl --include --location --request POST 'https://{{IDCS HOST}}/admin/v1/Groups' 
--header 'Content-Type: application/json' 
--header 'Authorization: Bearer {{ACCESS_TOKEN}}' 
--data-raw '{
  "displayName": "Customer Self-Service User",
  "externalId": "ORA_SVC_CUSTOMER_SELF_SERVICE_USER_ABSTRACT",
    "creationMechanism": "api",
    "description": "Example Description"
  },
  "schemas": [
    "urn:ietf:params:scim:schemas:core:2.0:Group",
    "urn:ietf:params:scim:schema:extension:custom:2.0:Group"
  ]
}'
```

To check other roles, replace ORA_SVC_CUSTOMER_SELF_SERVICE_USER_ABSTRACT with the role code.

To verify the groups are present use the following CURL command:

```bash
curl --location --request GET 'https://{{IDCS HOST}}/admin/v1/Groups?filter=externalId%eq%22ORA_SVC_CUSTOMER_SELF_SERVICE_USER_ABSTRACT%22' 
--header 'Authorization: Bearer {{ACCESS_TOKEN}}'
```
Configure the Resend Welcome and Password Recovery Email Templates

When a user is created in Identity Cloud Service, the user record is inactive. After all the data related to the user is stored in the appropriate locations, the user is activated again and an API call is made to resend the Welcome email. To prevent a user from receiving multiple emails and to ensure the user sees the appropriate welcome message you have two configuration tasks depending on the scenario.

You use the Resend Welcome template when a new user has signed up.

You use the Password Recovery template when the user has been migrated.

Here are both tasks:

Configure the Resend Welcome Template

Here's how you configure the Resend Welcome template:

1. Log in to Identity Cloud Service as a user with Administrative access
2. From the Navigation drawer, select Settings, and then Notifications.
3. Click the Configure tab.
4. Deselect the Welcome and User Activation check boxes.
5. Make sure the Resend Welcome check box is selected.
6. Click Save, then when the confirmation pop up window appears click OK.
7. Click the Email Templates tab.
8. Expand the Resend Welcome template, and replace the existing Subject line and message text with you own information and click Save.

Configure the Password Recovery Template

And here's how you configure the Password Recovery template:

1. Log in to Identity Cloud Service as a user with Administrative access
2. From the Navigation drawer, select Settings, and then Notifications.
3. Click the Configure tab.
4. Deselect the Welcome and User Activation check boxes.
5. Make sure the Password Recovery Request check box is selected.
6. Click Save, then when the confirmation pop up window appears click OK.
7. Click the Email Templates tab.
8. Expand the Password Recovery Request template, and replace the existing Subject line and message text with you own information and click Save.

Set Up Oracle B2B Service

Enable Digital Customer Service

You must enable Digital Customer Service in B2B Service to have access to the following profile options and work areas. Once enabled, the following work areas are grouped with the Service icon in B2B Service:

- Self-Service Users
• Registration Requests

Once enabled, the profile options are available in the following work areas:

• Manage Digital Customer Service Account Setup Profile Options
• Manage Digital Customer Service Profile Options

To enable the Digital Customer Service Application:

1. Sign in to B2B Service as an administrator or a setup user.
2. In the Setup and Maintenance work area select the Service offering.
3. Click the Change Feature Opt In link.
   The Opt In: Service page is displayed.
5. Click Done.


Related Topics
• Configure Profile Options
• Manage Setup Using Offering Functional Areas

Configure a User Category for Proxy Users

You can configure the proxy users to have a different password expiry policy. Doing so is strongly encouraged as it ensures that the regular password expiry rules don’t apply to proxy users. To do this, you can create a different user category for the proxy users.

To create a category specific for proxy users that uses a password policy that doesn’t expire passwords:

2. Navigate to the Security Console work area and click the User Categories tab.
3. Click Create.
   The User Category: Details page appears.
4. Click Edit.
5. Enter a name in the User Category Name field, such as ProxyUsers.

   **Note:** Note this field can’t contain spaces or special characters.
6. Click Save and Close.
7. Click Password Policy.
8. Click Edit.
9. Configure the fields for the proxy user password policy. In particular, you may want to set the Days Before Password Expiration to a relatively high number and give sufficient time for the Days Before Password Expiry Warning.
10. Click Save and Close.
11. Click Done.
Create the Proxy Users

Though it’s not required, it’s strongly recommended you use the syntax shown in the following table when you create your proxy user accounts.

1. Sign in to B2B Service as an administrator or setup user.
2. Click Navigator, then from the Tools menu, select Security Console.
3. In the Security Console work area, click the Users tab.
4. Click Add User Account.
5. Now, one at time, add three separate users and grant them roles by doing the following:
   a. From the User Category drop down list, select ProxyUsers.
   b. Fill in the First Name, Last Name, and Email fields.

   **Note:** The User Name field auto fills with the email address user name. Overwrite that in the following step.

   c. In the User Name field, choose one of the entries in the following table (PUDS_CSS_USER, PUDS_CSS_ADMIN, or PUDS_ANONYMOUS_USER).
   d. Enter a password, then confirm the password.

   **Note:** Passwords must be at least eight characters long.

   e. Click Add Role.
   f. In the Search field, enter the value listed in the Roles Granted column of the following table that corresponds with the user you have created.
   g. When the role is found, click Add Role Membership, and then click Done.
   h. Click Save and Close and repeat these steps for each of the three users you must create.

<table>
<thead>
<tr>
<th>User</th>
<th>Roles Granted</th>
<th>Role Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUDS_CSS_USER</td>
<td>Customer Self-Service Proxy User</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_PROXY_USER</td>
</tr>
<tr>
<td>PUDS_CSS_ADMIN</td>
<td>Customer Self-Service Proxy Account Administrator</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_PROXY_ACCOUNT_ADMINISTRATOR</td>
</tr>
<tr>
<td>PUDS_ANONYMOUS_USER</td>
<td>Customer Self-Service Proxy Anonymous User</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_PROXY_ANONYMOUS_USER</td>
</tr>
</tbody>
</table>

Set Profile Options for Self-Service Optimization

Now you enable a number of profile options.

1. Sign in to B2B Service as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
   - Task: Manage Digital Customer Service Profile Options.

3. Use the following table to set values for each of the profile options listed:

<table>
<thead>
<tr>
<th>Profile Option and Description</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>FND_IDP_PROXY_USER_WHITELIST</td>
<td>None</td>
<td>Enter a comma-separated list of proxy user names.</td>
</tr>
<tr>
<td>Used to identify the list of allowed proxy users.</td>
<td></td>
<td>Note: There must be no spaces between the commas and the names.</td>
</tr>
<tr>
<td>ORACLE.ADF.VIEW.ALLOWED_ORIGINS</td>
<td>None</td>
<td>* or specific comma-separated FQDNs.</td>
</tr>
<tr>
<td>List of trusted domains that can make requests.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CORS_ACCESS_CONTROL_ALLOW_HEADERS</td>
<td></td>
<td>Add these values, in the comma separated list, if they're not present:</td>
</tr>
<tr>
<td>Specifies comma-separated list of headers that are allowed as part of a CORS request.</td>
<td></td>
<td>Puds-Access-Token, kmauthToken, content-language, X-Oracle-ABCS-SessionId, X-Oracle-ABCS-UserId</td>
</tr>
<tr>
<td>SVC_CSS_PUDS_CACHE_DURATION</td>
<td>15 minutes</td>
<td>Any changes to this parameter will force a refresh of the proxy users configuration data cache.</td>
</tr>
<tr>
<td>Determines the amount of time, in minutes, that Proxy User Data Service objects are cached.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SVC_CSS_USE_FA_AS_IDP</td>
<td>False</td>
<td>Make sure this value is set to False for self-service optimization mode.</td>
</tr>
<tr>
<td>Identifies if self-service users are created in B2B Service or in IDCS.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Set the Oracle Identity Cloud Service Endpoint

Now you configure B2B Service to enable back end communication with IDCS.

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area.
3. Click the Tasks icon, then click Manage Setup Content.
4. Click Manage Integration of Additional Applications.
5. In the Search Results area, click the Actions menu, and select Create.
6. In the Create Application Integration form, enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter this value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>IDCS_REST_ENDPOINTAPP</td>
</tr>
<tr>
<td>Full URL</td>
<td>For example: https://&lt;IDCS HOST&gt;/admin/v1</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is the IDCS host that authenticates the Visual Builder instance.</td>
</tr>
<tr>
<td>Partner Name</td>
<td>IDCS</td>
</tr>
</tbody>
</table>

7. Click the Apply button and then verify the Protocol, Server Host and Context Root details are populated in the Server Details area.
8. Click Save and Close.

**Configure the Client ID and Client Secret**

Add the client ID and client secret that came from your confidential application on IDCS to your B2B Service configuration. First, though perform the prerequisite task.

| Note: | Use the client ID and secret that you created earlier in the Create the Application Client topic.

**Prerequisite**

In Oracle B2B Service, Release 20D, if the Identity Cloud Service client credential has never been set and you try to bring up the Manage Client Credentials for Proxy User Data Service task from the Setup and Maintenance screen the following error is displayed:

Unable to retrieve content. Additional information for "Remote Region error #1": An error occurred while invoking task Manage Client Credentials Proxy User Configuration Data. Review the FunctionalSetupServer logs for more details on this error. Contact your help desk.

To avoid this error, set the client credentials using the SOA Composer tool. If you set the client credentials and then bring up the Manage Client Credentials for Proxy User Data Service task in the Functional Setup Manager, the task will work as expected.

Here's how you do it:

2. Log in as a user with the Application Implementation Consultant role.
3. Click the Manage Security link.
4. Enter the fa-dcs-idcs-oauth.clientcreds.csf.key in the csf-key field.
5. Enter the Client ID in the User Name field.
6. Enter the Client Secret in the Password and Confirm Password fields.
7. Click Register.
Configure the Client ID and Client Secret
Now you add the client ID and client secret that came from your confidential application on IDCS to your B2B Service configuration.

1. Sign in to B2B Service as an administrator or a setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
   - Task: Manage Client Credentials for Proxy User Data
3. Enter the Client ID and Client Secret.
4. Click Test to make sure the values you entered are valid, and then click OK if so.
5. Click Save and Close.

Note: The credentials are cached by the Proxy User Data Service. These credentials can be cleared or refreshed by changing the value of SVC_CSS_PUDS_CACHE_DURATION profile option.

Manage the Proxy User Configuration Data
This task provides for managing all the URL patterns that you need to reach in B2B Service through the proxy user data service. The fields are prepopulated in B2B Service with all of the endpoints that are used in the ODCS reference implementation. Standard use case is to set the proxy user credentials.

If you need to add any additional objects, do the following:

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
   - Task: Manage Proxy User Configuration Data.
3. For predefined configuration data note the following:
   - You can add new configuration data.
   - Only allowlisted resources can be exposed to anonymous users. The following resources are on the allowlist:
     - categories
     - catalogProductItems
     - catalogProductGroups
     - productGroupHierarchies
     - fndStaticLookups
     - selfRegistrations
     - chatAuthenticate
     - dynamicLinkPatterns
   - Custom objects that you create with Application Composer can be exposed to Anonymous users even though they're not on the allowlist.
4. To add new objects, do the following:
   a. In the Search Results area, click the **New (+)** icon.
   b. Add the URL pattern.
   c. Click the drop down list and add the HTTP method.
   d. Click the drop down list and choose the appropriate user role.
   
   **Note:** This is the same user role from Identity Cloud Service.
   e. Add the appropriate proxy user key.
   f. Click **Active**.
5. Click **Save and Close**.

**Note:** Proxy user configuration data is cached for a duration specified by the SVC_CSS_PUDS_CACHE_DURATION profile option.

If this value is changed then the cache is cleared. For changes made using this UI to be read immediately, the value of SVC_CSS_PUDS_CACHE_DURATION profile must be altered. The recommended action is to add or subtract 1 minute from the existing value.

### Set Proxy User Credentials

Complete the configuration of the proxy user configuration data for the Self-Service Optimization feature, you need to set the user credentials for the proxy users.

1. Sign in to B2B Service as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
   - Task: Manage Proxy User Configuration Data.
3. Locate any line referencing the following proxy user keys:
   - PUK#_ANONYMOUS_USER
   - PUK#_SELF_SERVICE_USER
   - PUK#_SELF_SERVICE_ACCOUNT_ADMIN
4. Do the following with each of the three user keys:
   a. Select the entry, then from the **Actions** menu, click **Edit**.
   b. In the Edit Proxy User Configuration Data workspace, enter the Proxy User Name if it's different from the default name.
   
   **Note:** It's recommended that you retain the proxy user names.
   c. Enter the password for the proxy user.
   d. Click **Save and Close**.

Since the same proxy user key is used by multiple URLs, you can edit any one URL that uses this proxy user key to set the proxy user credentials associated with that key.
Set Up Administrators and Developers

Overview of Digital Customer Service Developer Roles

To work with business objects relevant to Digital Customer Service, the developer must be a Digital Customer Service user and must be granted the appropriate roles. Here’s an overview of the tasks you need to perform:

1. Create an Internal Customer Account (This task only needs to be done once)
2. Register the Developer as a Self-Service User Through the REST API (must be completed for every developer).
3. Approve the User (must be completed for every developer).
4. Add User Roles
5. Create the Developer APPID (This task only needs to be done once).

Create an Internal Customer Account

Before creating the Digital Customer Service developer or administrator users, an internal customer account must be created for use by these users. The internal customer account lets you associate your staff to a specific account. An account key is required when creating a new Digital Customer Service user.

**Note:** You only need to create the internal customer account once. This internal customer account can be used by all Developers and Administrators.

To create an internal customer account:

2. Navigate to the Service work area and click Accounts.
3. Click Create Account.
4. Enter the Name.

**Note:** The name that you enter in this field represents the AccountKey that you need to use in the Create a Self-Service User Account for the Developer Through REST API topic. This is true only if the value of the profile option SVC_CSS_ACCT_KEY_FIELD hasn't been changed.

5. Select Customer from the Type menu.
6. Click Save and Close.

Create the Developer APPID User

Now you create a Developer APPID. This user will be shared by all the developers to communicate with B2B Service. The user account is used in the Oracle Visual Builder Cloud Service preview mode and from the VBCS design time.

2. Navigate to the Security Console work area and click the Users tab.
3. Click **Add User Account**.
4. Enter the values for the required fields.
5. Click **Add Role**.
6. In the Add Role Membership dialog box, search for the following roles, and after locating each role, click **Add Role Membership**:
   - Customer Self-Service Application Developer
   - Customer Self-Service User
   - Customer Self-Service Account Administrator
7. After you have successfully added all three roles, click **Done**.
8. Click **Save and Close**.

### Create a Self-Service User Account for the Developer Through REST API

Creating a self-service user account for the developer can be done using REST API. This task requires you to use the Postman or another REST API Tool.

Here are the parameters and associated values that are needed to create a self-service user account for a developer through REST API:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td></td>
</tr>
</tbody>
</table>

- *[Oracle Cloud Applications Instance Host name]/crmRestApi/resources/11.13.18.05/selfRegistrations

**Note:** The attribute value "*[Oracle Cloud Applications Instance Host name]*" shown in this example represents the fully qualified domain name of the host of the Oracle B2B Service instance.

<table>
<thead>
<tr>
<th>Authorization</th>
<th>Basic Auth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The user name of the user you created in the Create the APPID User section.</td>
</tr>
</tbody>
</table>
| Header        | Accept - application/json  
|               | Content-Type - application/vnd.oracle.adf.resourceitem+json |
| Action        | Post |

<table>
<thead>
<tr>
<th>Payload</th>
</tr>
</thead>
<tbody>
<tr>
<td>{</td>
</tr>
<tr>
<td>&quot;AccountKey&quot;: &quot;&lt;internal_customer_account&gt;&quot;,</td>
</tr>
<tr>
<td>&quot;EmailAddress&quot;: &quot;<a href="mailto:user_email@companydomain.com">user_email@companydomain.com</a>&quot;,</td>
</tr>
<tr>
<td>&quot;LoginId&quot;: &quot;&lt;user_login&gt;&quot;,</td>
</tr>
<tr>
<td>&quot;PersonFirstName&quot;: &quot;&lt;user_firstname&gt;&quot;,</td>
</tr>
<tr>
<td>&quot;PersonLastName&quot;: &quot;&lt;user_lastname&gt;&quot;</td>
</tr>
<tr>
<td>}</td>
</tr>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>-----------</td>
</tr>
</tbody>
</table>

Where the `<internal_customer_account>` is the internal customer account that you created in the previous task. The same internal customer account can be specified for all administrators and developers. The `<user_login>` is the ID that you want to use to sign in. The `<user_email@companydomainname.com>` is the email of the Digital Customer Service user that you’re creating.

**Note:** We recommend that you import the CURL command into POSTMAN as raw text and execute it from there.

For example, you can create Jane Smith, a self-service user account for the developer through REST API, by running the following command in POSTMAN.

**Note:** The login ID is optional. If the login ID isn't specified, the value used is the value that's assigned to the `SVC_CSS_SIGN_IN_ATTR_NAME` profile option. The default value of `SVC_CSS_SIGN_IN_ATTR_NAME` is email address.

```
curl -v -u user:pppssww -X POST \
https://{{mydepoloyment.mycompanydomain.com}}/crmRestApi/resources/11.13.18.05/selfRegistrations \
-H 'Accept: application/json' \
-H 'Content-Type: application/vnd.oracle.adf.resourceitem+json' \
-d '{"AccountKey": "My Company", "PersonFirstName": "Jane", "PersonLastName": "Smith", "EmailAddress": "jane.smith@mycompanydomain.com"}'
```

**Note:** Run this command using the previously created PUDS_ANONYMOUS_USER.

The user will be created with a **Status** of **Pending** if the auto-approve feature is disabled.

**Approve the User**

Once the Administrator or Developer user is created, it remains in a **Pending Status** until it's approved in Oracle B2B Service. You must approve the user, then you must assign the appropriate role.

**Note:** If it's the first user approved for this account, the user will automatically have the account administrator role. For all subsequent users, the Account Administrator role must be assigned.

For more information about approving the user, refer to Manage Registration Requests in the Related Topics. For more information about assigning the Digital Customer Service Account Administrator role, refer to Manage Self-Service Users in the Related Topics.

**Related Topics**

- Manage Registration Requests
- Manage Self-Service Users

**Add Visual Builder Roles**

This topic describes how to add roles in Oracle Visual Builder and Oracle Visual Builder Studio to configure appropriate authorization for your Oracle Visual Builder platform and editor.

1. **In Identity Cloud Service**, click the Navigation Drawer, and select **Oracle Cloud Services**.
2. Select your Visual Builder instance.
3. Click the Application Roles tab.
4. Assign the Oracle Visual Builder ServiceDeveloper role to your users that require build and maintain access in the Oracle Digital Customer Service applications.
5. Assign the Oracle Visual Builder ServiceAdministrator role for users that require administrative access to configure instance-wide settings for the Oracle Visual Builder environment for all applications.

For instructions about completing this task, refer to Assign User Roles in the Related Topics. Additionally, you can learn more about roles and privileges in Oracle Visual Builder by referring to the Privileges Available to Roles in Oracle Visual Builder in the related topics.

**Tip:** You can use the filter to help you locate your instance. For Oracle Visual Builder instances you might want to search for the name of your instance prefixed with "VBINST" (for example "VBINST_").

**Note:** The following VB Studio steps apply only to one pod, typically your TEST instance. VBCS, however, is provisioned on all pods so those steps for the Application Roles are applicable to all instances.

1. Add Oracle Visual Builder Studio developer roles:
   a. Sign in to Identity Cloud Service, click the Navigation Drawer, and select Oracle Cloud Services.
   b. From the Oracle Cloud console dashboard, navigate to the Identity Cloud console and click Applications.
   c. Click the link for your Oracle Visual Builder Studio instance. You can use the filter to help you locate your instance. For Oracle Visual Builder Studio instances you might want to search for your instance prefixed with "DevServiceAppAUTO".
   d. Click the Application Roles tab.
   e. Grant a role to users:
      i. Click the menu options icon shown next to the role, and select Assign Users. If you want to assign the role to a group, you need to select Assign Groups.
      ii. Select the check box next to the name of each user that you want to add to the role, and then click Assign.

   **Note:** You will need to add the DEVELOPER_USER or the DEVELOPER_ADMINISTRATOR user roles. For more information about these roles, refer to the Identity Domain Roles in the Related Topics.

**Related Topics**
- Assign Users to Roles
- Privileges Available to Roles in Oracle Visual Builder
- Identity Domain Roles

---

**Set Up Oracle Visual Builder**
Retrieve the Oracle Visual Builder Designer URL

You will need to be able to access Oracle Visual Builder in the tasks in this section, as well as many other topics in this document. This task describes how you locate the Oracle Visual Builder designer URL in your B2B Service deployment. This URL is the one that you will need whenever you want to access Oracle Visual Builder.

To retrieve the Oracle Visual Builder designer URL:

1. Sign in to B2B Service as an administrator or a setup user.
2. In the Setup and Maintenance work area, click the Task menu, and select Review Topology.
3. Click the Diagnostic Tests tab.
4. Click the Enterprise Application Configuration sub-tab.
5. Click the Enterprise Application drop down list.
6. Click the Search link and enter Oracle Hybrid.
7. Click Search.

The Search and Select: Enterprise Application dialog box appears.
8. Select Oracle Hybrid VBCS, then click OK.
9. Select Validate External Enterprise Application Endpoint URL.
10. Click the Run icon.
11. Take note the value in the External Endpoint URL field.

**Note:** This is the URL that you will need to use every time you want to access Oracle Visual Builder.

12. Click Done.
13. Now, to configure for Oracle Hybrid Developer Cloud, click the Enterprise Application drop down list.
14. Click the Search link and enter Oracle Hybrid Developer Cloud.
15. Press the Enter key.

The Search and Select: Enterprise Application dialog box appears.
16. Click Oracle Hybrid Developer Cloud.
17. Click OK.
18. Click Validate External Enterprise Application Endpoint URL.
19. Click the Run icon next to Validate External Enterprise Application Endpoint URL.
20. The External Endpoint URL field is the Oracle Developer Cloud Service URL.

**Note:** This is the URL that you will need to use every time you want to access Oracle Developer Cloud Service. For example: https://<B2B hostname>/.

Specify the B2B Service Details in Oracle Visual Builder

To specify B2B Service details in Oracle Visual Builder:

1. Sign into Oracle Visual Builder as an administrator.
2. Click the Menu icon, and select Settings to open the Tenant Settings page.
3. Click the Services tab, then click the Back ends icon (+)
4. In the Back end Service Type window, select Oracle Cloud Application Instance.
5. In the Instance URL field of the Create Oracle Cloud Application Instance window, enter the instance URL of your B2B Service back end service.
6. From the Authentication drop down list, select **Oracle Cloud Account**.
7. Click **Create**.

**Note:** You must set the Instance URL field with the fully qualified domain name of your Oracle Applications Cloud B2B Service instance.

**Related Topics**
- Add a Connection for Applications Services

**Verify Your Oracle Visual Builder Settings**

Here's how to verify your Oracle Visual Builder settings:

1. Sign in to Oracle Visual Builder as a Service Administrator.
2. Click the **Home** menu.
3. Click **Settings**.

   The **Tenant Settings** screen appears.

4. On the **General** tab, locate the **Allow only secure applications to be created** option, and ensure that it's turned off.
4 Create a Basic Digital Customer Service Application

Create a New Digital Customer Service Application

This topic describes how to create a new Digital Customer Service application in Oracle Visual Builder.

**Note:** The steps that follow assume that you have selected the 20D Reference Implementation Template or later.

To create a new Digital Customer Service application:

1. Sign in to the Oracle Visual Builder editor as a user with the Developer role.
2. Click **New**.

   **Note:** If no applications have been created yet, the button will read **New Application**.

   The **Create Application** dialog appears.

3. In the **Application template** section, click **Change template**.
4. Click the reference implementation tile that matches the B2B Service version you are using. For instance, if your implementation is version 20D, choose the 20D tile.

   This template creates an application with basic service functionality, including the ability to create and update SRs, search knowledge, and chat with an agent.

5. Click **Select**.
6. Specify the **Application Name**.
7. Specify the **Application ID**.

   The **Application ID** is automatically derived from the specified Application Name, but you can change it, if desired. The Application ID cannot be modified once the application is created: it appears in the application URL.

8. Click **Finish**.

Once the Digital Customer Service application has been created, you are now ready to configure the application to meet your business needs.

**Note:** When Oracle B2B Service is deployed with multiple business units, additional configuration is required. For more information, refer to the Configuring Multiple Business Units with Digital Customer Service topic in the Related Topics.

**Caution:** For your Digital Customer Service Reference Implementation template to work properly, access to Knowledge and Chat must be allowed anonymously. Your Oracle Visual Builder settings must to be configured to allow publicly accessible applications to be created. To verify the settings, use the instructions that follow.

**Related Topics**

- Digital Customer Service Terminology
- Overview of Mandatory Setup Tasks
- Map Roles for Digital Customer Service
Add Mappings to User Roles

After creating your Digital Customer Service application, you must add the following mappings to your user roles in Oracle Visual Builder:

- Customer Self-Service User
- Customer Self-Service Account Administrator

To add the required Oracle Identity Cloud Service role mappings to your application roles:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Menu icon and select Settings.
4. Click the User Roles tab.
5. Select the User Proxy Production application profile in the drop down list beside the Create Role button before doing the mapping.
6. Add the Customer Self-Service User mapping:
   a. On the User card, click Assign groups or users. The Change Assignments dialog box is displayed.
   b. In the list of available mappings, search for the following string: Customer Self-Service User
   c. Click the plus sign (+) next to Customer Self-Service User.
   d. Click Save Changes.
7. Add the Customer Self-Service Account Administrator mapping:
   a. On the Account_Administrator card, click Assign groups or users. The Change Assignments dialog box is displayed.
   b. In the list of available mappings, search for the following string: Customer Self-Service Account Administrator
   c. Click the plus sign (+) next to Customer Self-Service Account Administrator.
   d. Click Save Changes.

Set Up Authentication for Your Application

The 20D reference implementation application template for Digital Customer Service is set up with all the appropriate configuration for enabling the proxy user data service for the service connections. The only thing that needs to be specified is the credentials for the Developer APPID.

You should not need to change the authentication to anything other than the default as this is configured to work with self-service optimization. Service authentication can be specified at three levels in the Digital Customer Service application to override the tenant settings. From the Settings menu choose Services to set authentication for all services on Oracle Cloud Applications or on a specific service, such as Sales and Service. Additionally, you can set authentication
for a specific service connection, such as crmRestApi, by selecting it in the Service Connections panel. crmRestApi overrides Sales and Service overrides Oracle Cloud Applications overrides tenant settings.

For the developer interaction with the service back end, a developer proxy is specified, and the connections from the Visual Builder designer to the B2B service back end won’t go through the proxy user data service.

To complete this configuration, perform the following task:

2. Click Settings, then click the Services tab.
3. Select the Oracle Cloud Applications node under the list of Back ends.
4. Click the Edit icon for the Development Oracle Cloud Applications Server with user proxy. This is the Application Profile associated with User Proxy Development.
5. Under the heading for Authentication for logged-in users, click the Edit icon to specify the Basic credentials for the Developer APPID.
6. Enter the user name and password for the Developer APPID and click Save.
7. Click Save.

Stage and Publish the Digital Customer Service Application

You can preview your changes as you develop them by clicking the Preview button.
Test that your changes perform as expected by staging the application. Access the **Stage** option by clicking the **Menu** button from the Visual Builder home page as shown in the following example:

![Menu button](image)

Staging your application enables you to test each update you make to confirm that it behaves as you expect and that no problems have been introduced, for example, when you add new features or change your data model.

When you publish a version of your application, it becomes read-only and can no longer be changed. If you want to make changes to update your application, you need to create a new version. When you publish a staged version of your application, it becomes the live version. If you are updating an earlier version of your application, the previous live version is archived and locked. Only one version of an application can be live at a time, but multiple versions of an application can be staged simultaneously.

**Note:** For detailed instructions on how to preview, stage and publish your application, you must refer to the Related Topic section for a link to the Developing Applications with Oracle Visual Builder guide. You must also refer to this topic for detailed instructions on how to retrieve the URL for your staged application.

**Related Topics**

- Stage and Publish Visual Applications
5 Develop Your Digital Customer Service Application

Overview of Developing Your Digital Customer Service Application

The Oracle Digital Customer Service reference implementation is an application built with the Oracle Visual Builder Visual Applications platform. It's pre-configured with pages, styling, and functionality supporting a typical self-service experience. The Visual designer enables developers to make changes and implement the look-and-feel of a brand.

As with any development framework, there can be restrictions when using ready-to-use components and capabilities. While Oracle Visual Builder is flexible and code can be written to accommodate many use cases, Oracle recommends using the packaged components as a first fulfillment of your requirements. If those components don't meet your requirements, then you may extend the capabilities.

Note: If you have modified your Digital Customer Service deployment, you must devise a product life cycle strategy to manage your own code migration and merges as well as uptake any environment changes.

Your Digital Customer Service application has rules for business objects to execute business logic that deals with the data. Using object and field validators you can ensure data at the field or record level is correct. For more information, see the Related Topics section.

Related Topics
- Create Rules for Business Objects

Configure Profile Options

This topic describes Digital Customer Service profile options, including configuration instructions.

The following two task lists apply to profile options for Digital Customer Service:
- Manage Digital Customer Service Profile Options
- Manage Digital Customer Service Account Setup Profile Options

Overview of Profile Options

Profile options let you configure and control application data centrally. Administrators and setup users manage profile options in the Setup and Maintenance work area.

Profile options store various kinds of information, including the following:
- User preferences
- Installation information
- Configuration choices
In this topic, we will focus on Oracle B2B Service profile options specific to Digital Customer Service. For more information about profile options, refer to the Profile Options topic in the Related Topics.

### Registration Profile Options

The following table lists the profile options for Digital Customer Service Registration Profile Options.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Default Value</th>
<th>Possible Values</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_CSS_SELF_REGISTRATION</td>
<td>New Or Existing</td>
<td>None, New Or Existing, Existing Only</td>
<td>Specifies which contacts can self-register. If Existing is specified, only existing contacts can self-register.</td>
</tr>
<tr>
<td>SVC_CSS_SELF_REG_AUTO_APPROVE</td>
<td>False</td>
<td>True, False</td>
<td>Enables automatic approval of self-service registration requests that are associated with an account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If SVC_CSS_SELF_REG_AUTO_APPROVE is set to False and SVC_CSS_ACCT_ADMIN_APPROVE is set to True, then the Digital Customer Service Account Administrators can approve user registration requests in the Digital Customer Service Customer user interface. Also, Digital Customer Service Administrators can approve registration requests in the Digital Customer Service Administration user interface.</td>
</tr>
<tr>
<td>SVC_CSS_ACCT_ADMIN_APPROVE</td>
<td>True</td>
<td>True, False</td>
<td>Enables the approval of self-service user registration requests by users with Digital Customer Service Account Administrator roles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If set to True, Digital Customer Service Account Administrators can approve user registration requests in the Digital Customer Service customer user interface and Digital Customer Service Administrators can approve registration requests in the Digital Customer Service Administration user interface.</td>
</tr>
<tr>
<td>Profile Option</td>
<td>Default Value</td>
<td>Possible Values</td>
<td>Effect</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------</td>
<td>------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>SVC_CSS_ACCT_KEY_FIELD</strong></td>
<td>OrganizationName</td>
<td>Any field in the Account object</td>
<td>Specifies a valid field name in the Account object. The field name is case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> You must create an attribute in the account object to be the account key, because the default account key of account name isn't secure.</td>
</tr>
<tr>
<td><strong>SVC_CSS_REG_CONT_MAP</strong></td>
<td>PersonFirstName:PersonFirstName, PersonLastName:PersonLastName, EmailAddress:EmailAddress</td>
<td>NULL, Any defined value, with a colon separating fields, and commas separating the pairs.</td>
<td>Specifies name and value pairs that map fields of the Registration View object to the Contact View object. When set to NULL, the same name is expected in both objects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> For example, reg_field1:contact_field1, reg_field2:contact_field2</td>
</tr>
<tr>
<td><strong>SVC_CSS_SIGN_IN_ATTR_NAME</strong></td>
<td>EmailAddress</td>
<td>The value of the assigned attribute must be unique.</td>
<td>Specifies the sign-in attribute that users must specify in the Login ID field in the Self-Service Registration object. This field is used to determine whether the user exists in the Lightweight Directory Access Protocol server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Possible values include: EmailAddress</td>
<td></td>
</tr>
<tr>
<td><strong>SVC_CSS_REG_FLD_CONTACT</strong></td>
<td>EmailAddress</td>
<td>Any fields on the Contact object</td>
<td>Specifies the fields to use during the user registration process to determine if the registering user is an existing customer.</td>
</tr>
</tbody>
</table>

**Note:** This option applies only when the `SVC_CSS_SELF_REG_AUTO_APPROVE` option is set to False.
<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Default Value</th>
<th>Possible Values</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_CSS_SEND_WELCOME_EMAIL</td>
<td>True</td>
<td>True, False</td>
<td>Enables sending a welcome email when a new user account is created.</td>
</tr>
<tr>
<td>SVC_CSS_USER_ROLE_COMMON_NAME</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_USER_ABSTRACT</td>
<td>A string representing the name of the role that's set up for Customer Self-Service users. Typically, this is a copy of a Customer Self-Service User with additional privileges added.</td>
<td>Specifies the common name of the role granted to previously created Customer Self-Service Users. For more information refer to Assigning Custom Job Roles in the Related Topics.</td>
</tr>
<tr>
<td>SVC_CSS_ACCOUNT_ADMIN_ROLE_COMMON_NAME</td>
<td>ORA_SVC_CUSTOMER_SELF_SERVICE_ACCOUNT_ADMINISTRATOR_ABSTRACT</td>
<td>A string representing the name of the role that's set up for Customer Self-Service Account Administrator. Typically, this is a copy of a Customer Self-Service Account Administrator with additional privileges added.</td>
<td>Specifies the common name of the role granted to the previously created Customer Self-Service Account Administrators. For more information refer to Assigning Custom Job Roles in the Related Topics.</td>
</tr>
<tr>
<td>SVC_CSS_USER_CATEGORY</td>
<td>An empty string</td>
<td>A string</td>
<td>Specifies the user category that defines the URL to which the self-service user is redirected after a password reset. The user category is defined in the Security Console.</td>
</tr>
<tr>
<td>SVC_CSS_IMP_SIGN_IN_ATTR_NAME</td>
<td>PrimaryEmailAddress</td>
<td>Any field on the Contact object.</td>
<td>Specifies a field in the Contact object to be used as the sign-in attribute when importing data into the Self-Service Roles object. The field name is case sensitive.</td>
</tr>
<tr>
<td>SVC_CSS_USE_FA_AS_IDP</td>
<td>False</td>
<td>True, False</td>
<td>Specifies whether the identity provider is Oracle Fusion Applications or Oracle Identity Cloud Service. When set to True, Oracle Fusion Applications is used.</td>
</tr>
<tr>
<td>ORA_SVC_CSS_SELF_REG_B2C_AUTO_APPROVE</td>
<td>True</td>
<td>True</td>
<td>Enables automatic approval of self-service registration</td>
</tr>
</tbody>
</table>
### Account Setup Profile Options

The following table lists the profile options for Digital Customer Service Account Setup Profile Options.

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Default Value</th>
<th>Possible Values</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>SVC_AC_MQS_ACCOUNT_ID</td>
<td>None</td>
<td>A string</td>
<td>Associates the Account ID to the identity domain assigned to your order. This represents the Identity Domain shown in the MyAccount UI in Cloud Portal.</td>
</tr>
<tr>
<td>SVC_AC_MQS_DATA_CENTER</td>
<td>None</td>
<td>A string</td>
<td>Enables the data center to use the metering service.</td>
</tr>
</tbody>
</table>
Profile Option | Default Value | Possible Values | Effect
--- | --- | --- | ---
 |  |  | This represents the name of the Data Center shown in the MyAccount UI in Cloud Portal.
CSO_CONTENT_RATING_TYPE | None | True and False | Enables content rating for Knowledge.

Set Digital Customer Service Profile Options
This topic describes how to set profile options for Digital Customer Service. The profile options specific to Digital Customer Service are found in two task areas: Manage Digital Customer Service Profile Options and Manage Digital Customer Service Account Setup Profile Options.

To find and set the Digital Customer Service profile options:

1. Sign in to Oracle B2B Service as administrator or a setup user.
2. In the **Setup and Maintenance** work area, go to the following:
   - Offering: Service
   - Functional Area: Digital Customer Service
   - Task: Manage Digital Customer Service Profile Options
   or
   - Task: Manage Digital Customer Service Account Setup Profile Options
3. Click the name of the profile option that you want to modify.
4. Set the profile option value as needed.
5. Click **Save and Close**.

**Related Topics**
- Overview of Profile Options
- Overview of Mandatory Setup Tasks
- Manage Setup Using Offering Functional Areas

Configure Git for Application Source Control
This topic describes how to configure Git for source control of your application.

In some deployments, you might have multiple Oracle Developer Cloud Service instances available to you within your account on Oracle Cloud. Oracle recommends that you use only one instance that includes the following string in the label or name: `test`. Using only one version that includes the `test` string enables better source code management within a single instance. This is recommended because, in the future, your account on Oracle Cloud will allow you to view only one `test` instance of Oracle Developer Cloud Service. Also, other instances that include `test` will be made obsolete, and will be subject to removal.
To configure Git, follow these steps:

1. In Oracle Developer Cloud Service, set up a Git repository. For more information about setting up a Git repository, refer to the Related Topics. After doing this task, you will receive an email informing you of the Oracle Developer Cloud Service URL.  

   **Note:** For groups that will be collaborating, when you’re creating your project, select the **Shared** option when defining **Security**.

2. In Oracle Visual Builder, integrate your application with a Git repository. For more information about integrating your application with a Git repository, refer to the Related Topics.

**Related Topics**

- Set Up a Git Repository
- Integrate Your Application with a Git Repository

### Secure Pages

Page security is controlled at the flow level. You must view the flow Metadata "\{\}" to view and update the security setting for the flow. For more information see the Related Topics section for a link to the Security section of the Developing Applications with Oracle Visual Builder in Oracle Integration guide.

Here’s an example of how it works. In the reference implementation app, the contact-us flow is available anonymously, and has the following security metadata:

```json
"security": {

"access": {

"requiresAuthentication": false

}

}
```

Conversely, the service-request-list flow requires the user to log in and have the "User" application role, and has the following security metadata:

```json
"security": {

"access": {

"requiresAuthentication": true,

"roles": ["User"]

}

}
```

**Related Topics**

- Security
Assign Custom Job Roles

This topic describes how to assign custom job roles for use in Digital Customer Service. There are many reasons why you might create a custom job role for Customer Self-Service users. One possible reason is when you create a custom object and want to assign privileges to that object.

To assign custom job roles for use in Digital Customer Service:

1. Create a custom role by making a copy of one of the following predefined roles:
   - Customer Self-Service User
   - Customer Self-Service Account Administrator

   For more information about creating custom roles by making copies of roles, refer to the Guidelines for Copying Sales Roles and Copying Job or Abstract Roles: Procedure links in the Related Topics.

2. Set the value of the appropriate Digital Customer Service profile option to the name of the custom role you created. The following profile options can be set to the name of the custom role:
   - `SVC_CSS_USER_ROLE_COMMON_NAME` If the value of this profile option is set to the name of a custom role, then all Customer Self-Service Users will be assigned this role when they are provisioned.
   - `SVC_CSS_ACCT_ADMIN_ROLE_COMMON_NAME` If the value of this profile option is set to the name of a custom role, then all self-service users who are assigned the Customer Self-Service Account Administrator role will receive this custom role.

   For more information about setting profile options, refer to the Configuring Profile Options topic.

   **Note:** If you update these profile options to specify a custom role once your Digital Customer Service application is in use, you must perform a mass update of any existing users from the old roles to the new roles.

Related Topics

- Guidelines for Copying Sales Roles
- Copy Job or Abstract Roles
- Add Mappings to User Roles

Application Configuration Settings

Digital Customer Service application settings are configured using application level variables in the Digital Customer Service web application. This topic describes how to configure settings, followed by descriptions of the application variables.
Modify the Application Variables

This topic describes how to modify application variables for your Digital Customer Service application in the Oracle Visual Cloud Builder Service. The variables that are available for configuration are described in the topics that follow.

To modify the application variables:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Web Applications tile.
4. Click dcs.

**Note:** This is the default name when using the Digital Customer Service Reference Implementation. If you have changed the name in Oracle Visual Builder, click on the modified name.

The dcs tab appears.
5. Click the (x) icon (Variables).
6. Click a variable, and make your modifications.

Linking

This topic describes application variable related to Service Request and Knowledge Management article linking.

All of the application variables related to Service Request and Knowledge Management article linking are contained in the `linkConfig` application variable. When you use the Digital Customer Service Reference Implementation template, the article linking section is configured as follows:

```json
{
  "SERVICE_REQUEST_CRM": {
    "pattern": "\b(SR|Bug)(\d{10})\b"
  },
  "KNOWLEDGE_LINK": {
    "pattern": "\b((?:SOL|FAQ)\d+)\b",
    "keyProperty": "IMDocumentId"
  },
  "SERVICE_REQUEST_HCM": {
    "pattern": "\b(Ticket)(\d{10})\b"
  }
}
```

The `SERVICE_REQUEST_CRM`, and `SERVICE_REQUEST_HCM` object type lines control the Service Request linking. The `KNOWLEDGE_LINK` object type line controls the Knowledge Management article linking.

By default in the Digital Customer Service Reference Implementation template, SR and Bug are defined as the case insensitive prefix that identify CRM Service Requests. Similarly, Ticket is defined as the case-insensitive prefix that identifies HCM Service Requests. For Knowledge Management articles, SOL and FAQ can be used interchangeably as the case-insensitive prefix that identifies articles. These prefixes are defined in the `pattern` application variable in each object type.

For example, if you want to change the prefix for Service Requests specifically to include both SR and Service Request as the prefix patterns, modify the `SERVICE_REQUEST` object type as follows:

```json
"SERVICE_REQUEST_CRM": { "pattern": "\b((?:SR|Service Request)\d{10})\b"},
```
Configure Product and Category Filtering

This topic describes the application variables related to product and category filtering.

- **dcsCategoriesOnly** Specifies the categories to display in your Digital Customer Service application. When set to **true**, categories with the **CSSFlag** set to **false** in the REST API won’t be displayed in the Category Selector.
- **dcsProductsOnly** Specifies the products to display in your Digital Customer Service application. When set to **TRUE**, only products with **Enable for Customer Self Service** set to **YES** will be displayed in the Product Selector. When set to **FALSE**, all products in the Oracle B2B Service product catalog are displayed.

Configure Product and Category Recent Selections

This topic describes the application variables related to product and category recent selections.

- **recent-selections** Contains the recent selections. This variable should be mapped to an application level variable. Up to five recent selections are displayed, with the most recent listed first.
- **recent-list-limit** Determines the number of rows that are displayed.
- **show-recent** Determines if recent selections are displayed.

Configure Language Defaults in Knowledge Management

This topic describes the application variables related to language defaults in Knowledge Management.

This configuration is required when more than one region is supported for the same language, because the default from the configuration file is used. Also for the API that retrieves the Knowledge Management locales, a **localeId** must be provided in the **kmauthntoken**, so that value is taken from the configuration file.

Oracle Knowledge Management supports a predetermined set of locales for knowledge searches. If the **Accept-Language** header element of the knowledge search REST request doesn't match one of the supported locales, an HTTP 400 error is returned. To prevent this, the locale specified in the **Accept-Language** header is overridden. This logic that determines the override locale is as follows:

1. Query the Server for all the supported locales and cache it.
2. Get the locale preference from the Oracle JET locale configuration using **oj.Config.getLocale()**;

**Note:** Oracle JET determines the locale for locale-sensitive operations in the following order: locale specification in the RequireJS configuration, lang attribute of the HTML tag, navigator.language browser property or navigator.userLanguage Internet Explorer property.

- If the locale preference is on the supported locale list, use it.
- If the locale preference isn’t a supported locale, extract the language from it.
3. Search the supported locale list by language. If only one match is found, use it.
4. Search **kmLanguageDefaults** in the **kmConfig** application variable. If a match is found, use it.
5. Pick the default locale for any language not on the list and use it.

The **kmLanguageDefaults** variable is the child of **kmConfig** variable. It maintains a mapping of language to locale.

The Interface ID for Knowledge Requests

This topic describes the application variables related to Interface ID defaults for Knowledge Management articles.
Use the `kmInterfaceId` variable, which is a child of the `kmConfig` top level application variable, to control what type of Knowledge Management articles appear in your Digital Customer Service application.

<table>
<thead>
<tr>
<th>kmInterfaceId Variable Value</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Only Oracle HCM Cloud articles appear.</td>
</tr>
</tbody>
</table>

**Application Configuration Settings**

The Digital Customer Service application determines whether or not the user registration request requires an account key based on the value of the application variable `userRegistrationType`. This variable can have one of two values:

- Contact. Users registering as self-service users must provide an account key. When the user registration request is approved, the contact representing the user is associated with a specific account.
- Consumer. Users registering as self-service users do not have to provide an account key. When the user registration request is approved, the contact representing the user is created as a standalone contact.

The default value is contact.

To set the value of the `userRegistrationType` variable:

2. Select **Web Applications**.
3. Select **dcs**.
4. Select **Variables and Types**.
5. Select **userRegistrationType**.
6. Change the default value to either **contact** or **consumer** based on the requirements of your application.

**Apply Themes to your Digital Customer Service Application**

This topic describes how to apply themes to your own Digital Customer Service application.

Oracle JET includes themes that provide styling across a web or hybrid mobile application. You can use these themes as provided, or you can configure them manually and through the tooling.

For more information about applying themes to your Digital Customer Service application, refer to the chapter related to applying themes in the Developing Applications with Oracle JET guide, in the Related Topics.

**Related Topics**

- Developing Applications with Oracle Visual Builder
- Developing Applications with Oracle JET
Change the Appearance of your Digital Customer Service Application

This topic describes how to change the appearance of your own Digital Customer Service application.

The Oracle Digital Customer Service Reference Implementation template has been styled to enhance its appearance. This has been done by modifying objects and adding styles to the **app.css** file.

To modify objects in the **app.css** file:

1. Navigate to the Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click **Web Apps**.
4. Expand **dcs**, expand **resources**, expand **css**, then click **app.css**.
   - The **app.css** tab appears.
5. Locate and configure the object that you want to modify. For example, to set the header of the Reference Implementation template to a transparent black, modify the **odcs-header** CSS class selector:

   ```css
   .odcs-header {
     background-color: rgba(0, 0, 0, 0.7);
     height: 58px;
   }
   ```

CSS Classes defined in **app.css** can then be referenced in the HTML of the application. For example we have this code in **pages/shell-page.html**:

```html
<header role="banner" id="header" class="odcs-header oj-web-applayout-header">
    ...
</header>
```

You can also use Oracle JET themes to provide consistent appearance of components across your Digital Customer Service application. For more information about Oracle JET themes refer to the Themeing Applications chapter in the Developing Applications with Oracle JET guide, in the Related Topics.

Once an Oracle JET theme is created it can be added uploaded to **resources/css** and then referenced in the **index.html** of the application with code like this:

```html
...<link type="text/css" rel="stylesheet" href="resources/css/app.css"/>
<link type="text/css" rel="stylesheet" href="resources/css/myJETTheme.css"/>
...```

**Related Topics**

- Developing Applications with Oracle JET

Custom Objects

If you create custom objects for either CX Sales or B2B Service, you must use Application Composer. If you use the Business Objects feature in Visual Builder your work won’t be backed by disaster recovery operations. Only use the Business Objects feature in Visual Builder for transient, cached, or otherwise, non-business critical data that can be recreated if lost.
Additional Feature Configuration

Configure Multiple Business Units with Digital Customer Service

When you have multiple business units, additional configuration is required once you have created your Digital Customer Service applications. Each business unit must have its own Digital Customer Service application.

**Note:** Only one business unit is supported per Digital Customer Service application.

For more information about setting up multiple business units, refer to the following cross-references in the Related Topics section: Setting Up Business Units for Service and Multiple Business Units in Sales.

Once you have created your Digital Customer Service applications, follow the instructions in the following sections of this topic:

1. Locate the business unit ID in Oracle B2B Service.
2. Specify the business unit ID in the Digital Customer Service application.
3. Configure the Business Unit ID for the Open Service Requests list.

Locate the Business Unit ID

To locate the business unit ID for your Digital Customer Service application:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. In the **Setup and Maintenance** work area, go to the following:
   - Offering: Service
   - Functional Area: Company Profile
   - Task: Manage Business Unit
3. Locate your business unit in the **Search Results** list and copy the value in the **BusinessUnitId** column.

   If you don’t see a **BusinessUnitId** column, click the **View** menu to access the **Columns** menu, and then select the columns to display.

   **Note:** You will need to use the value that you copied in the Specifying the Business Unit ID and Product Catalog Usage Code in the Digital Customer Service Application task.

Locate the Product Catalog Usage Code

To locate the Product Catalog Usage Code for your Digital Customer Service application:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. In the **Setup and Maintenance** work area, go to the following:
   - Offering: Service
   - Functional Area: Business Units
Task: Manage Service Product Group Usage for Business Unit

3. Copy the value in the Business Unit Profile Value text box.

You will need to use the value that you copied in the Specifying the Business Unit ID and Product Catalog Usage Code in the Digital Customer Service Application task.

**Note:** If you haven’t yet set the scope for tasks, the Select Scope dialog box appears. For more information about setting the scope for tasks, refer to the Set the Scope in Service BU Setup topic in the Related Topics.

Specify the Business Unit ID and Product Catalog Usage Code in the Digital Customer Service Application

Once you have located the business unit ID and product catalog usage code in Oracle B2B Service, you must specify them in your Digital Customer Service application.

To specify the business unit ID and product catalog usage code:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Web Apps tile.
4. In the Web Apps tree, click dcs.
   
   A dcs tab appears.
5. Click the (x) (Variables) icon.
6. Set the business unit ID:
   
   a. Click businessUnitId.
   b. In the Default Value text box, specify the value that you copied in Step 3 of the Locating the Business Unit ID task.

7. (Optional) Set the non-default usage code:

   a. Click usageCode.
   b. In the Default Value text box, specify the value that you copied in Step 5 of the Locating the Product Catalog Usage Code task.


**Note:** When adding the Chat or Category Selector to a page, you must ensure that your businessUnitId property is bound to $application.variables.businessUnitId. Moreover, when adding the Product Selector to a page, its usageCode property must be bound to $application.variables.usageCode.

Related Topics

- Set the Scope in Service BU Setup
- Create a New Digital Customer Service Application
- Setting Up Business Units for Service: Overview
- Manage Setup Using Offering Functional Areas
- Overview of Multiple Business Units in Sales
Configure Reschedule Work Order Functionality

The Reschedule Work Order action uses the /crmRestApi/resources/.*/svcWoCapacities endpoint which isn’t, at present, part of proxy table. To use this functionality, you must manually configure it.

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
   - Task: Manage Proxy User Configuration Data.
3. To add new objects, do the following:
   a. In the Search Results area, click the New (+) icon.
   b. Add the following URL pattern: /crmRestApi/resources/.*/svcWoCapacities.
   c. Click the drop down list and add the HTTP method: GET, OPTIONS.
   d. Click the drop down list and choose the user role: Customer Self-Service User.
   e. Add the proxy user key: PU#_SELF_SERVICE_USER.
   f. Click the Active check box.
   g. Click the Allow Identity Propagation check box.
4. Click Save and Close.

Configure Cobrowse

Here’s how to set up Cobrowse, and Integrate the Cobrowse script tag in your Digital Customer Service application.

Set Up Cobrowse

This topic describes what’s required before integrating the Oracle Cobrowse script tag in your Digital Customer Service application.

1. Configure the Oracle Cobrowse widget using the Oracle Digital Engagement Channels Administrative Console:
   a. Navigate to the following URL:
      www.mylivelook.com
   b. In the Login field, enter the administrator’s email address that was specified when you ordered the service.
   c. Enter your password.

   Note: On your first login attempt, you will need to click the Forgot my password link and instructions for creating a password will be emailed to you.

d. Click Login.

For more information, refer to the Related Topics section for documentation on Cobrowse setup.
2. Locate the `src` URL, which is in the Cobrowse Launcher Script in the Oracle Cobrowse administration UI. For more information, refer to the Related Topics section for documentation on Cobrowse setup.

**Integrate the Cobrowse Script Tag in Your Digital Customer Service Application**

Before integrating Oracle Cobrowse with your Digital Customer Service application you must configure Cobrowse in Oracle B2B Service and obtain the script tag.

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the **Web Apps** tile.
4. In the **Web Apps** tree, expand `dcs`, then `root pages`, and then click **shell**.
   
   The **shell** tab appears.
5. Click the **Page Structure** icon.

6. In the Page Structure panel filter field, enter **Cobrowse**.
7. Click the highlighted Cobrowse component.
8. Enter the launcher URL obtained in the previous topic in the launcher-url field of the component’s property inspector.

Related Topics
• Using Standalone Co-Browse
• Implementing Standalone Co-Browse
• Configuring Standalone Co-Browse
• Administering Standalone Co-Browse
• Co-Browse In-App SDK for iOS and Android

Integrate Chat in Your Digital Customer Service Application

In the Digital Customer Service reference implementation, the chat component is deployed in the footer of the shell page so that chat sessions persist across page navigation. If you want to create another shell page or show the chat dialog from an action, follow these steps:

Create a New Root Page
In the Digital Customer Service reference implementation, the chat component is deployed in the footer of the shell page so that chat sessions persist across page navigation. If you want to create another shell page follow these steps:

1. In Visual Builder, expand the Root Pages node, open the original shell page where the chat component appears.
2. Click the **Code** button:

![Code button](image)

3. Copy the oj-odcs-chat component from the footer of the original shell page, and then replace the oj-odcs-chat element in the foot of the new shell page. In the Components Search field, enter **chat**.
   
   Copying the code from the original shell page ensures that you have the correct ID, translations and correct references to application variables.

### Show Chat with an Action

If you want to show the chat dialog from an action, follow these steps.

1. In the Web Apps navigator, click your application icon.
2. Click the **Actions** icon:

![Actions icon](image)

3. In the list of Actions, locate and select the **ShowChatAction** action chain.
4. In the Action Chain properties window, make sure the following entries are correct:
   - Component: `{{ document.getElementById('odcs-chat') }}`
   - Method Name: open.

### Configure Chat to be Offered Only When Agents are Available

You can configure chat so that it’s offered as an option to customers only when an agent is available. You just need to do the following two steps:

1. Set SVC_CHAT_INLAYS_ACCESS_ENABLED profile option to **Yes**.
2. Set the default value of the DCS chatPollingEnabled application variable to **True**.
Map Roles for Digital Customer Service

Now you map roles to let the Oracle Visual Builder role to match with Oracle B2B Service. Once you have done this task you will be able to manage user roles in the Oracle B2B Service and your Digital Customer Service application similarly.

You must follow the process for mapping roles in this topic if you want to define additional roles.

Map a New Role

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the **Menu** icon and select **Settings**.
4. Click the **User Roles** tab.
5. Click **Add Role**.
6. Enter a role name in the **Role** text box.
7. In the **Mapping** list, select the role to which to map.
8. Click the **Check Mark** icon to complete the mapping.

Edit an Existing Role Mapping

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the **Menu** icon and select **Settings**.
4. Click the **User Roles** tab.
5. Hover over the role that you want to edit in the **User Roles** list, then click the **Pencil** icon.
6. Edit the role name in the **Role** text box.
7. In the **Mapping** list, edit the role to which to map.
8. Click the **Check Mark** icon to complete the mapping.

Remove an Existing Role Mapping

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the **Menu** icon and select **Settings**.
4. Click the **User Roles** tab.
5. Hover over the role that you want to remove in the **User Roles** list, then click the **Trash Can** icon.
   - The user role is removed.
6. Click **Close**.

Set Up Products, Categories and Knowledge Articles

Here are instructions on how to create products, categories, and author knowledge articles specific to Digital Customer Service. Product items and groups are used within the Digital Customer Service application to provide better support.
and knowledge article navigation. Also, product items and groups help you associate service requests for Oracle B2B Service process flows. So, when you’re creating and using product items and groups, think of them as another way to improve your customer’s experience.

To configure products and categories for service request management:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Configure the products that are available in service requests.

   **Note:** When creating your products, the following options must be selected: **Eligible to Sell**, **Eligible for Service** and **Enable Customer Self-Service**.

   For information about configuring products, refer to the Related Topics.

3. Configure the available categories for service requests.

   For information about configuring categories, refer to the Related Topics.

4. Author Knowledge articles that you want users to have access to in their Digital Customer Service applications.

   For information about creating and editing knowledge articles, refer to the Related Topics.

**Related Topics**

- Managing Service Request Categories: Explained
- Knowledge Articles
- Work with Sales Products

---

**Create a Digital Customer Service Icon in Oracle B2B Service**

Sometimes, when users perform certain actions in the Digital Customer Service application, they’re redirected to the Oracle B2B Service Dashboard. To make this path easier for your users, Oracle recommends that you include a Digital Customer Service icon within the user’s dashboard.

**Note:** If you use a third-party identity management solution with Oracle B2B Service, you must address the redirect issues within your deployment.

Follow the procedures in this topic in the listed order to create a Digital Customer Service icon in Oracle B2B Service:

1. Create a New Sandbox.
2. Create a New Card Icon for Accessing Digital Customer Service.
3. Validate the Card Icon.
4. Publish the Sandbox.

**Create a New Sandbox**

To create a new sandbox:

2. Click **Navigator > Configuration > Sandboxes**.
3. Click the + icon (New) to create the new sandbox.
4. Select the sandbox created in Step 3.
5. Click Set as Active.

Create a New Card Icon for Accessing Digital Customer Service

To create a new card icon for accessing Digital Customer Service:


   | Note: Ensure that your sandbox is set as active.

2. Navigate to the Configuration work area and click Structure.
3. From the Create menu, select Create Page Entry.
4. Enter information for the new card:
   - Name. Specify DCS.
   - Icon. Select an icon.
   - Group. Select Service.
   - Show on Navigator. Select EL Expression, then select the Edit and paste the following expression:
     ```java
     #{!securityContext.userInRole['ORA_PER_EMPLOYEE_ABSTRACT']}
     ```
   - Show on Springboard. Select EL Expression, then select the Edit and paste the following expression:
     ```java
     #{!securityContext.userInRole['ORA_PER_EMPLOYEE_ABSTRACT']}
     ```
   - Link Type. Select Static URL.
   - Destination. Specify the URL for your Digital Customer Service web application.
5. Click Save and Close.

Validate the Card Icon

To validate the card icon:

2. Click Navigator > Configuration > Sandboxes.
3. Select the sandbox created in the Create a New Sandbox topic.
4. Click Set as Active.
5. Navigate to the Home page.

The DCS icon appears on the Home page and in the Navigator.

Publish the Sandbox

To publish the sandbox:

1. Sign in to Oracle B2B Service as a user with the Sales Administrator job role.
2. Click Navigator > Configuration > Sandboxes.
3. Select the name of the sandbox created in the Create a New Sandbox topic.
   - The Sandbox Details dialog appears.
4. Click Publish.
Configure Proactive Knowledge

This topic provides an overview of the proactive knowledge feature and describes how to configure variables relating to proactive knowledge.

Overview of Proactive Knowledge

The proactive knowledge feature enables you to display relevant knowledge articles to users prior to creating a Service Request (SR). Having access to knowledge articles helps customers self-service their own issues, possibly avoiding creating SRs altogether.

When the user attempts to submit an SR, the application uses the title of the SR to search the knowledge base. If the knowledge search returns matches, the application shows a list of relevant knowledge articles to the user. If the user determines that one of the articles answers their question, then the SR isn’t submitted. If the knowledge articles don’t help, the user can go ahead and create the SR. If the knowledge search doesn’t return any matches, the application automatically submits the SR.

You can control if proactive knowledge is displayed at all, or based on how many knowledge searches a user has completed, or even by the number of articles that the user views. Also, you can configure the number knowledge articles that are displayed.

Control when Proactive Knowledge is Displayed

Proactive knowledge display options are controlled using variables. This table lists and describes the variables, and also contains an explanation of the accepted values that can be assigned to each variable.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Accepted Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>isProactiveKnowledgeOn</td>
<td>Controls if proactive knowledge is displayed during SR creation.</td>
<td>true or false</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this variable is set to <strong>false</strong>, proactive knowledge is entirely disabled. Consequently, no other variables related to proactive knowledge need to be configured.</td>
<td></td>
</tr>
<tr>
<td>disableProactiveKnowledgeSearchCount</td>
<td>The number of knowledge searches that a user must perform to prevent proactive knowledge articles from being displayed.</td>
<td>Positive integer</td>
</tr>
<tr>
<td></td>
<td>For example, if this value is set to 2, then if a user performs at least two searches</td>
<td>The default value is 1.</td>
</tr>
</tbody>
</table>
### Control How Many Knowledge Articles are Displayed

You can control the maximum number of knowledge articles to display when proactive knowledge displayed. The variable that controls this is `kmArticlesPageSize`.

**Note:** The default value assigned to `kmArticlesPageSize` is 5.

To configure how many knowledge articles to display:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the **Web Applications** tile.
4. In the **Web Apps** tree, expand `dcs`, then expand **flows**.
5. Click on **service-request-create**.
   - The **service-request-create** tab opens.
6. Click the (x) (Variables &Types) icon.
7. Click `kmArticlesPageSize`.
8. Enter the number of articles to display in the **Default Value** field.

#### Table: Additional Feature Configuration

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Accepted Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>disableProactiveKnowledgeViewCount</code></td>
<td>The number of knowledge articles that a user must view to prevent proactive knowledge articles from being displayed. For example, if this value is set to 3, then if a user views at least three knowledge articles, then proactive knowledge isn’t displayed.</td>
<td>Positive integer&lt;br&gt;The default value is 2.</td>
</tr>
<tr>
<td><code>kmArticlesPageSize</code></td>
<td></td>
<td>The maximum number of knowledge articles to display. The default value is 5.</td>
</tr>
</tbody>
</table>
Configure the Self-Service Registration Object

Use this topic to configure the Self-Service Registration object.

Overview of the Self-Service Registration Object

Digital Customer Service self-service registration requests are submitted using the Self-Service Registration object. This object is extensible and can be configured using the Application Composer in Oracle B2B Service. With the Application Composer, you can add new fields, validation rules and triggers to the object.

The payload of the REST request to the Self-Service registration resource can supply a value for the following attributes:

- Account Key
- Email
- First Name
- Middle Name
- Last Name

During the approval process, a contact record is created, and the attributes of the Self-Service Registration object can be transferred to the Contact object. The value assigned to the `SVC_CSS_REG_CONT_MAP` profile option determines which attributes in the Self-Service Registration object are transferred to which attributes in the Contact object. The default value assigned to `SVC_CSS_REG_CONT_MAP` profile option is: `PersonFirstName:PersonFirstName, PersonLastName:PersonLastName, EmailAddress:EmailAddress`. This means the value of the first name attribute of the Self-Service Registration object is transferred to the fist name attribute of the Contact object.

Use Case

For business reasons, if additional information needs to be gathered about the user submitting a registration request, custom fields can be added to the Self-Service Registration Object. If an additional field is a required, then a value must be provided in the REST request sent to the Self-Service Registration object.

If a new required custom attribute is added to the Contact object, a new custom attribute must also be added to the Self-Service Registration object and then specified in the `SVC_CSS_REG_CONT_MAP` profile option. This will transfer the value of the new attribute of the Self-Service Registration object to the new attribute of the contact object.

For example, if the date of birth of the user submitting the registration request is required for any reason, this attribute can be added to the Self-Service Registration object and mapped to the `Date of Birth` attribute that already exists on the Contact object. If the name of the attribute is `DateOfBirth` then the value of `SVC_CSS_REG_CONT_MAP` profile option should be `PersonFirstName:PersonFirstName, PersonLastName:PersonLastName, EmailAddress:EmailAddress, DateOfBirth:DateOfBirth`.

**Note:** The API Name of the new attribute is different from the Name.

Here are the tasks that you need to complete to address this use case:

1. Create the Field
2. Test the REST Request
3. Modify the Profile Option
Create the Field
First, you need to create the field.

To create the field:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Create a sandbox for adding the Date of Birth field:
   a. Click Navigator > Configuration > Sandboxes.
   b. Click Create Sandbox.
      
      The Create Sandbox page appears.
   c. Enter a name in the Name field.
   d. Click Create.
   e. In the Available Sandboxes list, click the name of the sandbox name that you specified in step c.
   f. Click the Plus icon (Add Tools).
      
      The All Tools dialog appears.
   g. Click the check-box in the Active next to each tool, then click OK.
   h. Click Enter Sandbox.
3. Navigate to the Application Composer.
4. Expand Objects, then Standard Objects, then Self-Service Registration, and then click Fields.

   The Fields page appears.
5. Click Create a custom field.
6. Click the Date option, then click OK.

   The Create Date Field page appears.
7. Specify the following for the Date field options:
   o In the Display Label field, enter the following string:
      
      Date of Birth
   o The Name field will be pre-populated based on the name that you entered for the Display Label, without any spaces.
   o The API Name field will be pre-populated based on the name that you entered for the Display Label, without any spaces, and typically with the following suffix:
     
     _c

     Tip:

     You will need to note the value assigned to the Date of Birth field, because it will be assigned to the svc_css_reg_cont_map profile option in the Modify the Profile Option task, later in this topic.
   o Deselect the Required option in the Constraints section.
   o Select the Updatable option in the Constraints section.
   o Deselect the Searchable option in the Constraints section.
   o Select the Include in Service Payload option in the Constraints section.
8. Click **Save and Close**.

**Test the REST Request**

Use this sample curl command to test the REST request:

```bash
Note: This is only an example. Your curl command must include details relevant to your deployment.

curl -X POST \
https://myhost.us.example.com/crmRestApi/resources/11.13.18.05/selfRegistrations \
-H 'Accept: application/json' \
-u "<user_name>:<password>" \
-H 'Content-Type: application/vnd.oracle.adf.resourceitem+json' \
-d '{
  "AccountKey": "HDFC Bank",
  "PersonFirstName": "Lilly",
  "PersonLastName": "Inigo",
  "EmailAddress": "lilly.inigo@example.com",
  "DateOfBirth_c": "2001-01-01"
}'
```

**Modify the Profile Option**

To modify the `svc_css_REG_CONT_MAP` profile option so that it includes the Date of Birth field:

1. Sign in to Oracle B2B Service as administrator or a setup user.
2. In the **Setup and Maintenance** work area, go to the following:
   - Offering: Service
   - Functional Area: Digital Customer Service
   - Task: Manage Digital Customer Service Profile Options
3. Click the `svc_css_REG_CONT_MAP` profile option.
4. Add the following profile option value to the list of values:
   ```
   DateOfBirth_c:DateOfBirth
   ```
5. Click **Save and Close**.

**Related Topics**

- Define Fields

**Set Up Visual Navigator**

Visual Navigator, once configured, enables you to show a grid of tiles on a page to facilitate navigation within and outside of the Digital Customer Service application.

When you drop the component on a page in the DCS application, you must configure the component before anything appears in the UI. You must determine the number of grid tiles, the image and text that displays in each tile along with the action that’s taken when each tile is clicked.

Find the Visual Navigator component in the list of Digital Customer Service components in the Components palette. Drag and drop the component from that location onto the page where you would like the Visual Navigator to appear. When you drop the component on the page, a NavigatorLoadAction action chain is created at the page level. You will
need to modify this action to configure the items the navigator displays. A number suffix is added to the name if more than one navigator is added to a given page.

Specify Items for an Array
To configure the navigator items you must first specify the items that you want the navigator to show in an array. You can specify this either by an action chain variable or using a separate JSON file.

Specify Items for the Action Chain Variable
Now you specify the items as an action chain variable. You edit the NavigatorLoadAction and set the default value of the action chain variable items to be an array.

1. From the page flow that you dropped the Visual Navigator component on, select the Actions icon.
2. From the list of Actions, select **NavigatorLoadAction**.
3. Click the **Action Chains - Variables** tab.
4. Select the items array from the list of variables
5. In the **Default Value** field, enter your code.

See the following example as reference.

```
[
  {
    "title": "Happy Holidays",
    "description": "Wishing all our customers a happy holiday season!",
    "type": "info",
    "icon": "fa fa-5x fa-glass-cheers"
  },
  {
    "title": "Setup your Nimbus 3000",
    "description": "How do I configure my Nimbus 3000?",
    "type": "knowledge-article",
    "id": "1003002",
    "icon": "fa fa-5x fa-question"
  },
  {
    "title": "My Service Requests",
    "type": "service-request",
    "operation": "list",
    "icon": "fa fa-5x fa-ticket-alt"
  },
  {
    "type": "product",
    "id": "CRMITEM-AS54888-00182744",
    "icon": "fa fa-5x fa-desktop"
  },
  {
    "type": "my-profile",
    "title": "My Profile",
    "description": "View your account information.",
    "icon": "fa fa-5x fa-user"
  },
  {
    "type": "url",
    "title": "Google",
    "icon": "fa fa-5x fa-search",
    "params": {
      "url": "https://www.google.com"
    }
  }
]```
Work With the JSON File
Create a JSON file on your local file-system using the same format as the previous example. From the web application navigator in Visual Builder upload the JSON file in a folder under the application's resource folder. Do this by either dragging and dropping the file or by right-clicking the folder you want to upload the JSON file to and selecting Import from the menu.

If you need to edit the NavigatorLoadAction use these steps:

1. Add a Call Module Function action as the first action in the chain.
2. Set the Call Module Function to call the application level loadJSON function.
3. Set the path input parameter of the function to be the relative path of the JSON file under the resources directory.
4. Add an Assign Variables action after the newly added Call Module Function action.
5. Assign the result of the call module function to flow level items variable.

Navigation Items
The supported types and operations are defined in the NavigateAction on the shell page. By default, the following types and operations are supported but these can be extended by adding additional cases to the shell page's NavigateAction. If no operation is specified it defaults to details.

The supported types and operations are listed in the following table:

<table>
<thead>
<tr>
<th>Description</th>
<th>Type</th>
<th>Operation</th>
<th>ID</th>
<th>Parameters</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static information</td>
<td>info</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the Contact Us Page</td>
<td>contact-us</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the Home page.</td>
<td>homepage</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visit a knowledge article</td>
<td>knowledge-article</td>
<td>knowledge-article</td>
<td>Knowledge article identifier. The kmContentId URL parameter when viewing the article in DCS.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the user's profile page</td>
<td>my-profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the product page</td>
<td>product</td>
<td></td>
<td>Item number of product</td>
<td></td>
<td>The title of the navigation item will be the product's name loaded from B2B Service.</td>
</tr>
<tr>
<td>Description</td>
<td>Type</td>
<td>Operation</td>
<td>ID</td>
<td>Parameters</td>
<td>Additional Information</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------------------------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Product Group</td>
<td>product-group</td>
<td></td>
<td>ProductGroupId of the product group</td>
<td></td>
<td>Title of the navigation item will be the product group's name loaded from B2B Service.</td>
</tr>
<tr>
<td>Category</td>
<td>category</td>
<td></td>
<td>CategoryId of the category</td>
<td></td>
<td>Title of the navigation item will be the category's name loaded from B2B Service.</td>
</tr>
<tr>
<td>Navigate to the service request create page.</td>
<td>service-request</td>
<td>create</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the service request list page.</td>
<td>service-request</td>
<td>list</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate to the work order list page.</td>
<td>work-order</td>
<td>list</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open a URL in a new tab.</td>
<td>url</td>
<td></td>
<td></td>
<td></td>
<td>{ &quot;url&quot;: &quot;<a href="https://www.samplewebpage.com">https://www.samplewebpage.com</a>&quot; }</td>
</tr>
</tbody>
</table>

**Icons and Images**

Items can have either an icon, such as a Font Awesome icon, or an image.

To apply an icon set the icon property of the item and specify the style classes required as its value, for example, fa fa-5x fa-user.

To use an image set the imageUrl property to the image's URL. Just a reminder, image names are case sensitive. Here's an example:

```
"imageUrl": "[[ $application.path + 'resources/images/service-request/SR0000038250.png' ]]
```

**Translations**

To specify a key in the application resource bundle set the title or description of the item to the key prefixed with an exclamation mark, for example, !bundle_key.

Here's an example:
Automatically Populate Key Information in Pre-Chat Form

You can automatically populate the product, category, and service request number in the pre-chat form, based on the page context in which the chat is initiated.

Here's how it works:

First, with the service request number on a service request form:

- If you're viewing a service request with a product (or product group) already selected and you initiate a chat, then the selected product (or product group) will be auto-populated in the pre-chat form.
- If you're viewing a service request with a category already selected and you initiate a chat, then the selected category will be auto-populated in the pre-chat form.
- If you're viewing a service request and you initiate a chat, then the service request number will be auto-populated in the pre-chat form.

Here's how fields are automatically populated on the Product Group landing page:

- If you're viewing a product landing page and you initiate a chat, then the selected product will be auto-populated in the pre-chat form.
- If you click through to a knowledge article from a product landing page, then the selected product will be auto-populated in the pre-chat form.

Now, the Product Group landing page:

- If you're viewing a product group landing page and you initiate a chat, then the selected product group will be auto-populated in the pre-chat form.

The Category Landing page:

- If you're viewing a category landing page and you initiate a chat, then the selected category will be auto-populated in the pre-chat form.
- If you click through to a knowledge article from a category landing page, then the selected category will be auto-populated in the pre-chat form.

And finally, here's the behavior with Knowledge search results:

- If you have done a knowledge search and selected a product from the product selector and you initiate a chat from the search results list or from a knowledge details page (from the search results), then the selected product will be auto-populated in the pre-chat form.
- If you have done a knowledge search and selected a category from the category selector and you initiate a chat from the search results list or from a knowledge details page (from the search results), then the selected category will be auto-populated in the pre-chat form.
The Chat component doesn't display the category, product or service request by default, so you must enable them by doing the following:

2. Navigate to Web Applications, dcs, and expand Root Pages, and then click shell.
3. Click shell, and then click the Page Structure icon.
4. In the Page Structure list, search for Chat.
5. Click Chat to display the property inspector.
6. Within the chat attributes, locate the category property, and click the arrow to display the sub-category.
7. Change the category.show sub-category value to true.
8. Click the category arrow to close the sub-category.
9. In the property inspector, locate the product property in the Chat attributes, and click the arrow to display the sub-category.
10. Change the product.show sub-category value to true, then click the product property arrow to close to sub-category.
11. Now locate the service-request property in the Chat attributes property inspector and click the arrow to expand the sub-category.
12. Change the service-request.show sub-category value to true.

Set Up Vanity URLs

The Vanity URL feature enables you to map a custom domain to your Oracle Visual Builder instance and Digital Customer Service Application. This topic describes how to provide a replacement domain to use instead of the typical Oracle domain. The Vanity URL feature is distinct from domain forwarding, where the browser gets redirected. With the CNAME mapping described here, your users will never see the Oracle domain in their browser.

To successfully set up a vanity URL, follow the following three tasks in this topic:

1. Configure a Domain Provider
2. Log a Service Request for Oracle Support
3. Set Up the Root URL App

Prerequisites

Before following the steps in this task you must make sure you own the sub-domain that you want to use and have access to the SSL certificate bundle information.

**Note:** If you have multiple Digital Customer Service applications you must perform these configuration steps on each one.

Configure the Domain Provider

The following instructions represent a generic overview for configuring a domain provider. The exact steps might be different, depending on your domain provider.

1. Create or identify a subdomain to map to Oracle Visual Builder via a domain provider. For example:
   myvb.jdeveloper.org.
2. Add a CNAME record for the subdomain to map to the Oracle Visual Builder instance URL. For example, create a CNAME record for my.jdeveloper.org that points to vbvanitytest-vbauto1.builder.ocp.oraclecloud.com.
3. Ensure a valid SSL certificate applies to that subdomain, either through your domain provider or through a valid certifying authority. For example, Comodo, DigiCert, or other.
**Note:** Even though it's possible to use a wildcard SSL certificate (*.example.org), the certificate bundle needs to be maintained on the server. Because of this, you will want to consider an SSL certificate, specifically for that subdomain. The following example shows a wildcard certificate issued for the *.jdeveloper.org domain.

4. Ensure that you have extracted or exported the bundle that contains the certificate and private key, because the certificate bundle will be managed on the server.

**Note:** Depending on your domain provider, you may need to indicate that you want to use the certificate on your own server in order to download the bundle.

You should now have a certificate along with a private key file.

**Log a Service Request for Oracle Support**

Now, you need to log a Service Request (SR) with Oracle Support to request your Oracle Visual Builder instance to be configured with your vanity domain.

1. Navigate to the Oracle Support site:

   https://support.oracle.com/

2. Sign in using your user name and password.

3. Create an SR. Your SR must include the following information:

   - The CNAME record showing the custom domain and the Oracle Visual Builder domain that it's pointing to.
   - The Certificate and Private key files. For example, the keys ending in .cer and .key.
Set Up the Root URL App

Follow the steps in this task to configure the custom URL for your domain.

To map a custom domain to your application:

1. In Visual Builder, click the **Web Applications** tab, and then click **Menu** and select **Settings**, as shown in the following example:

   ![Web Applications Menu](image)

   - Stage
   - Publish
   - Settings
   - Import
   - Export

   Open Staged Application

   - Help
   - About
   - Discussion Forum
   - Sign Out

2. In the Settings dialog box, enter the URL into the **Vanity URL** text field and click **Close**.

   The URL must be the full URL that you want to use and it must use valid form (for example, https://foo.example.org).

After you publish your DCS application, a visitor can type the custom domain (for example, https://foo.example.org) in the browser to open the web application. The URL won't contain any additional path parameters because the app is loaded as the root domain.

Post-Configuration Verification Tasks

This topic describes the post-configuration verification tasks recommended after configuring your Digital Customer Service application. The tasks outlined in this topic apply only if you created your Digital Customer Service application using the Digital Customer Service Reference Implementation template.
Verify the Knowledge Search Component

To verify the Knowledge Search component:

1. Navigate to your Digital Customer Service application.
2. Enter the search text for the Knowledge Management articles that have been created.
3. Click the Search icon.
4. Verify that the search results match the search text.
5. Click the Category field to verify the list of categories are displayed.
6. Click the Product field to verify the list of products are displayed.
7. Sign in to your Digital Customer Service application as a self-registered user.
8. Enter the search text for the Knowledge Management articles that have been created.
9. Click the Search icon.
10. Verify that the search results match the search text.
11. Click the Category field to verify the list of categories are displayed.
12. Click the Product field to verify the list of products are displayed.

Verify the Service Request Creator Component

To verify the Service Request Creator component:

1. Sign in to your Digital Customer Service application as a self-registered user.
2. Click the User menu, then select My Service Requests.
3. Click Create Service Request.
4. Enter details in the following fields:
   - Title
   - Describe the Problem
   - Category
   - Product
5. Click Submit.
6. Verify that a confirmation message appears.

Verify the Service Request List Component

To verify the Service Request List component:

1. Sign in to your Digital Customer Service application as a self-registered user.
2. Click the User menu, then select My Service Requests.
3. Verify that the Service Requests list contains the service requests created in the Verify the Service Request Creator Component task.
4. Specify a Filter.
5. Verify that the My Service Requests list returns only SRs that contain the filter in the title.
6. Change the Sort By to Service Request Number Ascending.
7. Verify that the Service Request list is ordered by SR number, where the lowest SR number appears first in the list.
Verify the Edit Service Request Data Component

To verify the Edit Service Request Data component:

1. Sign in to your Digital Customer Service application as a self-registered user.
2. Click the User menu, then select My Service Requests.
3. View an existing SR by clicking on it from the My Service Requests list.
4. Verify that the details of the SR that you selected are displayed as expected.
5. Add a message:
   a. In the Messages tab, enter a message in the Write a new message field.
   b. Click Submit.
   c. Verify that the message you entered is displayed in the list of messages at the end of the page.
6. Add a file attachment:
   a. Click the File Attachments tab.
   b. Drag-and-drop files into the Drop files to attach or browse box.
   c. Click the Pencil (Edit Description) icon next to an uploaded file, enter a description, then click the Check Mark (Update Description) icon.
   d. Verify that the file and its description are listed in the list of file attachments.
   e. Click the file name.
   f. Verify that the file is successfully downloaded.
7. Add a URL attachment:
   a. Click the URL Attachments tab.
   b. Enter a URL and a description.
   c. Click Submit.
   d. Verify that the URL and its description are listed in the list of URL attachments.
8. Escalate the SR:
   a. Click the Actions menu and select Escalate this request.
   b. Enter a message in the Escalate this request dialog box.
   c. Click Escalate.
   d. Verify that the SR displays an escalated indicator.
   e. Verify that the escalation message appears in the list of messages on the Messages tab.
9. Close the SR:
   a. Click the Actions menu and select Resolve this request.
   b. Enter a message in the Resolve this request dialog box.
   c. Click Resolve.
   d. Check that the SR displays a Status of Resolved.
   e. Verify that the closure message appears in the list of messages on the Messages tab.

Verify the Chat Component

To verify the Chat component:

1. Sign in to your Digital Customer Service application as a self-registered user.
2. Click the Live Chat Support link.
3. Fill in the **Subject** field.

   **Note:** Some user details are prepopulated in the form.

4. Click **Start Chat**.
5. Verify that the chat connects, and is placed in the queue.

   If the chat component isn’t working, you may need to enable the SVC_ENABLE_CHAT profile option. For more information, see Related Topics for a link to the Configure Chat Profile Options topic.

### Verify Search Results with Product and Category as Search Criteria

To verify search results where both product and category are used as search criteria:

1. Sign in to your Digital Customer Service application as a self-registered user.
2. Enter your search criteria in the **Search** text box.
3. Expand the **Filter your search** option.

   The **Select category** and **Select product** fields appear.

4. Navigate the product hierarchy in the **Select product** field, then click a product.
5. Navigate the category hierarchy in the **Select category** field, then click a category.
6. Click the **Magnifying Glass** (Search) icon.

   Your search results appear.
7. Verify the results match the search criteria.

### Related Topics
- Configure Chat Profile Options

### Add a B2B Service Field to the Service Request Page

There several steps you perform to add a custom field from B2B Service into the Service Request form.

- Replace the service metadata: You first replace the service metadata in Digital Customer Service with the latest metadata from B2B Service, including the configurations you would like the Digital Customer Service application to consume.
- Edit the page itself. You add the new field, change the REST API call to ensure that the new field is requested or sent, and then you add a new UI control for the new field onto the page.

### Replace the Metadata

Replace the endpoint metadata in the application with the latest metadata from the server that includes the new configuration.

1. In Visual Builder select the **crmRestApi** in the Services window, and then click the **Service Connections** icon in the navigator.
2. Click the **Endpoints** tab.
3. Click the **Replace definitions for all selected endpoints** icon.
4. Click **Replace** on the **Confirm definitions replace** dialog box.
5. Once the operation is complete, click **OK**.

### Add the New Field

Now you add the new field to the corresponding type in the Digital Customer Service application

1. In the navigator, click the **Web Application** icon.
2. Expand the **Flows** node.
3. Expand the **service-request-create** flow.
4. Select **service-request-create-start**.
5. From the Designer list, select the **Variables and Types** icon.
6. In the workspace, for the createServiceRequest type, click **Edit from Endpoint**.
7. From the **Endpoint Structure** list, select the custom field, and then click **Finish**.

### Change the REST Request

Change the action chain for the REST request to ensure that the field is included in the body of the create request and mapped to the property on the object.

1. Ensure that the **service-request-create-start** is selected, and then from the Designer list, select the **Actions** icon.
2. In the workspace, select **SubmitServiceRequestAction**.
3. In the workspace, select the callCreateServiceRequestEndPoint REST call.
4. In the **Call Action Chain** window, in the **Input Parameters** area, click **Assign**.
5. In the **Call Action Chain** workspace, in the **Target** area, click **body**.
6. Before the closing brace in the JSON code, add a new entry for the custom field. Make sure you add a trailing comma to the preceding line.

   For example, "MyCustomField_c": [[ $page.variables.serviceRequest.MyCustomField_c ]]

### Change the GET REST Request for the List

Edit the action chain or service data provider that does the GET request and make sure the field parameter of the GET includes the custom field. You also may need to map the field in the response to a variable.

1. In the Web Apps list, expand the **Flows** node, and then expand the **service-request-list** node.
2. Select **service-request-list-start**
3. In the Designer, click the **Variables and Types** icon.
4. In the Variables workspace, select **srListServiceDataProvider**.
5. In the **Parameters** list, select the **fields** parameter.
6. In the **urlParameters.field** area, add a comma at the end of the field list, and add the B2B Service custom field name, then click **Save**.

### Change the GET REST Request for the Detail Page

Now edit the request for the detail page.

1. From the Flows list, expand the **service-request-detail** node, and then select **service-request-detail-start**.
2. Click the **Actions** icon in the Designer.
3. Locate **LoadServiceRequestAction**, and click the **Menu** icon in that row, and select **Edit**.
4. In the diagram, click **Call REST Endpoint**.
5. In the **Input Parameters** list, select **fields**.
6. Add the new custom field to the comma separated list of fields and then click **Save**.
Enable Your Own Sign In Pages

To enable your own sign-in pages, you must first update your Digital Customer Service application configuration to use Digital Customer Service as the Security provider. After doing this, VBCS will inject data into the app-flow.json file which will allow the Digital Customer Service Security Provider to have access to the same IDCS configuration information as the standard VB security provider. In addition to enabling you to create your own sign-in page, using the Digital Customer Service Security Provider enables you to use the Change Password button on the My Profile page in the out of the box reference implementation. That button takes the user to the reference implementation's Change Password page.

1. Using the application navigator’s Source View, navigate to webApps > webAppName > app-flow.json.
2. Locate the userConfig element in the app-flow.json file of the application in the DT editor, and replace the child element "type": "vb/DefaultSecurityProvider" with "type": "oj-odcs/application-common/OdcsSecurityProvider".
3. Then, add "defaultSecurity": true.

This entry must be a child element of the "userConfig/configuration" element which tells VBCS to send IDCS configuration data to the app-flow.json file during application staging. Here’s how the updated "userConfig" element should look:

```json
"userConfig": {
    "type": "oj-odcs/application-common/OdcsSecurityProvider",
    "configuration": {
        "defaultSecurity": true,
        "authentication": {
            "type": "implicit"
        },
        "embedding": "deny"
    }
}
```

You can optionally specify the custom sign-in page for Digital Customer Service by setting userConfig/configuration.odcsLoginPath to point to a VB page path. If this path isn’t specified, the RI default of shell/sign-in is used.

Set the Service Instance URL

Now you must set the service instance URL for the idcsRestApi Service Connection.

1. In Oracle Visual Builder, open your Digital Customer Service application (if it’s not open already).
2. Click Service Connections, click idcsRestApi, and then click the Servers tab.
3. Click Edit, then in the Edit Server page, edit the Instance URL to be the URL of your IDCS server
4. Click Save.

Verify the Identity Cloud Service Identity Provider Policy

If you have a custom sign-in page for your Digital Customer Service application confirm that IDCS is enabled to use the User Name-Password authentication factor.

1. In the Identity Cloud Service administration console, click the Navigation Drawer, the expand Security, and choose IDP Policies.
2. Click Default Identity Provider Policy, and then the Identity Provider Rules tab.
3. Click the Menu icon and choose Edit.
4. In the Edit Default IDP Rule dialog box, make sure **Username-Password** is shown in the **Allowed Identity Providers** box. If not, do the following:
   a. Click in the **Assign Identity Providers** box, and select **Username-Password**.
   b. Click **Save**.

If you don’t want to add **Username-Password** to the Default Identity Provider Policy, you can add a new IDP Policy for the Digital Customer Service application to use. When you create the new policy, add a rule that allows the Username-Password Identity Provider and assign the Digital Customer Service application to the policy. This will ensure that the application uses the new IDP policy instead of the default IDP policy.

For more information, see Related Topics for a link to the Identity Cloud Service documentation.

**Related Topics**
- Understand Identity Provider Policies

### Configure Custom Password Reset in Identity Cloud Service

Use this topic to set up Identity Cloud Service to include the Digital Customer Service Reset Password page URL link when a user requests a password reset.

For this functionality to work Identity Cloud Service requires a REST request to be made to the IDCS /Settings API by a tenant administrator to set `allowedNotificationRedirectUrls` to include the Digital Customer Service Reset Password page URL. This setting defines the allowed notification redirect URLs which can be specified as the value of `notificationRedirectUrl` in the POST `.../admin/v1/MePasswordResetRequestor` request payload, which is then included in the reset password email notification sent to a user as part of the forgot password/password reset flow.

**Note:** The Client ID and Client Secret must be for an IDCS application which has either the Identity Domain Administrator or Security Administrator application role granted. This is required to successfully invoke the /Settings REST API.

Use the following PowerShell script:

```powershell
### MODIFY THE FOLLOWING VARIABLES FOR YOUR IDCS/ODCS ENVIRONMENT ###

# Set IDCS variables (modify for your IDCS instance)
$IdcsUrl = '...' # e.g. 'https://idcs-xxx.identity.yyy.idcs-host.com'
$ClientId = '...' # Client ID for privileged app in IDCS
$ClientSecret = '...' # Client Secret for privileged app in IDCS

# Either set the first 3 variables below for your ODCS app or explictly define $ForgotPasswordUrl
$OdcsHost = '...' # e.g. 'my-odcs-server.com'
$OdcsAppName = '...' # e.g. 'my_odcs_app'
$OdcsVersion = '...' # e.g. '1.1'
$ForgotPasswordUrl = "https://${OdcsHost}/ic/builder/rt/${OdcsAppName}/${OdcsVersion}/webApps/dcs/?page=shell&shell=forgot-password"

### DO NOT MODIFY THIS SCRIPT BELOW THIS LINE ###

# Generate an access token
$Credentials = [Convert]::ToBase64String([System.Text.Encoding]::UTF8.GetBytes("${ClientId}:${ClientSecret}"))
$Uri = "$IdcsUrl/oauth2/v1/token"
$Headers = @{
    Authorization = "Basic $Credentials"
}
```
```powershell
$Parameters = @{
    grant_type = 'client_credentials',
    scope = 'urn:opc:idm:__myscopes__'
}
try {
    $Response = Invoke-RestMethod -Uri $Uri -Method POST -Headers $Headers -Body $Parameters
} catch {
    Write-Host "Access token request POST to {0} failed with an error: {1}`nForm parameters: {2}`nException: {3}" -f $Uri, ($Parameters | Out-String), $_.ErrorDetails, $_.Exception -fore red
    exit
}
$AccessToken = $Response.access_token
Write-Debug "Access Token = $AccessToken"

# Check the 'allowedNotificationRedirectUrls' IDCS Setting value
$Uri = "$IdcsUrl/admin/v1/Settings/Settings/?attributes=allowedNotificationRedirectUrls"
$Headers = @{
    Authorization = "Bearer $AccessToken"
    'Content-Type' = 'application/scim+json'
}
try {
    $Response = Invoke-RestMethod -Uri $Uri -Method GET -Headers $Headers
} catch {
    Write-Host "Request to GET {0} failed with an error: {1}.`nException: {2}" -f $Uri, $_.ErrorDetails, $_.Exception -fore red
    exit
}
$AllowedUrls = $Response.allowedNotificationRedirectUrls
Write-Debug "Allowed URLs from GET /admin/v1/Settings/Settings = $AllowedUrls"

# Add the forgot password URL to the Settings, if required (i.e. not already in $AllowedUrls)
if ($null -ne $AllowedUrls -And $AllowedUrls.Contains($ForgotPasswordUrl)) {
    Write-Output "URL ($ForgotPasswordUrl) is already registered"
} else {
    # Remove query parameter from /Settings URL, headers remain as for previous request
    $Uri = "$IdcsUrl/admin/v1/Settings/Settings/"
    # Add new URL and format the list for inclusion in the JSON payload (without powershell encoding)
    $AllowedUrls += $ForgotPasswordUrl;
    $AllowedUrls = '"{0}"' -f ($AllowedUrls -join '","')
    $Body = '{
        "schemas": ["urn:ietf:params:scim:api:messages:2.0:PatchOp"],
        "Operations": [
        {
            "op": "replace",
            "path": "allowedNotificationRedirectUrls",
            "value": [" + $AllowedUrls + '"]
        }]
    }
    try {
        $Response = Invoke-RestMethod -Uri $Uri -Method PATCH -Headers $Headers -Body $Body
    } catch {
        Write-Host "Request to PUT {0} to {1} failed with an error: {2}.`nException: {3}" -f $Body, $Uri, $_.ErrorDetails, $_.Exception -fore red
        exit
    }
    $AllowedUrls = $Response.allowedNotificationRedirectUrls
    Write-Output "Added new URL: $ForgotPasswordUrl"
}
```
Write-Output "\nAllowed Notification Redirect URLs:
Write-Output $AllowedUrls

Localize Digital Customer Service for Multilingual Support

This topic describes how to localize Digital Customer Service for multilingual support.

How You Create Localized Digital Customer Service Applications

You can create localized versions of your application by translating the UI text and messages in your application into other languages. The localized strings are displayed in the application during runtime. When you run the staged or published application, a localized version is displayed based on the language settings of your browser.

A Digital Customer Service application created using the Reference Implementation template includes translations to the 25 languages supported by Oracle B2B Service. While the Reference Implementation template is delivered with these translation strings and files, any modifications that you apply to the strings in your Digital Customer Service application will require additional translation.

The supported default language locales are as follows: ar, cs, da, de, es, fi, fr-CA, fr, hu, it, iw, ja, ko, nl, no, nl, pt-BR, ro, ru, sk, sv, th, tr, zh-CN, zh-TW.

The resource bundles provide an initial set of translated strings for the majority of the application that you can use for your own translation files. To populate the rest of the translation files for the languages you want to support, follow the instructions for generating files for new languages, and then use the existing translated files to obtain translations for use in your new file.

The Digital Customer Service Reference Implementation template comes with a single, application specific bundle. If you create strings, you must add the translations to the bundle, or create bundles.

For comprehensive information about adding translated text to your application, refer to the Work with Translations topic in the Develop Applications chapter of the Developing Applications with Oracle Visual Builder guide in the Related Topic.

Configure Languages Available in your Digital Customer Service Application

By default, the preferred language specified in the viewing browser is used to display your Digital Customer Service application to users. In the Digital Customer Service Reference Implementation template, a languages menu can be configured to list the specific languages that you want to make available to your users, should they want to use another language.

To configure the languages available to your Digital Customer Service application users:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click Web Applications.
4. In the Web Apps tree, expand dcs, then root pages, and then click shell. The shell tab appears.
5. Click the JS (Functions) icon.
6. Search the script for the following string:

   `PageModule.prototype.localeList`

7. Copy the language that you want to include in the languages menu from the section that is commented out. Do not include the `//` at the beginning of the line. For example, if you want to make Italian available, copy the following string:

   ```
   { code: 'it', name: 'Italiano'},
   ```

8. Paste the string that you copied in step 7 into the available languages that are not commented out, in the `PageModule.prototype.localeList` section.

9. Click the Play icon (Run) to view the change in your application.

10. Click the Globe icon (Languages) to verify that the language that you added in step 7 appears in the list of available languages.

Create Translations for New Languages

You can introduce a new language beyond the ones delivered with a Digital Customer Service application that was created using the Reference Implementation.

For more information, refer to the Work with Translations topic in the Developing Applications with Oracle Visual Builder in the Related Topics.

To introduce a new language beyond the ones delivered with a Digital Customer Service application that was created using the Reference Implementation, follow these steps:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Menu icon in the editor, and select Settings.

   The Settings tab appears.

4. Click theTranslations secondary tab.

5. Download the latest language bundle by clicking the ARB or XLIFF download link in the Download all strings section.

   A zip file is downloaded.

6. Open your zip file.

7. Extract the app-strings file.

8. Rename the app-strings file to app-strings-<locale>.arb or app-strings-<locale>.xliff, depending on the downloaded file type. Where `<locale>` is the language locale.

   For example, for a file containing Welsh translations, the modified file name should be: app-strings-cy.arb Or app-strings-cy.xliff.

9. Open your app-strings-<locale> file in a text editor. The first few lines of the file will resemble the following:

   ```
   {
   "@@x-bundleName" : "app",
   "@@x-bundlePath" : "webApps/dcs/resources/strings/app/nls/app-strings",
   "common_save" : "Save",
   "@common_save" : {
   "description" : "Used by components that perform a saving operation.",
   "source_text" : "Save"
   },
   "common_cancel" : "Cancel",
   "@common_cancel" : {
   ```
10. Replace the English strings with the translation for the language you are creating. Consider the following `cancel` string:

```json
  "common_cancel" : "Cancel",
  "@common_cancel" : {
    "description" : "Used by components that cancel the current operation.",
    "source_text" : "Cancel"
  },
```

You would want to replace the string after the `"common_cancel": "` with the translated language equivalent. In this example, you would want to replace the string `Cancel` with the Welsh equivalent for Cancel, which is `Canslo`. The modified text will look similar to the following:

```json
  "common_cancel" : "Canslo",
  "@common_cancel" : {
    "description" : "Used by components that cancel the current operation.",
    "source_text" : "Cancel"
  },
```

11. Repeat step 10 for all the strings in the language that you are creating.


13. Add the app-strings-<locale> file to the zip file that you downloaded in step 5, and save the updated zip file.

14. Click the Menu icon in the editor, and select Settings.

The Settings tab appears.

15. Click the Translations secondary tab.

16. Upload the zip file that you saved in step 13, containing your new app-strings-<locale> file to the Uploaded updated bundle section.

The language is added to the bundle.

**Add New String Translations for Existing Languages**

You can translate additional strings after modifying strings in your Digital Customer Service application generated from the Reference Implementation template.

For more information, refer to the Work with Translations topic in the Developing Applications with Oracle Visual Builder in the Related Topics.

To add new string translations for existing languages:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Menu icon in the editor, and select Settings.
The **Settings** tab appears.

**4.** Click the **Translations** secondary tab.

**5.** Download the latest language bundle by clicking the **arb** or **xliff** download link in the **Download new and changed strings** section.

A **zip** file is downloaded.

**6.** Open your **zip** file.

**7.** Extract the app-strings file.

**8.** Rename the app-strings file to **app-strings-<locale>.arb** or **app-strings-<locale>.xliff**, depending on the downloaded file type. Where **<locale>** is the language locale.

For example, for a file containing French translations, the modified file name should be **app-strings-fr.arb** or **app-strings-fr.xliff**.

**9.** Open your **app-strings-<locale>** file in a text editor.

**10.** Replace the English strings with the translation for the language you are updating. Consider the following **Submit Now** string:

```json
{
  "common_submit_now" : "Submit Now",
  "@common_submit_now" : {
    "description" : "Used to submit data entered in a form immediately.",
    "source_text" : "Submit Now",
  },
}
```

You would want to replace the string after the **"common_submit_now": "** with the translated language equivalent. In this example, you would want to replace the string **Submit Now** with the French equivalent for **Submit Now**, which is **Soumettre Maintenant**. The modified text will look similar to the following:

```json
{
  "common_submit_now" : "Soumettre Maintenant",
  "@common_submit_now" : {
    "description" : "Used to submit data entered in a form immediately.",
    "source_text" : "Submit Now",
  },
}
```

**11.** Repeat step 10 for all the strings in the language that you are creating.

**12.** Save your **app-strings-<locale>** file.

**13.** Add the **app-strings-<locale>** file to the **zip** file that you downloaded in step 5, and save the updated **zip** file.

**14.** Click the **Menu** icon in the editor, and select **Settings**.

The **Settings** tab appears.

**15.** Click the **Translations** secondary tab.

**16.** Upload the **zip** file that you saved in step 13, containing your new **app-strings-<locale>** file to the **Uploaded updated bundle** section.

The language bundle is updated with the new string translations for the existing language.

**Related Topics**

- Developing Applications with Oracle Visual Builder
- Work with Translations
7 Users and Accounts

Self-Service Registration

Here’s an overview of user self-service registration.

When the Digital Customer Service Reference Implementation template is used to create your Digital Customer Service application, users can take advantage of the self-service registration feature available to anonymous users through the **Sign-Up** link on the home page of their Digital Customer Service application. There are various profile options that control the way in which the self-service registration feature behaves. For more information about profile options relating to self-service registration, refer to Configure Profile Options in the related topics.

One profile option to note though is the ZCA_CONTACT_ADDRESS_REQUIRED_ENABLED profile option. You must set this profile option to one of two values:

- **No.** This means a contact address for the contact is optional.
- **Yes for Customer only.** This is the default value and it means that an address is required for contacts of the Customer type only.

**Note:** The Digital Customer Service Self Service Registration feature doesn't support requiring addresses for all contact types, just for the Customer type.

The APPID user is used to call the self-registration API on behalf of the anonymous user when they use the **Sign-Up** link.

**Note:** A user can register multiple times if they need to be registered as a user in multiple customer accounts. Each registration request should use a different Account Key.

**Related Topics**

- Configure Profile Options

Set Up Self-Service Registration without an Account Key Requirement

Administrators can enable this feature in the Setup and Maintenance work area. This feature is delivered enabled.

**Note:** After enabling the self-service registration without an account key requirement, as specified in this section, the ODCS application developer specifies whether or not to require the account key by specifying the ODCS application-level variable userRegistrationType. The value **consumer** is used if you don’t want to specify an account key. The default is **contact**, which requires an account key.

1. Sign in to B2B Service as an administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
Task: Manage Digital Customer Service Profile Options.

3. Locate the SVC_CSS_ALLOW_CONSUMER profile option and set it to Yes.
4. Optional step: Locate the SVC_CSS_CONSUMER_USER_CATEGORY and set it to the user category for consumers which defines the redirect URL for self-service users after a password reset.

After these settings are enabled, the Account key field will no longer be required for self-service users to register in the ODCS application.

Assign Roles to Digital Customer Service Users

This topic shows you how to assign user roles in the Digital Customer Service application.

Self-Service Account Administrator

Each customer account must have at least one self-service account administrator. You can assign or remove the account administrator role to user accounts in Oracle B2B Service.

Note: The first user created under a customer account is always automatically made granted the Account Administrator role for that account. The steps that are listed in this topic, are for creating additional account administrators.

To assign the self-service account administrator role:

1. Sign into Oracle B2B Service as an administrator or setup user.
2. Navigate to the Service work area and click Self-Service Users.
3. From the Self-Service Users list, select the user you want to modify.
4. In the User Administration section, select the following role: Account Administrator.
5. Click Save.

A dialog appears, confirming the role modification.

Self-Service Account Manager

You can assign the self-service account manager role to user accounts in Oracle B2B Service.

To assign the self-service account manager role:

1. Sign into Oracle B2B Service as an administrator or setup user.
2. Navigate to the Service work area and click Self-Service Users.
3. From the Self-Service Users list, select the user you want to modify.
4. In the User Administration section, select the following role: Account Manager.
5. Click Save.

A dialog appears, confirming the role modification.

Set Up Customer Accounts
Create a Custom Account Key Field

Use this topic to create a custom Account Key field for Digital Customer Service. The value of the new Account Key field must be unique to each account and can be set to any value. If the value is set to a string that's easy to guess then someone could guess the value and create for themselves a user account. This is a particular problem if automatic approval is set to true. If the account key is set to a string that is difficult to guess then only those to whom the string is sent can successfully submit a registration request.

End user customers are required to have a known account key. Users must also specify an appropriate account key when they register for a self-service user account.

Multiple tasks must be completed to create a custom Account Key field for Digital Customer Service. To create a custom Account Key field for Digital Customer Service, complete these tasks in the order that they appear in this topic:

1. Add the Account Key to the Account Object
2. Add the Account Key to Pages
3. Populate the Account Key for Existing Accounts
4. Publish the Sandbox
5. Set a Profile Attribute for the Account Key

Add the Account Key to the Account Object
To add a custom field for the Account Key to the Account object, you will need to use the Application Composer in Oracle B2B Service.

To add the Account Key to the Account Object:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Create a sandbox for adding the Account Key field:
   a. Click Navigator > Configuration > Sandboxes.
   b. Click the + icon (New) to create the new sandbox.
      The Create Sandbox dialog appear.
   c. Enter a name in the Sandbox Name field.
   d. Click Save and Close.
      A confirmation dialog appears.
   e. In the Manage Sandboxes list, click the line item with the sandbox name that you specified in step c.
   f. Click Set as Active.
3. Navigate to the Application Composer.
4. Expand Objects, then Standard Objects, then Account, and then click Fields.
   The Select Field Type page appears.
5. Click the Action menu, and select Create.
   The Select Field Type dialog appears.
6. Click the Text option, then click OK.
   The Create Text Field page appears.
7. Specify the following for the Account Key text field options:
   o In the Display Label field, enter the following string: 
      Account Key
The **Name** field will be pre-populated based on the name that you entered for the **Display Label**, without any spaces.

The **API Name** field will be pre-populated based on the name that you entered for the **Display Label**, without any spaces, and typically with the following suffix:

\[-c\]

**Tip:**

You will need to note the value assigned to the **API Name** field, because it will be assigned to the `svc_css_acct_key_field` profile option in the Set a Profile Attribute for the Account Key task, later in this topic.

- In the **Display Type** option, click the **Simple Text Box** option.
- Deselect the **Required** option in the **Constraints** section.
- Select the **Updatable** option in the **Constraints** section.
- Select the **Searchable** option in the **Constraints** section.
- Select the **Include in Service Payload** option in the **Constraints** section.

8. Click **Save and Close**.

**Add the Account Key to Pages**

In this task, you will add the Account Key field that you created in the previous task to the necessary pages in the Oracle B2B Service Application Composer.

To add the Account Key to Pages:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Navigate to the **Application Composer**.
3. Expand **Objects**, then **Standard Objects**, then **Account**, and then click **Pages**.
   
   The **Account: Pages** page appears.
4. In the **Creation Page Layouts** section, select a layout to base your page on, such as **Standard layout**.
5. In the **Creation Page Layouts** section, click the **Actions** menu, and select **Duplicate**.
   
   The **Duplicate Layout** dialog appears.
6. Enter a name in the **New Layout Name**.
7. Click **Save and Edit**.
8. Click the **Pencil** icon (**Edit**) next to **FUSE Customer ObjectCreation View**.
9. The **Creation Layout** page appears.
10. From the **Available Fields** column, click the **AccountKey** field that you created in the previous task, then click the arrow to move it to the **Selected Fields** column.
11. Click **Save and Close**.
12. Click the **AccountKey** hyperlink, then set the following options on the **Edit UI Properties** dialog:
   
   - Set **Required** to **No**.
   - Set **Updatable** to **Yes**.
   - Set **Hidden** to **No**.
13. Click **Save and Close**.
14. Click **Done**.
15. In the **Details Page Layouts** section, click the **Actions** menu, and select **Duplicate**.
The **Duplicate Layout** dialog appears.

16. Enter a name in the **New Layout Name**.
17. Click **Save and Edit**.
18. In the **Subtabs Region**, click the **Profile** subtab.
19. Click the **Pencil** icon (**Edit**) next to **Summary Edit Summary Subtab**.

   The **Details Layout Edit Summary** page appears.

20. From the **Available Fields** column, click the **Account Key** field that you created in the previous task, then click the arrow to move it to the **Selected Fields** column.
21. Click **Save and Close**.
22. Click the **Account Key** hyperlink.

   The **Edit UI Properties** dialog appears.

23. Set **Required** to **Expression**, then click the **xyz** next to the **Required** field.

   The **Advanced Expression** dialog appears.

24. In the **Edit Script** text box, add the following expression:

   ```java
   if (SalesProfileType == "ZCA_CUSTOMER") {return true} else {return false}
   ```

   **Note:** This makes the Account Key required if the **Account Type** is **Customer**. Self-service registration only works for **Customer** accounts.

25. Click **OK**.
26. Set **Updatable** to Yes.
27. Set **Hidden** to **Expression**, then click the **xyz** next to the **Required** field.

   The **Advanced Expression** dialog appears.

28. In the **Edit Script** text box, add the following expression:

   ```java
   if (SalesProfileType != "ZCA_CUSTOMER") {return true} else {return false}
   ```

   **Note:** This hides the field if it's not a **Customer** account type.

29. Click **OK**.
30. Click **Save and Close**.

### Populate the Account Key for Existing Accounts

If you already have existing Customer accounts, you will need to edit the accounts, and add the required Account Key field.

**Note:** Make sure to assign unique values to each account.

To add the Account Key to existing Customer account:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Navigate to **Accounts**.
3. Search for, then click on the account.

   The **Edit Account** dialog appears.

4. In the **Account Key** field, enter a value that uniquely identifies the Customer account.
5. Click **Save and Close**.
6. Repeat steps 3-5 for all previously existing Customer accounts.
Publish the Sandbox
To ensure that the configuration that you applied in the previous tasks takes effect, you must now publish the sandbox.

To publish the sandbox:
1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Click Navigator > Configuration > Sandboxes.
3. Select the name of the sandbox created in step 2 of the Add the Account Key to the Account Object task. The Sandbox Details dialog appears.
4. Click Publish.

Set a Profile Attribute for the Account Key
The account key is used to uniquely identify an account, and is determined by the value assigned to the SVC_CSS_ACCT_KEY_FIELD profile option.

By default, the SVC_CSS_ACCT_KEY_FIELD profile option is set to the organizationName field, which appears as Name of the Account in the Oracle B2B Service User Interface for account management. You must create an attribute to be the account key: the default account key of organizationName isn't secure because it can be easily guessed.

You must set the SVC_CSS_ACCT_KEY_FIELD profile option to the API Name field of the Account Key created in step 7 of the Add the Account Key to the Account Object task in this topic.

For more information about configuring profile options, refer to Configuring Profile Options in the Related Topics.

Related Topics
- Working with Fields
- Configure Profile Options

Create a Customer Account in Oracle B2B Service
To set up a customer account in Oracle B2B Service:
2. Navigate to the Service work area and click Accounts.
3. Click Create Account.
4. Enter the Name.
5. Select Customer from the Type menu.
6. Specify the account key in the appropriate field.

Note: The field in which you enter the account key depends on the value assigned to the SVC_CSS_ACCT_KEY_FIELD profile option. The account key should be specified in the attribute that you defined for the account key.
7. Click Save and Close.

End User Self-Registration User Account Creation
The Oracle Digital Customer Service Reference Implementation has sample pages that provide the ability for an end user to self-identify and register within the application.

The end user needs the account key to register successfully.
Manage Registration Requests

Registration requests are sent to Oracle B2B Service for users intending to use Digital Customer Service features. Administrators must then determine whether the request should be approved or rejected in the Service work area. This topic explains how to accept and reject registration requests in Oracle B2B Service.

Approve Registration Requests

This topic describes how to approve registration requests in Oracle B2B Service.

To approve registration requests:

1. Sign in as a user with a role that includes the Customer Self-Service Administrator duty role.
2. Navigate to the Service work area and click Registration Requests.
   The Self-Service Registrations screen is displayed. By default, a list of pending self-service registrations is displayed.
3. Click the Actions list, then select Approve.
4. Select one or more pending registration requests that you want to approve.
5. Click the Approve (# Selected) button.

   Note: The number sign (#) represents the number of registration requests selected.

   The Requests to Be Approved dialog box appears.
6. (Optional) In the Reason for Approving text box, enter a reason.
7. Click the Approve button.
   A message appears, confirming the number of approved registration requests. The approved requests no longer appear in the pending list.

   Note: When a user registration request is approved, a welcome email is sent to the user with a password reset link.

Reject Registration Requests

This topic describes how to reject registration requests in Oracle B2B Service.

To reject registration requests:

1. Sign in as a user with a role that includes the Customer Self-Service Administrator duty role.
2. Navigate to the Service work area and click Registration Requests.
   The Self-Service Registrations screen is displayed. By default, a list of pending self-service registrations is displayed.
3. Click the Actions list, then select Reject.
4. Select one or more pending registration requests.
5. Click the **Reject (# Selected)** button.

    **Note:** The number sign (#) represents the number of registration requests that you have selected.

    The **Requests to Be Rejected** dialog box appears.

6. (Optional) In the **Reason for Rejecting** text box, enter a reason.
7. Click the **Reject** button.

   A message appears, confirming the number of rejected registration requests. The rejected requests no longer appear in the pending list.

---

### Manage Self-Service Users

Users can be granted different roles. By default, when a registration request is approved for a user, they are granted the User role. However, administrators can grant or remove roles, depending on the user’s intended responsibilities.

**Note:** The first user to be approved for a customer account is automatically granted the Account Administrator role. There must always be one user with the Account Administrator role for an account.

Use this topic to add and remove roles for self-service users in Oracle B2B Service. For more information about self-service user roles, see About Digital Customer Service Roles.

To manage self-service roles for an account:

1. Sign in as a user with the Customer Self-Service Administrator role.
2. Navigate to the **Service** work area and click **Self-Service Users**.
3. From the **Self-Service Users** list, select the user you want to modify.
4. In the **User Administration** section, select or deselect one or more of the following roles:
   - **User**
   - **Account Manager**
   - **Account Administrator**

   **Note:** Removing the User role causes the removal of all privileges. The only way to restore the privileges is to submit a new registration request. You cannot delete the User role for the last Account Administrator because each account must have at least one administrator.

5. Click **Save**.

   A dialog appears, confirming the role modifications.

**Related Topics**

- Digital Customer Service Roles
Import Self-Service Users

This topic shows you how to import self-service users for use with your Digital Customer Service application.

The primary use case for using import is when you're migrating from one service implementation solution to Oracle Digital Customer Service. In this use case, you will likely have some existing reference identifiers on the originating service implementation solution that you want to retain. In this case, using the following fields might help: AccountPartyOrigSys, AccountPartyOrigSysRef, ContactOrigSys, ContactOrigSysRef. Additionally, there is a primary key for the data set being imported. The value of the primary key column is automatically generated in the Oracle Fusion Applications data model. Oracle Fusion Applications automatically assigns values for Contact Party Id and Account Party Id. Account Party Number must be unique, and is assigned by Oracle Fusion Applications if it’s not already specified. For more information on importing, refer to the Related Topics.

Another use case for using import is to bulk import and create self-service users from a text file. You might want to do this in a situation where you have a new customer account, and are being supplied with the list of authorized users.

Here is a high level overview of what you will be doing when importing self-service users:

- Creating contacts
- Assigning self-service roles and associating them with customer accounts
- Downloading the Self-Service Roles template.
- Preparing the Import file, then importing the users.
- Sending pending LDAP requests.
- Synchronizing the user accounts and their roles with Oracle Identity Cloud Service

**Note:** When using the import process for creating self-service users, there is no additional approval step required.

Create Contacts

Your first step is to create the contacts. The contact must have an email address. To create contacts, follow the instructions in the Import Your Contact Data task in the Related Topics list. This may also require you do the Import Your Account Data task, which is also in the Related Topics list, if you have not already done that yet.

Assign Self-Service Roles and Associate them with Customer Accounts

The next step is assigning and associating the self-service roles with customer accounts. Refer to the Manage Self Service Users topic in this guide.

Download the Self-Service Roles Template

This section describes how to download the self-service roles template.

The self-service roles template contains the following fields:

- AccountPartyId
- AccountPartyNumber
- AccountPartyOrigSys
- AccountPartyOrigSysRef
• ActionCode
• ContactOrigSys
• ContactOrigSysRef
• ContactPartyId
• ContactPartyNumber
• DeleteFlag
• EndDate
• ErrorMessage
• JobDefinitionName
• JobDefinitionPackage
• LoginId
• RegistrationId
• RelationshipTypeCd
• RoleId
• StartDate

To download the self-service roles template file:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. In the Setup and Maintenance work area, click the Task menu, and select Search.
3. Search for the following task:

   Manage File Import Objects

4. Click Manage File Import Objects from the search results.
5. Enter the following string in the text box at the header of the Code column:

   ORA_SVC_CSS_ROLES

6. Click the Enter key.
7. Click the ORA_SVC_CSS_ROLES row in the Manage File Import Objects list.
8. Click Download Template.
9. Click Save File, then OK.
10. Specify a download location for the template file, then select Save.
11. When the download completes, click Done.

   The ORA_SVC_CSS_ROLES_Template.zip is downloaded.

Prepare the Import File

This section describes how to prepare the import file for importing self-service users. For more information about file-based data import, refer to Understanding File-Based Data Import and Export in the Related Topics.

To prepare the import file:

1. Locate, and open the ORA_SVC_CSS_ROLES_Template.zip file that you saved in the Downloading the Self-Service Roles Template topic.
2. Extract the SVC_SELF_SERVICE_ROLES.csv file.
3. Open the SVC_SELF_SERVICE_ROLES.csv file.
Note: The SVC_SELF_SERVICE_ROLES.csv file contains many fields that aren’t required. The following fields are mandatory: AccountPartyId Or AccountPartyNumber, ContactPartyId Or ContactPartyNumber, RelationshipTypeCd. You can remove any of the unused fields from the first row of the file. If LoginId is not specified then the Email Address of the contact will be used as the Login ID.

4. For each self-service user you plan to import, enter the following data in a dedicated row:
   
a. Enter the account information relating to the self-service user in the AccountPartyId or AccountPartyNumber column.

   Tip: To quickly locate the values for AccountPartyId or AccountPartyNumber using REST API, run the following command as an administrator:

   GET <Oracle-Fusion-Application-Host>/crmRestApi/resources/11.13.18.05/accounts/

   b. Enter the contact information relating to the self-service user in the ContactPartyId or ContactPartyNumber column.

   Note: When importing the Contacts, it’s possible to provide a unique identifier for each contact in the form of the ContactPartyNumber. This must be unique for each user. So you should provide the same unique numbers for ContactPartyNumber for the user in the Contact import file and the Self-Service Roles import file to match them up.

   c. Enter the login ID relating to the self-service user in the LoginId column.

   Note: If the svc_css_imp_sign_in_attr_name profile option is set, then the LoginId is optional.

   d. Enter the Digital Customer Service roles to assign to the self-service user in the RelationshipTypeCd column. The following values can be assigned:

      - ORA_CSS_USER. This corresponds to the Digital Customer Service User role.
      - ORA_CSS_ACC_MGR. This corresponds to the Digital Customer Service Account Manager role.
      - ORA_CSS_ACC_ADMIN. This corresponds to the Digital Customer Service Account Administrator role.

   Note: The ORA_CSS_ACC_MGR and ORA_CSS_ACC_ADMIN roles by themselves can be only used if the self-service user already exists. If the import is going to create a new self-service user the ORA_CSS_ACC_MGR and ORA_CSS_ACC_ADMIN roles must be combined with ORA_CSS_USE role. To assign multiple roles to a user concatenate them using the & character. For example: ORA_CSS_USER&ORA_CSS_ACC_ADMIN.

5. Repeat step 4, on a dedicated row for each additional self-service user you want to import.

   Note: For each AccountPartyId Or AccountPartyNumber, at least one user in the import file must have the ORA_CSS_ACC_ADMIN role assigned.


7. Include the SVC_SELF_SERVICE_ROLES.csv in a new SVC_SELF_SERVICE_ROLES.zip archive, and save it.
Tip: When using a Mac, you must use the `zip` utility in terminal to create the `SVC_SELF_SERVICE_ROLES.zip` file.

Consider the following sample data in the `SVC_SELF_SERVICE_ROLES.csv` file:

Example 1

<table>
<thead>
<tr>
<th>AccountPartyId,ContactPartyId,RelationshipTypeCd</th>
</tr>
</thead>
<tbody>
<tr>
<td>300100110957452,300100156316610,ORA_CSS_User &amp; ORA_CSS_ACC_ADMIN</td>
</tr>
</tbody>
</table>

Example 2

<table>
<thead>
<tr>
<th>AccountPartyNumber,ContactPartyNumber,RelationshipTypeCd</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDRM_67617,CDRM_743628,ORA_CSS_USER</td>
</tr>
<tr>
<td>CDRM_67617,CDRM_743711,ORA_CSS_USER&amp;ORA_CSS_ACC_ADMIN</td>
</tr>
<tr>
<td>CDRM_67617,CDRM_743651,ORA_CSS_USER&amp;ORA_CSS_ACC_MGR</td>
</tr>
</tbody>
</table>

Example 3

<table>
<thead>
<tr>
<th>AccountPartyNum,ContactPartyNum,LoginId,RelationshipTypeCd</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDRM_67617,CDRM_743628,Mary.Smith,ORA_CSS_USER</td>
</tr>
<tr>
<td>CDRM_67617,CDRM_743711,John.Rogers,ORA_CSS_USER&amp;ORA_CSS_ACC_ADMIN</td>
</tr>
<tr>
<td>CDRM_67617,CDRM_743651,Pat.Williams,ORA_CSS_USER&amp;ORA_CSS_ACC_MGR</td>
</tr>
</tbody>
</table>

Import the Self-Service Users

Before proceeding with the instructions in this section, you must have completed the steps in the previous sections:

- Downloading the Self-Service Roles Template
- Preparing the Import File

Note: If you're importing a user with multiple accounts, you must set `ZBS_TI_RETRY_ATTEMPTS` profile option to 1 before beginning the import.

To import the self-service users:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. In the **Setup and Maintenance** work area, click the **Task** menu, and select **Search**.
3. Search for the following task: **Manage File Import Activities**
4. Click **Manage File Import Activities** from the search results.
5. Click the + button (Create).

   The **Create Import Activity: Enter Import Options** screen is displayed.

6. Enter a name in the **Name** field.
7. From the **Object** list, select **Self-service roles**.
8. In the **Source File** section, select the **Desktop** option for **Upload From**.
9. Click **Browse**, to locate and specify the `SVC_SELF_SERVICE_ROLES.zip` file that you created in step 7 of the Create the Import File section.
10. Click **Next**.

   The **Create Import Activity: Map Field** screen is displayed.
11. Verify the mappings are as expected. If necessary, make your corrections.
12. Click **Next**.
The Create Import Activity: Create Schedule screen is displayed.

13. From the Schedule list, select Immediate.
14. Click Next.

The Create Import Activity: Review and Activate screen appears.
15. Review the import details, the click Activate.

Your import job is listed in the Manage Import Activities list. The Status value of your job will change multiple times during processing, until it's Completed or Completed with Errors.

**Note:**

16. (Optional) Review errors. If the Status value is Completed with Errors, some users might not have been imported. Follow these steps to review the errors:
   a. Click the Completed with Errors link to view the error details.
   b. On the View Import Status: Support Self-Service-User Import screen, click the Diagnostics tab in the Diagnostics and Logging section.
   c. Click the Generate button to generate the zip file.
   d. Download the zip file, to review the diagnostic messages.

For more information about importing users, refer to Importing Users Overview in the Related Topics.

### Send Pending LDAP Requests

Perform this task after successfully importing the self-service user roles.

**Note:** This topic is only required only if SVC_CSS_USE_FA_AS_IDP profile option is set to TRUE.

With the import of the self-service roles to associate with the contact records, the final step to enable a self-service user account is to create the user account in the Oracle B2B Service identity management system. This is in turn synchronized with Oracle Identity Cloud Service, allowing users to sign in. To create the user account in the Oracle B2B Service identity management system, the **Send Pending LDAP Requests** job needs to be run.

To send the pending LDAP requests:

1. Sign in to Oracle B2B Service as an administrator or a setup user.
2. Navigate to the Scheduled Processes work area.
3. Click Schedule New Process.
   
   The Schedule New Process dialog box appears.
4. Select the Job option.
5. Click the Name menu, then select Search.
6. Enter the following string in the Name text box, then click Search:
   
   **Send Pending LDAP Requests**
7. Click Send Pending LDAP Requests, then click OK.
8. Click OK on the Schedule New Process dialog box.
   
   The Process Details dialog box appears.
9. Click Submit.
   
   A Confirmation dialog is displayed.
10. Click OK.

Monitor the job. When it's complete, the newly imported self-service users are created in LDAP.

Related Topics
- Understanding File-Based Data Import and Export
- Understanding Import and Export Management
- Import Your Contact Data
- Import Your Account Data
- Import Monitoring

Self-Service Contact or Account Merge

B2B Service uses Oracle Customer Data Management to cleanse contact and account records. Merge actions eliminated duplicate records by creating a victim and survivor record. The survivor record serves as the master record. Digital Customer Service has several rules which are used in B2B Service to prevent merge operations on victim records. Here's a list of potential error messages along with resolutions.

<table>
<thead>
<tr>
<th>Error Message Name and Message Text</th>
<th>Description</th>
<th>How You Resolve the Error</th>
</tr>
</thead>
</table>
| ZCH_GUID_ISSUE                      | This error message is displayed when one of the duplicates in a merge request is a valid user. | Delete the victim Self-Service user using Self-Service Users UI. If B2B Service is your Identity Provider do the following:  
  - Use the Security Console to delete the user.  
  - Then, run the Synchronize User GUID job. If Oracle Identity Cloud Service is your Identity Provider do the following:  
    - Delete the user in Identity Cloud Service Administrator Console. |
<p>| SVC_CSS_CNT_MRG_PENDING_REG         | This message is displayed when two accounts are being merged and the victim record has pending registration requests. | Use the Registration Requests UI to reject the pending registration request of the victim contact. |
| SVC_CSS_ACT_MRG_PENDING_REG         | This message is displayed when 2 accounts are being merged and the victim record has pending registration requests. | Use the Registration Requests UI to reject the pending registration request of contacts from the victim account. |</p>
<table>
<thead>
<tr>
<th>Error Message Name and Message Text</th>
<th>Description</th>
<th>How You Resolve the Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>This merge request can't be processed because 1 of the duplicate records has pending self-service registration requests.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SVC_CSS_ACT_MRG_USERS</td>
<td>This message is displayed when 2 accounts are being merged and the victim record has existing self-service users.</td>
<td>Currently there's no resolution (one will come in a future release).</td>
</tr>
</tbody>
</table>
8 Components

Overview of Components

This topic describes the Digital Customer Service components that are available when developing your application in the Oracle Visual Builder.

There are two types of components:

- **Oracle JavaScript Extension Toolkit Composite Component Architecture components.** These components are reusable pieces of user interface code that you can embed as custom HTML elements in the Visual Builder Application.
- **Oracle Visual Builder pattern components.** These components use templates of existing available components and HTML elements and additional Oracle Visual Builder-related bindings such as page variables, listeners and action chains.

Oracle Visual Builder pattern components aren't accessible as a component whose attributes you can inspect. Once included on a page, the Oracle Visual Builder pattern components are a collection of other HTML components with no outer component. Whereas the Standard Oracle JavaScript Extension Toolkit Oracle JET Composite Component Architecture components have attributes that can be inspected.

Oracle Visual Builder pattern components that are a part of Digital Customer Service are:

- Change Password Form
- Forgot Password Form
- Knowledge Article
- Knowledge Article Facets
- Knowledge Article List
- Knowledge Popular Articles
- Knowledge Search
- Reset Password Form
- Service Request Creator
- Service Request Data
- Service Request File Attachment
- Service Request List
- Service Request Message List
- Service Request Message Creator
- Service Request URL Attachment List
- Sign In
- Sign In Form
- Sign Out
- Sign Up
- User Registration Request Management
• User Registration Requests List
• User Roles Management
• User Roles List
• Visual Navigator
• Work Order Detail
• Work Order List

Standard Oracle JavaScript Extension Toolkit Oracle JET Composite Component Architecture components that are a part of Digital Customer Service are:
• Chat
• Cobrowse
• Category Selector
• Product Selector
• Linked Text
• Download Attachment

Interaction Methods Components

This topic lists and describes interaction methods components. The following table describes components specific to interaction methods.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>Enables users to initiate a chat request and exchange messages with an agent.</td>
</tr>
<tr>
<td>Cobrowse</td>
<td>Enables users to initiate a Cobrowse session. Cobrowse is launched using the supplied launcherUrl attribute value and the JET language by loading the launcher.js file into the application. The Cobrowse component is by default included on the shell page of the Digital Customer Service Reference Implementation template. For more information, refer to the Configure Cobrowse topic in the Related Topics.</td>
</tr>
</tbody>
</table>

Related Topics
• Configure Cobrowse

Product and Category Components

This topic lists and describes Product and Category Components. The following table describes components specific to products and categories.
Oracle CX Service
Implementing Digital Customer Service

Chapter 8
Components

Component Name | Description
--- | ---
Category Selector | Enables users to select a category, for example to filter the search results. This component works in conjunction with Knowledge Search, Chat, Create Service Request and Edit Service Request.

Product Selector | Enables users to select a product, for example to filter the search results. This component works in conjunction with the Knowledge Search, Chat, Create Service Request and Edit Service Request.

Knowledge Management Components

This topic lists and describes knowledge management components.

The following table describes components specific to knowledge management components.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Article</td>
<td>Enables you to display a knowledge article when the component's variable <code>kmContentId</code> is configured with a valid Knowledge Article ID.</td>
</tr>
<tr>
<td>Knowledge Article List</td>
<td>Displays a list of knowledge articles associated with a supplied search term and optionally selected product and category filters.</td>
</tr>
<tr>
<td>Knowledge Popular Articles List</td>
<td>Displays Popular Knowledge Articles. This component provides a user interface component that displays popular articles that are measured by a ranking score. This ranking score is derived from the strength of the knowledge article viewed within a time lapse mechanism.</td>
</tr>
</tbody>
</table>

The following variables are associated with this component:

- `kmPopularArticlesList` - The Service Data Provider for the component which maps the Service Data Provider to the following custom fetch action chain: `kmPopularArticlesFetchAction`.
- `kmPopularArticlesFilter` - The product category filter that adds context to the query. The Action chain associated with the Popular Articles Fetch has a description with details on how `kmPopularArticlesFetchAction` can be used. `kmPopularArticlesFetchAction` queries the most popular items back from the Knowledge Management content REST API. The number of results can be limited by updating the `kmPopularArticlesLimit` NUMBER page variable.
- `kmPopularArticlesLimit` - Controls the maximum number of articles to display. The default value is 5.
- `kmPopularArticlesResultsCache` - Represents the object used to scope the caching of the popular articles, and prevents an article from being called more frequently than appropriate.

Knowledge Search | Displays a list of knowledge articles associated with a supplied search term and optionally selected product and category filters. This component can be used in collaboration with the Knowledge Article List and Knowledge Article Facets components.
## Component Name

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Article Facets</td>
<td>Enables you to filter a list of knowledge articles resulting from a knowledge search. Types of facets include: Product, Category, Collection, and Document Type.</td>
</tr>
</tbody>
</table>

## Service Requests Components

This topic lists and describes service requests components.

The following table describes components specific to Service Requests. It also lists the restrictions associated with the component and any additional configuration required.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download Attachment</td>
<td>Enables the Service Request Attachment List to support downloading of the listed attachments.</td>
</tr>
<tr>
<td>Linked Text</td>
<td>Replaces a text field with references to service requests with links to the details page for the service request, and creates links to Knowledge Management articles.</td>
</tr>
<tr>
<td></td>
<td>For example, “SR1234567890” in the Field value would be replaced with a link to the details page for service request number 1234567890.</td>
</tr>
<tr>
<td>Service Request Creator</td>
<td>Displays the service request creation form and the functionality required to allow users to create Service Requests.</td>
</tr>
<tr>
<td>Service Request Data</td>
<td>Displays the summary details of a service request.</td>
</tr>
<tr>
<td></td>
<td>For the Service Request Data component to render a valid service request, it must be mapped to the input page serviceRequestNumber parameter. This parameter is a required parameter and has to be wired to a valid service request number by the calling page navigation.</td>
</tr>
<tr>
<td>Service Request File Attachment</td>
<td>Lists service request file attachments and allows the user to edit the description or add new file attachments.</td>
</tr>
<tr>
<td></td>
<td>For the Service Request File Attachment component to render a valid service request, it must be mapped to the input page serviceRequestNumber parameter. This parameter is a required parameter and has to be wired to a valid service request number by the calling page navigation.</td>
</tr>
<tr>
<td>Service Request List</td>
<td>Displays a list of service requests to the account user in a preconfigured Oracle Visual Builder list view. The presentation of a row can be edited.</td>
</tr>
<tr>
<td>Service Request Message Creator</td>
<td>Provides functionality to allow new messages to be added to a service request.</td>
</tr>
</tbody>
</table>
Work Order Components

This topic lists and describes service requests components.

The following table describes components specific to Work Orders. It also lists the restrictions associated with the component and any additional configuration required.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Order List</td>
<td>Displays a list of work orders to the account user in a preconfigured Oracle Visual Builder list view. Provides the capability to search for a work order and sort the list of work orders.</td>
</tr>
<tr>
<td>Work Order Detail</td>
<td>Displays the summary details of a work order. Provides the capability to update contact information, add a message for the technician, reschedule a work order and cancel a work order. Some configuration is needed to reschedule a work order. For more information, refer to the Related Topics link.</td>
</tr>
</tbody>
</table>

Related Topics

- Configure Reschedule Work Order Functionality

Sign In and Sign Out Components

This topic lists and describes sign in and sign out components.

The following table describes components specific to Sign In and Sign Out.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sign In</td>
<td>Enables users to sign in.</td>
</tr>
<tr>
<td>Sign Out</td>
<td>Enables users to sign out.</td>
</tr>
</tbody>
</table>

**User Components**

This topic lists and describes user components.
The following table describes components specific to users.

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign Up</td>
<td>Allows anonymous users to register to become self-service users.</td>
</tr>
<tr>
<td>User Registration Request Management</td>
<td>Enables Oracle Digital Customer self-service administrator users to manage user registrations. The component shows the selected user’s name, email, account information, status and a reason associated with the approval or rejection. For the User Registration Request Management component to render a user’s registration details, the user’s ID must be mapped to the component’s page variable named selfServiceRegistrationId. This parameter is a required parameter. It must be configured by the calling page navigation -- typically from an instance of the User Registrations Requests List -- in that calling page’s userRegistrationsNavigateToEditAction action’s navigateToEdit step. When in read-only mode, the approver and approved date will be shown.</td>
</tr>
<tr>
<td>User Registration Requests List</td>
<td>Lists the Digital Customer Service self-service registrations. The listing can be sorted by last update date, email, name, role or account in either descending or ascending order. The list displays the username, email, account, registration status and last update date.</td>
</tr>
<tr>
<td>User Roles List</td>
<td>Lists the Digital Customer Service self-service users and their roles. The list can be sorted by last update date, email, name, role or account in either descending or ascending order. The list displays the username, email, account, roles and last update date. The rows have a trash can icon, which can be used to remove the user.</td>
</tr>
<tr>
<td>User Roles Management</td>
<td>Allows the Digital Customer Service self-service administrator users to view, add and remove user roles. The component shows the selected user’s name, email, account information and their assigned roles and details on who made the last update and when. For the User Roles Management component to render a user’s roles, the user’s ID must be mapped to the component’s page variable named userRolesUsersld. This parameter is a required parameter. It must be configured by the calling page navigation -- typically from an instance of the User Roles List -- in that calling page’s UserRolesNavigateToEditAction action’s navigateToEdit step.</td>
</tr>
</tbody>
</table>
### Component Name | Description
--- | ---
| | The remove user button removes the user.
| Change Password Form | Component that creates a form that allows a user to change their password.
| Forgot Password Form | Component that creates a form that allows users who have forgotten their password to initiate the reset password process.
| Reset Password Form | Component that creates a form that allows users who have forgotten their password to complete the reset password process.
| Sign-In Form | Component that creates a form that allows IDCS users to log in to the DCS application.

## Integrate Composite Component Architecture Components

You can integrate non-Digital Customer Service Oracle JET Composite Component Architecture (cca) components with your application.

For more information about this type of integration, refer to the Interviews for Digital Customer Service topic in the Oracle Intelligent Advisor documentation in the Related Links.

**Related Topics**
- Interviews for Digital Customer Service

## View Information about Components

This topic describes how to view additional information about components.

You can find more information about component attributes directly in Oracle Visual Builder.

To view more information about a specific component:

1. Navigate to the Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click **Web Apps**.
4. Expand `dcs`, then expand `flows`.
5. Select a page where the component appears.
6. In the **Page Structure** panel, click the component.
7. Click the **Design** tab in the `<Component> Selector` inspector.
8. All of the attributes specific to the selected component appear in the `<Component> Selector` section of the inspector, in the **All** tab.
9. Hover over the name of the attribute, then hover over the question mark icon to reveal one or more of the following fields relating to the attribute:
   - **Type**
   - **Value**
   - **Supported Values**
   - **Description**
9 Life Cycle Management

Determine Component Versions

Digital Customer Service provides reusable components to your application through a component catalog service integrated into Oracle Visual Builder. These components may be updated periodically to provide bug fixes or additional features.

This topic describes how to determine your Digital Customer Service component versions in Oracle Visual Builder.

To determine your Digital Customer Service application component versions:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click the Puzzle Piece icon (Components).
   The Components list appears.
4. Click the Installed tab.
   The names of all of your installed components are listed, including version numbers.

Determine Template Version

This topic describes how to determine the version of the Digital Customer Service template your application was based on, in Oracle Visual Builder.

Digital Customer Service provides templates for you to create your application. Additional templates may be provided with each version, and in some situations, you might want to know the version of the template that your application was based on.

To determine the version of your template:

1. Sign in to Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click Web Applications.
4. In Web Apps, click dcs.
5. Click the JS icon (Functions).
   The functions appears.
6. The first line of the functions will look similar to the following:


   In this example, the 19C 2.3.1 indicates the version of the template that you are using.
Move Configuration Data from Stage to Production

Export Configuration Data from the Stage Environment

The proxy user name and password aren't moved by this process. Proxy user configuration data must be configured in the stage environment and moved to the production environment.

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
3. From the Actions drop down list, select Export, then Create New.
4. Click Yes to dismiss the Warning dialog box.
5. In the Export Offering Setup Data work area, click the Show drop down list in the Business Objects area and select All.
6. Make sure Proxy User Configuration is selected for export. If you don't want to export profile options, deselect Export for the Application Profile Value row.
7. If you deselected the Application Profile Value row, click through the Warning pop up window.
8. Enter a name in the Process Name field and then click Submit.
9. Click OK to confirm the export, and then monitor the status of the export.
10. When the status reads Ready to Export, click the link.
11. Click Download File, and then click Done.
12. A compressed file with the name you gave the process will be downloaded locally.

Import Configuration Data Into the Production Environment

Now you import the data into your production environment.

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Service.
3. From the Actions drop down list, select Import, then Create New.
4. Click Yes to dismiss the Warning dialog box.
5. In the Import Offering Setup Data work area, click the Browse and select the compressed file you downloaded in the previous step.
6. Click Submit, and then click OK to confirm the import.
7. Click the Waiting for manual import link.
8. In the Resume Import Setup Data window, click Yes to resume the import.
9. When the status reads Ready for data validation, you can validate it using the Manage Proxy User Configuration task.
10 Migrating to Self-Service Optimization

Overview of Migrating Users to Self-Service Optimization

Self-Service User Optimization makes it possible to use Identity Cloud Service for authentication. With Identity Cloud Service you have a sign-in page that you can configure, along with email notification and immediate login access after registration. This enables you to scale Self Service Optimization to a much larger number of users than would occur in many B2C scenarios.

During the registration approval process, the SVC_CSS_USE_FA_AS_IDP profile option determines the overall behavior. Here are the profile option settings:

- If the profile option is set to TRUE, the user account is created in the Identity Store managed by B2B Service, and then copied over to Identity Cloud Service.
- If the profile option is set to FALSE, the user is created directly in Oracle Identity Cloud Service.

A user that's created in the B2B Service Identity Store, with the SVC_CSS_USE_FA_AS_IDP profile option set to TRUE, must also be enabled for Self-Service Optimization prior to having access to the Digital Customer Service application. The user migration process enables these user accounts.

Here are some terms to keep in mind during your setup:

- Self-Service Optimization enabled Digital Customer Service application: A Digital Customer Service application that's Self-Service Optimization enabled is configured to send all B2B Service requests through the Proxy User Data Service.
- Self-Service Optimization enabled user account: When Self-Service Optimization is used, the user is always authenticated by Oracle Identity Cloud Service. A user account with the same User ID value may or may not exist in the B2B Service Identity Management Store. A user account in Oracle Identity Cloud Service is considered to be Self-Service Optimization enabled only if the GUID of the Oracle Identity Cloud Service user account is stamped on a contact record representing the Oracle Identity Cloud Service user account in B2B Service.
- Self-Service Optimization user migration: Self-Service Optimization user migration is the process that ensures the GUID of an Oracle Identity Cloud Service user account is stamped on a contact record representing the Oracle Identity Cloud Service user account in B2B Service.

Pre-Migration Tasks

Overview of Pre-Migration Tasks

Use this topic as a guide as you prepare to migrate your Digital Customer Service implementation to include Self-Service Optimization.

Before you begin, you must previously have set up your environment following the instructions in Chapter 3. Prior to doing user migration, however, you must complete the steps laid out in this topic.
Overview of Tasks
Here's an overview of the tasks you'll perform.

<table>
<thead>
<tr>
<th>Note:</th>
<th>You must perform each of these listed tasks in the order they're presented.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Set up Oracle Identity Cloud Service</td>
</tr>
<tr>
<td>2.</td>
<td>Set up Oracle B2B Service</td>
</tr>
<tr>
<td>3.</td>
<td>Set up Administrators and Developers</td>
</tr>
<tr>
<td>4.</td>
<td>Set up Oracle Visual Builder</td>
</tr>
<tr>
<td>5.</td>
<td>Set up Oracle Visual Builder Cloud Service with Oracle B2B Service</td>
</tr>
<tr>
<td>6.</td>
<td>Prepare your current application for Self-Service Optimization</td>
</tr>
</tbody>
</table>

Pre-Migration Tasks for Setting Up Oracle Identity Cloud Service
First you set up Oracle Identity Cloud Service using the following topics from Chapter 3.

1. Set Up Oracle Identity Cloud Service for Authentication.
2. Create the Application Client.
3. Allow Anonymous Users to Access the Signing Certificate.
4. Configure the Password Reset Email.
   - You use the Resend Welcome template when new users are registered by way of Self Service Optimization. It's recommended that you ensure the message content is appropriate.
   - You use the Password Recovery template when the user has been migrated. This template is also used when user uses the forgot password flow and so, if this template is configured for the purpose of migration, it must be changed appropriately after migration is complete.
5. In Identity Cloud Service disable the notification called User Profile Updated by Administrator. By disabling this notification, you ensure that email isn’t sent about the user profile change when the isFederated parameter is set to FALSE. You do this in the menu under Settings, Notifications and then by deselecting User Profile Updated by Administrator and then saving the setting.
6. Use the B2B Service application in Oracle Identity Cloud Service to trigger a full import of users and roles from B2B Service to Oracle Identity Cloud Service. Once the operation is complete, check the Synchronization Failure Report to determine if there were any issues that need to be addressed.

Pre-Migration Tasks to Set Up Oracle B2B Service
Now you set up Oracle B2B Service using the following tasks from Chapter 3.

1. Configure a User Category for Proxy Users.
2. Create the Proxy Users.

<table>
<thead>
<tr>
<th>Note:</th>
<th>If you’re using custom job roles for your self-service users, consult the Related Topics for a link to the guidelines on creating proxy users.</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Set Profile Options for Self-Service Optimization.</td>
</tr>
</tbody>
</table>

| Caution: | In the production environment, change the value of profile option SVC_CSS_USE_FA_AS_IDP to false only just before you migrate the users otherwise user registration may fail or users wont be able to use the application. |
4. Set the Oracle Identity Cloud Service Endpoint.
5. Configure the Client ID and Client Secret.
6. Manage the Proxy User Configuration Data.
7. Set Proxy User Credentials.

Related Topics
- Create the Proxy Users

Pre-Migration Tasks to Set Up Administrators and Developers

While you’re developing your application for Self Service Optimization, you test the application in Preview mode using an APPID user account. You create this account using the following topic from Chapter 3.

Create a Developer APPID User.

Specify B2B Service Details to Visual Builder Cloud Service

You set up Oracle Visual Builder using the following steps from Chapter 3.

To specify B2B Service details to Oracle Visual Builder, do the following:

1. Sign into Oracle Visual Builder as an administrator.
2. Click the Menu icon, and select Settings to open the Tenant Settings page.
3. Click the Services tab, then click the Back ends icon (+)
4. In the Back End Service Type window, select Oracle Cloud Application Instance, and click Close.
5. In the Instance URL field of the Create Oracle Cloud Application Instance window, enter the instance URL of your Oracle Cloud Applications back end service.
6. From the Authentication drop down list, select Oracle Cloud Account.
7. Click Create.

Note: You must set the Instance URL field with the fully qualified domain name of your Oracle Applications Cloud B2B Service instance.

Prepare Your Current Application for Self-Service Optimization

Now make a new version of the current application and modify it to work with Self-Service Optimization by performing the following tasks:

1. Perform the steps in the Chapter 11 section Create an Application for Self-Service Optimization with Pre-20C Template.
2. Perform the steps in the Chapter 4 task Add Mappings to User Roles.
3. If you’re working on the stage environment, you can stage the application and test it by signing up and using that user for further testing the application.

Related Topics
- Enable the Implicit Grant in the Digital Customer Service Application
- Create Development and Production Application Profiles
User Migration

Self-Service Optimization User Migration Prerequisites

The B2B Service user account used to initiate the Self-Service Optimization user migration process must have the below roles as part of their user roles:

- Custom Objects Administration
- Customer Relationship Management Application Administrator
- Employee
- Sales Administrator

Overview of the User Migration Process

The complex Self-Service Optimization user migration task is performed by a method on the IdpMigrationManager class. These methods are available to Application Composer Groovy scripts. The user migration is initiated by scheduling the Schedule Custom Groovy Object Functions ESS Job which is configured to trigger a custom object function written on a Custom Object. You can view the results of the migration process in a custom report.

From the development perspective, here’s what the migration entails:

- Determine a logic for partitioning users that will be migrated.
- And the following three tasks are covered under the Create Required Artifacts for the Migration topic.
  - Create a Custom Object
  - Create Custom Object Functions
  - Create a Custom Report

Once these pieces are in place, you can schedule the Schedule Custom Groovy Object Functions ESS Job. Once this job is run, you can view the custom report.

Partition Users for Self-Service Optimization

It is strongly recommended that you use the functions available for the Self-Service Optimization user migration and migrate no more than 2000 users at one time. If you need to migrate more than 2000 self service users you must partition them into batches. This task shows you how to partition users based on the contact party ID value. The users are partitioned into batches and the party ID of the first contact and last contact in the batch are shown. This migration strategy assumes that no users have been migrated. If some users have already been migrated then this task will still work, but if a large number of users have already been migrated this partitioning method may not work as expected.

**Note:** See the section “Create a Data Model from a Custom Query” for more information on how to run the following queries.
First, for information only, use the following query to find the total number of users:

```
SELECT count(*)
FROM fusion.svc_self_service_roles
WHERE relationship_type_cd = 'ORA_CSS_USER'
AND delete_flag = 'N'
AND current_idp_cd != 'ORA_CSS_IDP_IDCS'
```

Next, use the following query that uses the DENSE_RANK analytic function to partition the users into batches. The batch size in this example is 2000.

```
SELECT
  batch_num,
  MIN(contact_party_id) first_contact_party_id,
  MAX(contact_party_id) last_contact_party_id,
  COUNT(*) batch_size
FROM
  (
    SELECT
      contact_party_id,
      floor((rank - 1) / 2000) batch_num
    FROM
      (SELECT
          contact_party_id,
          DENSE_RANK() OVER(
            ORDER BY
            contact_party_id
          ) AS rank
        FROM fusion.svc_self_service_roles
        WHERE
          relationship_type_cd = 'ORA_CSS_USER'
          AND delete_flag = 'N'
          AND current_idp_cd != 'ORA_CSS_IDP_IDCS'
        )
      )
  )
GROUP BY batch_num
ORDER BY batch_num
```

The output shows the party ID of the first and last contact in each batch

**Create a Custom Object for the Migration**

You first create a custom object as part the migration requirements.

1. Sign in to Oracle B2B Service as a user who has privileges to perform migration tasks.
2. Create a sandbox by doing the following:
   a. Click **Navigator > Configuration > Sandboxes.**
   b. Click **Create Sandbox.**
      
The **Create Sandbox** page appears.
   c. Enter a name in the **Name** field.
   d. Click **Create.**
   e. In the **Available Sandboxes** list, click the name of the sandbox name that you specified in step c.
   f. Click the **Plus** icon (Active Tools).
      
The **All Tools** dialog appears.
g. Click the Application Composer, and then click OK.

h. Click Enter Sandbox.

3. Navigate to the Application Composer.

4. From the Objects list in the Object Explorer, click the Create (+) icon against Custom Objects to create a custom object.

5. In the Create Custom Objects dialog box, enter: PudsUserMigrator as the display label. The other required fields will auto fill.

6. Click OK.

Overview of the IdpMigrationManager

The IdpMigrationManager class provides methods that enable existing users in B2B Service Identity Store to use Self-Service Optimization.

The following table lists the available methods:

<table>
<thead>
<tr>
<th>Instance Method</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>migrate()</td>
<td>Use this method to migrate all the users.</td>
</tr>
<tr>
<td>migrate(contactPartyId: String)</td>
<td>Use this method to migrate only the user identified by the given contact party ID.</td>
</tr>
<tr>
<td>migrate(contactPartyIds: String[])</td>
<td>Use this method to migrate all the users identified by the given contact party IDs.</td>
</tr>
<tr>
<td>migrateByAccountPartyIds(accountParty String[])</td>
<td>Use this method to migrate all the users related to the accounts identified by the given account party ID.</td>
</tr>
</tbody>
</table>

The getInstance() Method

You can use the static getInstance() method of the IdpMigrationManager to obtain an instance of the IdpMigrationManager.

This method takes the following argument.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>idpDestination</td>
<td>The value of this parameters must always be ORA_CSS_IDP_IDCS.</td>
</tr>
<tr>
<td>batchSize (optional)</td>
<td>This number determines the number of users fetched from the database and processed at one time. The recommended batch size is 100. This parameter value isn’t used when methods that accept contactPartyId as parameter.</td>
</tr>
<tr>
<td>totalCount (optional)</td>
<td>The total number of users processed. This value should not be greater than 2000.</td>
</tr>
</tbody>
</table>
Groovy Code

Use the following Groovy code to get an instance of the IdpMigrationManager.

```groovy
def idpDestination = "ORA_CSS_IDP_IDCS";
def mgr = oracle.apps.crm.service.css.migrationService.util.IdpMigrationManager.getInstance(idpDestination, 100, 2000);
```

Here's an example use of the Groovy script code to enable a single contact identified the contact party ID for Self-Service Optimization.

```groovy
def contactPartyId = 1234L;
def idpDestination = "ORA_CSS_IDP_IDCS";
def mgr = oracle.apps.crm.service.css.migrationService.util.IdpMigrationManager.getInstance(idpDestination);
def msg = mgr.migrate(contactPartyId);
return msg;
```

Create Custom Object Functions

Now you create the following functions:

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>getContactsInRange</td>
<td>Returns the party IDs of contacts within a given range.</td>
</tr>
<tr>
<td>migrateContactsInRange</td>
<td>Migrates all the contacts in the given range.</td>
</tr>
<tr>
<td>migrateBatch &lt;N&gt;</td>
<td>Migrates a batch of users. You must create one function for each batch you run.</td>
</tr>
</tbody>
</table>

1. In Application Composer, expand Custom Objects, expand the PudsUserMigrator node.
2. Select Server Scripts, then click the Object Functions tab.
3. Click the Action drop down list, and select Add a New Object Function.
4. In the Create Object Function page, do the following:
   a. In the Function Name field, enter: `getContactsInRange`
   b. Click the Returns drop down list, and select: List.
   c. Expand the Parameters area, and click the Add Parameter icon.
   d. In the Name field, enter: `start` and from the Type drop down list, select Long.
   e. Click the Add Parameter icon again.
   f. In the Name field, enter: `end`, and from the Type drop down list, select Long.
   g. In the Edit Script field, paste the following code:

```groovy
def partyList = [];
def selfRegnVO = newView('SelfRegistrationVO');

selfRegnVO.appendViewCriteria(""  
(ContactPartyId between '${start}' and '${end}' ) AND StatusCd = 'ORA_CSS_APPROVED' 
")

selfRegnVO.setMaxFetchSize(6000)
selfRegnVO.executeQuery()
```
while (selfRegnVO.hasNext()){
    def curRow = selfRegnVO.next();
    partyList.add(curRow.ContactPartyId);
}
partyList = partyList.unique()
return partyList.sort();

h. Click **Save and Close**.

5. Click the **Add a New Object Function** icon, and In the Create Object Function page, do the following:
   a. In the Function Name field, enter: migrateContactsInRange
   b. Click the **Returns** drop down list, and select: String.
   c. Expand the Parameters area, and click the **Add Parameter** icon.
   d. In the Name field, enter: start and from the **Type** drop down list, select Long.
   e. Click the **Add Parameter** icon again.
   f. In the **Name** field, enter end, and from the **Type** drop down list, select Long.
   g. In the **Edit Script** field, paste the following code:

```java
if(contactPartyIdList.size() == 0){
    throw new oracle.jbo.ValidationException('There are no contacts identified by the given partyId range: ' + start + "-" + end);
}

if(contactPartyIdList.size() > 2000){
    throw new oracle.jbo.ValidationException('There are more than 2000 contacts identified by the given partyId range: ' + start + "-" + end);
}

def contactPartyIds = contactPartyIdList as Long[];
def idpDestination = "ORA_CSS_IDP_IDCS";
def mgr = oracle.apps.crm.service.css.migrationService.util.IdpMigrationManager.getInstance(idpDestination, 100, 2000);
def msg = mgr.migrate(contactPartyIds);
return msg;
```

h. Click **Save and Close**.

6. Click **Add a New Object Function**, then in the Create Object Function page, do the following:
   a. In the Function Name field, enter: migrateBatch<N>.
   b. Click the **Returns** drop down list, and select: String.
   c. Change the Visibility value to **Callable by External System**.
   d. In the **Edit Script** field, paste the following code:

```java
def batchStartContactPartyId = ?L;
def batchEndContactPartyId = ?L;

def msg = migrateContactsInRange(new Long(batchStartContactPartyId), new Long(batchEndContactPartyId));
return msg;
```

**Note:** ?L must be replaced with the start and end contact party ID values from the Partition Users for Self-Service Optimization topic. If you save without changing this value, the script will throw an error.
Create a Data Model from a Custom Query

Use this topic to create a data model from a custom query.

1. Log in to B2B Service as a user who can use Reports and Analytics.
2. Click Navigator > Tools > Reports and Analytics.
3. Click Browse Catalog.

Your browser opens the Oracle Business Intelligence catalog in a new browser tab.
4. Click New, and then from the drop down list, select Data Model.
5. On the Diagram tab, click the Plus icon, and select SQL Query from the drop down menu, and do the following:
   a. In the Name field, enter Migration Data.
   b. From the Data Source drop down list, select ApplicationDB_CRM.
   c. From the Type of SQL drop down list, select Standard SQL.
   d. Paste the following SQL statement into the SQL query text box:

   ```sql
   SELECT
       event_id,
       job_id,
       contact_party_id,
       hzp.party_unique_name contact_name,
       event_type_cd,
       etlookup.meaning event_type,
       event_status_cd,
       eslookup.meaning event_status,
       event_note,
       login_id,
       history.last_update_date
   FROM
       fusion.svc_css_idp_migr_history history,
       fnd_lookups etlookup,
       fnd_lookups eslookup,
       hz_parties hzp
   WHERE
       etlookup.lookup_code = event_type_cd
   AND etlookup.lookup_type = 'ORA_SVC_CSS_EVENT_TYPE_CD'
   AND eslookup.lookup_code = event_status_cd
   AND eslookup.lookup_type = 'ORA_SVC_CSS_EVENT_STATUS_CD'
   AND hzp.party_id = history.contact_party_id
   AND history.last_update_date >= :JOB_START_DATE
   ```

   e. Click OK.

6. In the Add Parameter dialog box, select the JOB_STATE_DATE check box and click OK.
7. In the Parameters page, click the Data Type drop down list for JOB_START_DATE parameter and select Date.
8. Click the Mandatory check box.
9. In the Display Label field, enter Job Start Date.
10. In the Data Model pane, click Properties > Data Sets > Migration Data.
11. Click the gear icon for each entry in the G_1 table, select properties each time, and then enter the information shown in the following table:

   e. Click Save and Close.

   **Note:** Create as many migrateBatch jobs as required based on the partitioning logic output.
<table>
<thead>
<tr>
<th>Name</th>
<th>Display Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVENT_ID</td>
<td>Event ID</td>
<td>Long</td>
</tr>
<tr>
<td>JOB_ID</td>
<td>Job ID</td>
<td>String</td>
</tr>
<tr>
<td>CONTACT_PARTY_ID</td>
<td>Party ID</td>
<td>Long</td>
</tr>
<tr>
<td>CONTACT_NAME</td>
<td>Name</td>
<td>String</td>
</tr>
<tr>
<td>EVENT_TYPE_CD</td>
<td>Event Type Code</td>
<td>String</td>
</tr>
<tr>
<td>EVENT_TYPE</td>
<td>Event Type</td>
<td>String</td>
</tr>
<tr>
<td>EVENT_STATUS_CD</td>
<td>Event Status Code</td>
<td>String</td>
</tr>
<tr>
<td>EVENT_STATUS</td>
<td>Status</td>
<td>String</td>
</tr>
<tr>
<td>EVENT_NOTE</td>
<td>Comments</td>
<td>String</td>
</tr>
<tr>
<td>LOGIN_ID</td>
<td>Login ID</td>
<td>String</td>
</tr>
<tr>
<td>LAST_UPDATE_DATE</td>
<td>Last Update Date</td>
<td>Date and Time</td>
</tr>
</tbody>
</table>

12. Click JOB_ID and ensure that only that row is selected, then click the Gear icon and select Group By.
13. Click CONTACT_PARTY_ID and ensure that only that row is selected, then click the Gear icon and select Group By.
14. Click the Save As icon, and give the data model a meaningful name such as Migration DM.
15. Click the View Data button.
16. Enter a value for the Job Start Date and click View to view sample data.
17. Save as sample data.

Create a Custom Report Based on a Data Model

Now you can create a report based on the data model you have created.

1. Log in to B2B Service as a user who can use Reports and Analytics.
2. Click Navigator > Tools > Reports and Analytics.
3. On the Reports and Analytics page, click Create, and then select Report.
4. Select Use Data Model, then click the search icon and locate the data model you previously created.
5. Click Next.
6. On the Select Layout page, choose the Landscape page option, and the Table layout option, and then click Next.
7. On the **Create Table** page, deselect **Show Grand Totals Row** and then click **Next**.
8. On the **Save Report** page, click **Customize Report Layout**.
9. Click **Finish**.
10. In the **Save As** dialog box, enter a name such as **Migration Report**, and then click **OK**.
11. Add a layout grid by doing the following:
   a. In the report editor, click **Drop a Data Item Here**, and press the delete button on your keyboard.
   b. Click the **Insert** tab (if it’s not already selected).
   c. Drag the **Layout Grid** from the Components list and drop it below the report title.
   d. In the Insert a Layout Grid dialog box, enter 1 in the Rows box, and leave the Columns box as 2, and then click **OK**.
   e. Click the **Insert** tab again, and from the Components list, drag a **Text Item** and drop it in the first column.
   f. Double-click the text item and enter the following: **Job started on or after**.
   g. From the **Data Source** pane, drag the **JOB_START_DATE** parameter to the second column.
   h. Reduce the width of the **Job started on or after** column.
12. Add a repeating section component by doing the following:
   a. Click the **Insert** tab, and then drag the **Repeating Section** component and drop it below the Layout Grid.
   b. In the **Insert a Repeating Section** dialog box, select **JOB ID** from the **Element** drop down list, and then click **OK**.
   c. Click the **Insert** tab, and drag a **Layout Grid** and drop it into the repeating section.
   d. Click the **Insert** tab, and drag a **Text Item** and drop it in the first column.
   e. Double-click the text item and enter the following: **Job ID**.
   f. From the **Data Source** pane, drag the **JOB_ID** parameter to the second column.
   g. Re-size the first column.
13. Now add a data table by doing the following:
   a. Click the **Insert** tab, and drag the **Data Table** component and drop it under the row in the repeating component,
   b. While the data table is selected, click the **Show** drop down list on the **Table** tab and select the first item that indicates no (darkened) summary row.
   c. From the Data Source pane, drag and drop the following fields into the data table:
      - Event ID
      - Contact Party ID
      - Login ID
      - Event Type
      - Event Status
      - Comments
14. Click the **Save** icon, and then click the **Done** button to access the report in View mode.
15. In the **Start Date** field, enter a job start date, and then click **Apply** to view the report.

**Schedule the Job for Users for Self-Service Optimization**

Before you schedule your job, make sure of the following:

- The value of the profile option **SVC_CSS_USE_FA_AS_IDP** is set to **FALSE**.
- All the users to be migrated are in the FA Identity Store and Identity Cloud Service.
**Note:** The Job Schedule process must be repeated for every migrateBatch <N> custom object function that’s created based on partitioning logic.

1. Log in into B2B Service as a user with privileges required to schedule ESS jobs.
2. Click on Navigator > Tools > Scheduled Processes.
3. Click the Schedule New Process button.
4. In the Schedule New Process dialog box, enter: Schedule Custom Groovy Object Functions, then click OK.
5. In the Process Details dialog box, add the Object name (such as PudsUserMigrator_c) and Object Function (such as, migrateBatch1) and click Submit.
6. After the job completes, review the log files and the text files.
7. If the job ran successfully, the output log file output will resemble the following:

   ```
   JobId 36773: Successfully invoked and executed PudsUserMigrator_c object function migrateBatch1
   ```
8. The text file output will include one line for each contact that was migrated successfully. If the status is FAILED you can use this report to figure out what caused it. Here’s an example of the output:

   ```
   Executing PudsUserMigrator_c object function migrateBatch1 returns: 300100185580882: MIGRATED
   ```

### View the Migration Report

Use this task to view migration reports.

2. Click Navigator > Tools > Reports and Analytics.
3. Click Browse Catalog.
4. Locate the report you created, and then click Open.
5. Enter a value in the Start Date field, and click Apply to view the report.

### Post-Migration Tasks

#### Overview of Post-Migration Tasks

Use this topic as a guide as you perform post-migration tasks on your Digital Customer Service implementation.

1. Stage the updated Digital Customer Service application that includes the Self-Service Optimization modifications and validate it's functioning correctly for existing users who have been migrated.
2. Publish the updated Digital Customer Service application that includes the Self-Service Optimization modifications.
4. Disable the Identity Cloud Service User Sync process if this was only being used for Digital Customer Service and not any other Hybrid SaaS service. Go to Oracle Cloud Services, Click on Oracle Applications Cloud Provisioning and toggle the "Enable Provisioning" to disable it.
11 Alternative Implementation Options

Implement Your Digital Customer Service Experience with REST APIs

Overview of the Digital Customer Service Experience with REST APIs

Find information in this chapter on implementing and configuring your Oracle Digital Customer Service experience using REST APIs. You will get to know the details on how to develop, configure, manage, and administer an Oracle JET-based customer service application. Also, you will learn how to set up and work with the additional features in Oracle B2B Service. For more information about Oracle B2B Service, refer to the Related Topics.

A significant part of implementing your Digital Customer Service experience using REST APIs relies on Oracle JavaScript Extension Toolkit (Oracle JET). Oracle JET is a collection of JavaScript libraries and functions used to develop client-based applications. Your implementation will leverage Oracle JET libraries and development best practices to provide service lifecycle, knowledge management, and products association with service requests and user management request and approvals. For more information about Oracle JET, refer to the Related Topics.

The topics in this chapter describe how to build an application purely based on JavaScript using Oracle JET, consuming data from Oracle B2B Service using REST APIs.

Related Topics
- Oracle CX Sales Help Center
- Welcome to Oracle JET

Get Started with the Digital Customer Service Experience with REST APIs

Implementing the Digital Customer Service experience with REST APIs requires the JavaScript reference implementation that was developed using Oracle JET and Oracle's JavaScript framework and toolkit, including third-party dependent software.

Installation Prerequisites

You must download all of the dependent software for use on the computer where the Digital Customer Service experience is being implemented with REST APIs.

Note: The versions of the prerequisite software listed in the following table were used in development. Later versions might also work with your deployment.
### Software or Package Name

<table>
<thead>
<tr>
<th>Software or Package Name</th>
<th>Tested Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Development Kit</td>
<td>1.8.0_181</td>
</tr>
<tr>
<td>Node.js</td>
<td>7.10.1</td>
</tr>
<tr>
<td>NPM</td>
<td>6.4.1</td>
</tr>
<tr>
<td>Oracle JET</td>
<td>5.1.0</td>
</tr>
<tr>
<td>Oracle Identity Cloud Service</td>
<td>18.4.2</td>
</tr>
</tbody>
</table>

### Related Topics
- Oracle JET
- NPM

### Add Self-Service Registration

Users require a user name and password to access the customer service application that is developed on Oracle JET. If the user is not self-registered, the user must provide a first name, last name, and user name on the Self-Registration page in the customer service application developed on Oracle JET.

Once the required information is provided, the self-service registration process will inform the administrator by sending an email notification. The administrator can then sign in to the application and approve or reject the request. The self-service registration process creates an account in Oracle B2B Service and assigns appropriate roles. For more information about approving and rejecting self-service registration requests, refer to the Manage Registration Requests in the Related Topics.

### Related Topics
- Manage Registration Requests

### Set Up Oracle Identity Cloud Service Applications

#### Overview of Oracle Identity Cloud Service Applications

Your Oracle JET application will access Oracle B2B Service REST API resources. Within this model, your Oracle JET application performs actions on behalf of an Oracle JET application user. For authentication to work, the Oracle Identity Cloud Service or other identity provider must support OAuth2-based authentication. Irrespective of the identity provider used, applications should be defined in the identity provider representing the Oracle JET application. The following topics describe how to create the necessary applications in Oracle Identity Cloud Service.

Follow the instructions in these topics in the order in which they appear:

2. Create an Application for OAuth Implicit Flow.
3. Create an Application for JSON Web Token Assertion.

**Create an Oracle B2B Service Resource Application**

This topic describes how to create a confidential resource application for Oracle B2B Service in Oracle Identity Cloud Service.

For detailed instructions on creating confidential applications in Oracle Identity Cloud Service, refer to the in the Adding a Confidential Application link in the Related Topics.

To create a confidential resource application for Oracle B2B Service in Oracle Identity Cloud Service:

1. Sign in to your Oracle Identity Cloud Service administration console.
2. Expand the **Navigation Drawer**, and then click **Applications**.
3. Click **Add**.
   - The **Add Application** page appears.
4. Click **Confidential Application**.
5. In the **App Details** pane of the **Add Confidential Application** window, specify a name for the application in the **Name** field.
6. Click **Next** to proceed.
   - A confirmation message indicates that the application has been added in a deactivated state.
7. You will be prompted to configure authorization information for your application now. Do not configure now, instead, click **Skip for later**.
8. Click **Next**.
9. Click **Configure this application as a resource server now**, and configure these fields as follows:
   - **Access Token Expiration**. Leave at the default value.
   - **Refresh Token Expiration**. Leave at the default value.
   - **Primary Audience**. Specify the Oracle B2B Service instance that is used to perform resource invocation.
   - **Add (Allowed Scopes)**. Click **Add** next to **Allowed Scopes**:
     i. In the **Add Scope** dialog enter the following for **Scope**:
        /
     ii. Select **Requires consent**.
     iii. Click **Add**.
10. Click **Next**.
11. Skip the Web Tier Policy prompt by clicking **Skip for later**.
12. Click **Next**.
13. Click **Finish**.

**Related Topics**

- Adding a Confidential Application

**Create an Application for OAuth Implicit Flow**

This topic describes how to create a mobile application for OAuth implicit flow in Oracle Identity Cloud Service.

**Note:** You must create a confidential resource application for Oracle B2B Service in Oracle Identity Cloud Service before following the instructions in this topic. For more information, refer to the Create an Oracle B2B Service Resource Application topic
For detailed instructions on creating mobile applications in Oracle Identity Cloud Service, refer to the Adding a Mobile Application link in the Related Topics.

To create a mobile application for OAuth implicit flow in Oracle Identity Cloud Service:

1. Sign in to your Oracle Identity Cloud Service administration console.
2. Expand the Navigation Drawer, and then click Applications.
3. Click Add.
   The Add Application page appears.
4. Click Mobile Application.
5. In the App Details pane of the Add Mobile Application window, specify a name for the application in the Name field.
6. Click Next to proceed.
   A message confirms that the application has been added in a deactivated state.
7. In the Authorization and Accessing APIs from Other Application sections of the Add Mobile Application page, configure the these fields as follows:
   - Authorization Code. Select this check box.
   - Implicit. Select this check box.
   - Allow non-HTTPS URLs. Select this check box, and specify the redirect URL.
   
   **Note:** If the Oracle JET reference implementation is used, this application already has a callback resource that can be used. For example, the redirect URL would be similar to the following: http://OracleJETApplicationHost:port/?root=callback. If the Oracle JET application is not deployed or developed yet, then this field can be left empty temporarily. Once the application is up and running this setting should be updated before using the Oracle JET application for accessing Oracle B2B Service resources.
8. In the Allowed Scopes section, click Add.
10. Click Next.
11. Click Finish.

Related Topics
- Adding a Mobile Application

Create an Application for JSON Web Token Assertion
Use this topic to create a confidential application for JSON Web Token Assertion in Oracle Identity Cloud Service.

**Note:** You must create a confidential resource application for Oracle B2B Service, and create a mobile application for OAuth implicit flow in Oracle Identity Cloud Service before following the instructions in this topic. For more information, refer to the Create an Oracle B2B Service Resource Application and Create an Application for OAuth Implicit Flow topics.

For detailed instructions on creating confidential applications in Oracle Identity Cloud Service, refer to the in the Adding a Confidential Application link in the Related Topics.

To create a confidential application for JSON Web Token Assertion in Oracle Identity Cloud Service:

1. Sign in to your Oracle Identity Cloud Service administration console.
2. Expand the Navigation Drawer, and then click Applications.
3. Click Add.
The **Add Application** page appears.

4. Click **Confidential Application**.

5. In the **App Details** pane of the **Add Confidential Application** window, specify a name for the application in the **Name** field.

6. Click **Next** to proceed.

A confirmation message indicates that the application has been added in a deactivated state.

7. Click **Configure this application as a client now**, and configure these fields as follows:
   - **Client Credentials**. Select this option.
   - **JWT Assertion**. Select this option.
   - In the **Client Type** section, follow these steps:
     i. Click **Trusted**.
     ii. Click **Import**.
     iii. Specify the certificate file you want to import for use with Oracle JET.
   - In the **Allowed Scopes** section, follow these steps:
     i. Click **Add**.
     ii. Select the Oracle B2B Service instance.

8. Click **Next**.

9. Click **Finish**.

**Related Topics**

- **Adding a Confidential Application**

---

**Set Up the JSON Web Token Application**

**Overview of JSON Web Token Applications**

OAuth JSON web tokens can be used to exchange Oracle Identity Cloud Service access tokens. This is a standalone JSON web tokens Java application that returns JSON web tokens which can be used by the Oracle JET application to fetch access token from Oracle Identity Cloud Service. This is a Java application that runs inside a jetty container exposing a REST API service. This REST API service is deployed on port 8080 and supports the following assertion models:

- **User Assertion**. In this model a non-null JSON web token is returned for user JSON web token and a null value for client (Oracle JET application) JSON web tokens.
- **Client Assertion**. In this model, a non-null JSON web token is returned for both user and client JSON web tokens.

**Prerequisites for Running JSON Web Token Applications**

Before downloading and running the JSON web token application, Maven and Java Development Kit must be installed on the computer on which the application is deployed. The application was developed using the following versions:

- Maven 3.5.4
- Java Development Kit 1.8.0_221

**Note**: After installing the prerequisite software, they must be added to the path.
Compile and Start the JSON Web Token Application

This topic describes how to compile and start the JSON web token application.

After downloading the JSON web token application software run the following commands on the command line, in the stated order:

1. `mvn clean`
   
   This command cleans the project.

2. `mvn install`
   
   This command compiles the code and creates a jar file in the target directory.

3. `java -jar target/JWTAssertionTokens-1.0.jar`
   
   This command starts the jetty server to run on port 8080 with the application deployed.

Test the JSON Web Token Application

This topic describes how to test your JSON web token application.

Once your JSON web token application is running you should verify that it's deployed properly and is in working order by testing some URLs.

**Note:** Alternatively, you can verify the URL using Postman, a free third-party software desktop tool, or any other API testing tool of your choice.

Verify the Output for Client Assertion

Type the following URL into a browser:

```
http://hostname:8080/jwttokens?
userId=username@oracle.com&clientId=ee7323169a7743fa929d94a117b131bb&assertionType=clientAssertion
```

Output similar to the following should be returned for the previously mentioned URL:

```JSON
{
  "userJWTToken":
    "eyJ4NXQjUzI1NiI6InBMqzNBWGE3b1oxVEpJU2JjcVNvX1BxTVM3cDRssV0BLBVCZGhydVBHZFkiiLCJ4NXQiOiIwRDVLV0pSVVL13NUM5UThvV3BmYXpsVA_nMCOnH7g9Wp12HQeB7Ku7INBqnfhsbH88StFgKx8ctJHT90M-
    RVo7DMklQbgocSNHQVMgrL16by7Xx3d35rH7VXe6HnAKQY3b3vmtXgjNPs3CyBbTyOMFmja4E7xuY8Z2m9H3bkXFGTbfqfWbrqH-
    _4VJNK4gWuURpm8a8JhPjXzH3CiUfUEP26Wd5AJJFlUIO2s8thOEqgkmas-2WJZCy4rHtnRjSu3H56GFJ6Fh9Ho1v1PKznByuFYL_58d1IMI7pW8DJ
    "clientJWTToken":
    "eyJ4NXQjUzI1NiI6InBMqzNBWGE3b1oxVEpJU2JjcVNvX1BxTVM3cDRssV0BLBVCZGhydVBHZFkiiLCJ4NXQiOiIwRDVLV0pSVVL13NUM5UThvV3BmYXpsVA_nMCOnH7g9Wp12HQeB7Ku7INBqnfhsbH88StFgKx8ctJHT90M-
    RVo7DMklQbgocSNHQVMgrL16by7Xx3d35rH7VXe6HnAKQY3b3vmtXgjNPs3CyBbTyOMFmja4E7xuY8Z2m9H3bkXFGTbfqfWbrqH-
    _4VJNK4gWuURpm8a8JhPjXzH3CiUfUEP26Wd5AJJFlUIO2s8thOEqgkmas-2WJZCy4rHtnRjSu3H56GFJ6Fh9Ho1v1PKznByuFYL_58d1IMI7pW8DJ
```

Verify the Output for User Assertion

Type the following URL into a browser:

```
http://hostname:8080/jwttokens?
userId=username@oracle.com&clientId=ee7323169a7743fa929d94a117b131bb&assertionType=userAssertion
```

Output similar to the following should be returned for the previously mentioned URL:

```JSON
{
  "userJWTToken":
    "eyJ4NXQjUzI1NiI6InBMqzNBWGE3b1oxVEpJU2JjcVNvX1BxTVM3cDRssV0BLBVCZGhydVBHZFkiiLCJ4NXQiOiIwRDVLV0pSVVL13NUM5UThvV3BmYXpsVA_nMCOnH7g9Wp12HQeB7Ku7INBqnfhsbH88StFgKx8ctJHT90M-
    RVo7DMklQbgocSNHQVMgrL16by7Xx3d35rH7VXe6HnAKQY3b3vmtXgjNPs3CyBbTyOMFmja4E7xuY8Z2m9H3bkXFGTbfqfWbrqH-
    _4VJNK4gWuURpm8a8JhPjXzH3CiUfUEP26Wd5AJJFlUIO2s8thOEqgkmas-2WJZCy4rHtnRjSu3H56GFJ6Fh9Ho1v1PKznByuFYL_58d1IMI7pW8DJ
```

**Oracle**
Referenced Third-Party Libraries

This topic lists the reference third-party libraries.

The following table lists the referenced third-party libraries for JSON web tokens.

<table>
<thead>
<tr>
<th>JAR File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>commons-codec:commons-codec:jar version 1.11</td>
<td>Simple encoder and decoders for various formats such as Base64 and Hexadecimal.</td>
</tr>
<tr>
<td>org.apache.commons:commons-lang3:jar version 3.9</td>
<td>Apache Commons Lang, a package of Java utility classes for the classes that are in the java.lang hierarchy.</td>
</tr>
<tr>
<td>org.junit.jupiter:junit-jupiter-engine.jar version 5.4.2</td>
<td>For unit tests.</td>
</tr>
<tr>
<td>com.fasterxml.jackson.core:jackson-databind.jar version 2.9.9</td>
<td>Jackson is a high-performance JSON processor (parser, generator).</td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-annotations:jar:9.4.15.v2019021</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-continuation:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-http:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-ic:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-jndi:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-plus:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-security:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-server:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-servlet:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-webapp:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-xml:jar:9.4.15.v20190215</td>
<td></td>
</tr>
<tr>
<td>org.eclipse.jetty:jetty-util:jar:9.4.15.v20190215</td>
<td></td>
</tr>
</tbody>
</table>
### JAR File Name | Description
--- | ---
org.eclipse.jetty.toolchain.jet schemas:jart:3.1 | All versions 9.4.15.v20190215

### Run the Oracle JET Application

This topic describes how to run the Oracle JET application.

Once configured, your Oracle JET application is ready for use. We can now build and deploy the Oracle JET application.

To build and deploy the Oracle JET application, run these commands in the stated order:

1. npm install
   - This command installs all npm packages that are necessary for running the Oracle JET application. Run this command whenever there are changes to the packages used by the application
2. ojet build
   - This command builds the Oracle JET application
3. ojet serve
   - This command deploys the Oracle JET application on port 8000.

**Note:** You can deploy your Oracle JET application to a different port by using the command with the following parameter: `--server-port=<port#>`. Where `<port#>` is the port number.

### Configure the Oracle JET Application

Use this topic to configure your Oracle JET application.

After downloading the Oracle JET application, you must configure the javascript file to include site-specific values. The javascript file can be found in the installed directory, at the following path:
The configuration file is seeded with default values that represent the authentication scheme chosen to connect to Oracle B2B Service resources, application endpoints, and timeout values. The following table provides an overview of the configuration parameters that require modifications.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>adminUserForRegn</td>
<td>The user name used by self-signed user registration in conjunction with adminUserPswdForRegn, the password to sign in to Oracle B2B Service.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:firstname.lastname@yourdomain.com">firstname.lastname@yourdomain.com</a></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is used exclusively for self-service registration.</td>
</tr>
<tr>
<td>adminUserPswdForRegn</td>
<td>The password used by self-signed user registration in conjunction with adminUserForRegn, for the user name to sign in to Oracle B2B Service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is used exclusively for self-service registration.</td>
</tr>
<tr>
<td>faInstance</td>
<td>The URL for Oracle B2B Service.</td>
</tr>
<tr>
<td>loginType</td>
<td>A string that represents how your Oracle JET application connects to Oracle B2B Service. These are possible values:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Basic</strong> When the user attempts to login, the user name and password are required.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implicit</strong> Uses the OAuth Implicit grant type flow. This method is browser-based, where a user is redirected to the identity provider to sign in. With this method, the user consents to allowing Oracle B2B Service to access resources on their behalf.</td>
</tr>
<tr>
<td></td>
<td>• <strong>UserAssertion</strong> Uses JSON web tokens provided by a jetty-based server application. The JSON web tokens are used as user information. The client ID and client secret are used to represent the application.</td>
</tr>
<tr>
<td></td>
<td>• <strong>ClientAssertion</strong> - Uses JSON web tokens provided by a jetty-based server application. JSON web tokens are used for the user and client.</td>
</tr>
<tr>
<td>authzEndpoint</td>
<td>The URL for the Oracle Identity Cloud Service authorize endpoint.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><a href="https://IDCSservice/oauth2/v1/authorize">https://IDCSservice/oauth2/v1/authorize</a></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property is used only when loginType is set to Implicit.</td>
</tr>
<tr>
<td>idcsTokenEndpoint</td>
<td>The URL for the Oracle Identity Cloud Service token endpoint.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td>redirectUri</td>
<td>The URL for the Oracle JET application callback endpoint.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><a href="http://OJETApplication:portnumber/?root=callback">http://OJETApplication:portnumber/?root=callback</a></td>
</tr>
<tr>
<td>clientId</td>
<td>The string representing the Oracle Identity Cloud Service application ID.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>8dab63f5fc204a3582c80fc76ccba1e3</td>
</tr>
<tr>
<td>scope</td>
<td>The URL representing the Oracle B2B Service instance.</td>
</tr>
<tr>
<td>assertionClientId</td>
<td>The string representing the Oracle Identity Cloud Service application ID of a confidential application.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>he7323169a7743fa929d94a117b138bb</td>
</tr>
<tr>
<td>clientSecret</td>
<td>The string representing the Oracle Identity Cloud Service application client secret.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>64f25f01-b7d7-4a50-9b30-9ea9c8967c8b</td>
</tr>
<tr>
<td>jwtToken</td>
<td>The URL for the Oracle JET application endpoint.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td><a href="http://JWTTokensAppHost:portnumber/jwttokens">http://JWTTokensAppHost:portnumber/jwttokens</a></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This property can be left blank when <code>loginType</code> is set to <strong>Implicit</strong> or <strong>Basic</strong>.</td>
</tr>
<tr>
<td>serviceRequestResource</td>
<td>The path for service request resources.</td>
</tr>
<tr>
<td></td>
<td>For example:</td>
</tr>
</tbody>
</table>

Implement Chat Inlay

Overview of the Chat Inlay

This topic describes how to configure the Chat inlay for Digital Customer Service.

Chat inlays are syndicated widgets that you can deploy on any web page. The Chat inlay markup can be put on any page in the Digital Customer Service application. The Chat inlay is a chat session that occurs between a chat agent and an end user. It can be initiated from a chat offering such as a Conditional Chat link or a Proactive Chat as well as being simply placed on a page. To use chat inlay you must enable a number of profile options.

For additional information about Chat inlay, refer to the Related Topics. The cross-reference in the Related Topics refer to Oracle B2B Service documentation. Clicking the link will redirect you to the Oracle B2B Service Customer Portal.

1. Sign in to B2B Service as administrator or setup user.
2. In the Setup and Maintenance work area, go to the following:
   ○ Offering: Service.
   ○ Task: Manage Digital Customer Service Profile Options.
3. Use the following table to set values for each of the profile options listed:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORS_ACCESS_CONTROL_ALLOW_HEADERS</td>
<td>Specifies comma-separated list of headers that are allowed as part of a CORS request.</td>
<td>None</td>
<td>Add these values if they're not present:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Puds-Access-Token for the proxy user data service</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• kmauthtoken</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• content-language</td>
</tr>
</tbody>
</table>
### Profile Option
**Description**
**Default Value**
**Comments**

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
<th>Default Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORACLE.ADF.VIEW.ALLOWED_ORIGINS</td>
<td>List of trusted domains that can make requests.</td>
<td>None</td>
<td>* or specific comma-separated FQDNs.</td>
</tr>
<tr>
<td>SVC_CHAT_INLAYS_ACCESS_ENABLED</td>
<td>Enable access for chat inlays to get the bootstrap configuration.</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SVC_CHAT_ANONYMOUS_ACCESS_ENABLED</td>
<td>Enable anonymous chat access for end users.</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SVC_CHAT_WAIT_TIME_ENABLED</td>
<td>Enable a wait time for chat.</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**
- Inlay Registry Documentation

### Configure Chat Inlay on any HTML Page

To configure the Chat inlay on any web page edit the page's HTML to add the chat inlay markup and JavaScript loader.

1. Add markup to the HTML page on which the Chat inlay will reside.

   ```html
   <inlay-oracle-chat-embedded id="chatInlay" class="inlay"
   site-url="[Oracle Cloud Applications Instance URL]" site-type="ec">
   </inlay-oracle-chat-embedded>
   ``

   The attribute value "[Oracle Cloud Applications Instance URL]" shown in the previous example represents the fully qualified domain name of the host of the Oracle B2B Service instance. Replace the value in the example, with your own Oracle Cloud Applications Instance URL. Here’s an example of the markup:

   ```html
   <inlay-oracle-chat-embedded id="chatInlay" class="inlay"
   site-url="acme-test.fa.us2.oraclecloud.com" site-type="ec">
   </inlay-oracle-chat-embedded>
   ```

   | Note: For the Chat inlay to work with Oracle B2B Service, you must set the site-type to "ec". |

2. Add a script tag on the page that you configured in step 1. Use the following script tag as an model:

   ```html
   <script id="oit-loader"
   src="http://static-XX.custhelp.com/s/oit/latest/common/v0/libs/oit/loader.js" async"></script>
   ``

   Replace the xx in the script tag with data center location code that's geographically closest to you.
### Data Center Location

<table>
<thead>
<tr>
<th>Data Center Location</th>
<th>Data Center Location Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chicago</td>
<td>mw</td>
</tr>
<tr>
<td>Washington DC</td>
<td>va</td>
</tr>
<tr>
<td>Phoenix</td>
<td>px</td>
</tr>
<tr>
<td>Toronto</td>
<td>tr</td>
</tr>
<tr>
<td>Calgary</td>
<td>cg</td>
</tr>
<tr>
<td>Brazil</td>
<td>br</td>
</tr>
<tr>
<td>Amsterdam</td>
<td>am</td>
</tr>
<tr>
<td>Germany</td>
<td>de</td>
</tr>
<tr>
<td>London</td>
<td>gb</td>
</tr>
<tr>
<td>Japan</td>
<td>jp</td>
</tr>
<tr>
<td>Australia</td>
<td>sy</td>
</tr>
<tr>
<td>Singapore</td>
<td>sg</td>
</tr>
</tbody>
</table>

**Related Topics**

- Inlay Registry Documentation

**Add the Chat Inlay to the Digital Customer Service Shell**

Use this task to replace chat in the Digital Customer Service shell with the chat inlay.

1. In Visual Builder, click the Web Applications icon, then expand your Digital Customer Service application.
2. Expand the **Root Pages** node, and select **shell**.
3. Click the **Code** button to display the underlying code.

4. Add the inlay to the shell page where the existing `oj-odcs-chat` component is.

5. Within the code palate, search for the following existing `oj-odcs-chat` entry and remove it:

   ```html
   <inlay-oracle-chat-embedded id="inlay1" inlay-hidden="false" polling-enabled="false" persistence-enabled="false" site-url="" site-type="ec" class="inlay">inlay-oracle-chat-embedded>
   ```

6. Add the following script to initialize the inlay to `shell-page.js`:

   ```javascript
   PageModule.prototype.initializeInlays = function(faHost){
     $('#inlay1').attr('site-url', faHost);
     $('#inlay1').after('<script id="oit-loader" src="http://static-XX.custhelp.com/s/oit/latest/common/v0/libs/oit/loader.js" async="true"></script>');
   };
   ```

7. Add a `vbEnter` event handler that invokes an action chain to call the `initializeInlays` module function.

Enable Profile Options for the Chat Inlay

Now you enable profile options to enable chat inlays, allow anonymous access and enable the wait time setting.

1. In the Setup and Maintenance work area, click the **Tasks** icon, and then click the **Search** link.

2. In the Search field, enter **Manage Administrator Profile Values**.

3. Click the link for the task.

4. To enable inlay interactions do the following:
   a. In the Manage Administrator Profile Values work area, enter the following in the Profile Option Code field: **SVC_CHAT_INLAYS_ACCESS_ENABLED** and click **Search**.
   b. Set the Profile Value field to **Yes**.
   c. Click **Save**.

5. To enable anonymous access do the following:
   a. In the Profile Option Code field, enter: **SVC_CHAT_ANONYMOUS_ACCESS_ENABLED**, and click **Search**.
   b. Set the Profile Value field to **Yes**.
   c. Click **Save**.

6. To enable the wait time setting do the following:
   a. In the Profile Option Code field, enter: **SVC_CHAT_WAIT_TIME_ENABLED**, and click **Search**.
   b. Set the Profile Value field to **Yes**.
   c. Click **Save**.
Create an Application for Self-Service Optimization with Pre-20C Template

Enable the Implicit Grant in the Digital Customer Service Application

If you're using a template prior to 20C, you may need to perform this step. Enable the implicit grant in the Digital Customer Service applications security settings by doing the following:

1. In Visual Builder, open the Digital Customer Service application.
2. From the navigator panel, select the Web Applications icon.
3. Select dcs from the list.
4. Click the dcs tab in the work area.
5. Click the Security sub tab, and make sure Enable implicit grant is selected.

Create Development and Production Application Profiles

Use this task to create Development and Production application profiles.

1. In Visual Builder, open your Digital Customer Service application.
2. Click the Settings tab, then click the Application Profiles sub tab.
3. For the Default application, click Rename.
4. In the Name field, enter Development.
5. In the Description field, enter Default development profile.
6. Click Save Changes.
7. Click the Duplicate button, and enter the following values:
   - Name: Production
   - ID: Production
   - Description: Default production profile
8. Click Duplicate.
9. Click the menu beside either the Development profile or the Production profile and choose the following options:
   - For Development, choose Make development default.
   - For Production, choose both Make stage default, and Make publish default.
10. Map the user roles for the new Production profile.
11. Complete the Add Mappings to User Roles from chapter 4, adding the Production profile role.

Related Topics
- Add Mappings to User Roles
Set Up Service Connections

Now you set up REST API connections.

Configure crmRestApi

First you configure the crmRestApi.

1. Navigate to your Oracle Visual Builder.
2. Open your Digital Customer Service application.
3. Click Service Connections, click crmRestApi, and then click the Servers tab.
4. Click the Copy icon to make a copy the production server. This server has the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter this information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance URL</td>
<td>vb-catalog://backends/fa/proxy/crmRestApi/resources/11.13.18.05</td>
</tr>
<tr>
<td>Description</td>
<td>Production Server.</td>
</tr>
<tr>
<td>Application Profiles</td>
<td>Production.</td>
</tr>
<tr>
<td>Add custom header</td>
<td>VB-Alt-Authorization-Header-Name with value Puds-Access-Token.</td>
</tr>
<tr>
<td>Authentication for logged-in users</td>
<td>Propagate Current User Identity.</td>
</tr>
<tr>
<td>Authentication for anonymous users</td>
<td>None.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Dynamic, the service supports CORS.</td>
</tr>
</tbody>
</table>

5. For the original server (the server you just copied) click the Edit icon and enter the required information listed in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter this information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance URL</td>
<td>Keep the URL value.</td>
</tr>
<tr>
<td>Description</td>
<td>Development Server</td>
</tr>
<tr>
<td>Application Profiles</td>
<td>Development</td>
</tr>
<tr>
<td>Security</td>
<td>Select the Allow anonymous access to the Service Connection Infrastructure check box.</td>
</tr>
<tr>
<td>Authentication for logged-in users</td>
<td>a. Select Basic from the drop down list.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Enter User name and password icon in the User name field, and then enter the developer APPID and password, and then click Save.</td>
</tr>
</tbody>
</table>
Field | Enter this information
--- | ---
| Note: See Related Topics. In the Set Up Administrators and Developers topic, you will find instructions on setting up the Developer APPID.

Authentication for anonymous users | Click the drop down list, and select Same as Authenticated User.

Connection type | Select Always use proxy irrespective of CORS support.

6. Click **Save**.

Configure the fscmRestApi (Optional)
If your Digital Customer Service application has an fscmRestApi then perform the following steps.

1. In Oracle Visual Builder, open your Digital Customer Service application (if it’s not already open).
2. Click Service Connections, click **fscmRestApi**, and then click the **Servers** tab.
3. Click the **Copy** icon to make a copy the production server. This server has the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter this information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance URL</td>
<td>The URL value of your instance.</td>
</tr>
<tr>
<td>Description</td>
<td>Production Server.</td>
</tr>
<tr>
<td>Application Profiles</td>
<td>Production.</td>
</tr>
<tr>
<td>Add custom header</td>
<td>VB-Alt-Authorization-Header-Name with value Puds-Access-Token.</td>
</tr>
<tr>
<td>Authentication for logged-in users</td>
<td>Propagate Current User Identity.</td>
</tr>
<tr>
<td>Authentication for anonymous users</td>
<td>None.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Dynamic, the service supports CORS.</td>
</tr>
</tbody>
</table>

4. For the original server (the server you just copied) click the **Edit** icon and enter the required information listed in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter this information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance URL</td>
<td>Keep the URL value.</td>
</tr>
</tbody>
</table>
Create an Application with the Standard Digital Customer Service Configuration with a 20C Template or Later

Create an Application with the Standard Digital Customer Service Configuration with a 20C Template or Later

To create a standard Digital Customer Service application that’s not enabled with Self-Service Optimization, using the 20C template, use these tasks.

**Set the Default Application Profile**
First, you make the Default application profile the default for development, stage and publish.

1. Sign in to Oracle Visual Builder as an administrator.
2. Click the Menu icon, and select Settings.
3. From the Settings page, click the Application Profiles tab.
4. In the Default entry, expand the menu and do the following:
   a. Select Make development default.
   b. Select Make stage default.
   c. Select Make publish default.

**Map the Application User Roles**
Now you map the application user roles for the Default application profile.

1. In Visual Builder, ensure the Default application is opened.
2. Click the Menu icon, and select Settings.
3. Click the User Roles tab.
4. Click the Application Profile drop down list, and select Default.
5. Refer to the Add Mappings to User Roles topic in the Mandatory Setup Tasks chapter.
6. Add the Customer Self-Service User mapping:
   a. On the User card, click Assign groups or users.
      The Change Assignments dialog box is displayed.
   b. In the list of available mappings, search for the following string:
      Customer Self-Service User
   c. Click the plus sign (+) next to Customer Self-Service User.
   d. Click Save Changes.
7. Add the Customer Self-Service Account Administrator mapping:
   a. On the Account_Administrator card, click Assign groups or users.
      The Change Assignments dialog box is displayed.
   b. In the list of available mappings, search for the following string:
      Customer Self-Service Account Administrator
   c. Click the plus sign (+) next to Customer Self-Service Account Administrator.
   d. Click Save Changes.

Configure Service Authentication
And the final step is to configure service authentication.
1. In the Visual Builder Settings workspace, click the Services tab.
2. From the Backends list, select Oracle Cloud Applications.
4. Click the Enter user name and password icon by the User name field.
5. In the User name field, enter the user name of the APPID user.
6. In the Password field, enter the B2B Service password for the APPID user.
# 12 Performance

## Performance Tuning Checklist

Here's a collection of performance tuning tips. They're listed in no particular order of importance but can be considered once your Digital Customer Service application is up and running.

<table>
<thead>
<tr>
<th>Potential Issue</th>
<th>Performance Tuning Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>The application is slow because it has not been bundled and minified for deployment.</td>
<td>Refer to the Related Topics area for a link to the Optimize Your Application for Deployment topic.</td>
</tr>
<tr>
<td>Large images take too much time to load and are then scaled down for the section of screen within which they're displayed.</td>
<td>Reduce the size of images to the size needed for the UI presentation. Optimize the image for the usage in the UI presentation either by size or quality, balancing small file size against acceptable quality.</td>
</tr>
<tr>
<td>Application load times are slow when the client region is far from the data center location of the deployment.</td>
<td>Deploy the application to global Content Delivery Network (CDN). Visual Builder's CDN functionality sets the base href of the application to the CDN server to ensure all resources are correctly loaded from the CDN. As a result relative URLs including anchor references will be resolved relative to the base href value.</td>
</tr>
<tr>
<td>For application navigation it's recommended you use the Visual Builder navigate action and the DCS navigate event. Where href=&quot;#&quot; has been used as a placeholder it should be replaced with href=&quot;javascript:;&quot;.</td>
<td>To navigate to an anchor within a page you will need to use <code>&lt;a href=&quot;javascript:;&quot; onclick=&quot;document.location.hash='myanchor';&quot;&gt;</code>. Refer to the Related Topics section for a link to the topic Host an Application on a Content Delivery Network (CDN).</td>
</tr>
<tr>
<td>Page navigation is slow because of URL links and results which are reloading the entire application with each navigation.</td>
<td>Do page navigation with navigation events. For information on using your Navigation Action to assist in tuning navigation between pages in a flow, and to root pages, see the Related Topics section for the Navigate Action topic in the Developer Applications with Oracle Visual Builder guide.</td>
</tr>
<tr>
<td>REST calls are slowing page navigation.</td>
<td>• Reduce the number of REST calls that need to be made on each page.</td>
</tr>
<tr>
<td>Potential Issue</td>
<td>Performance Tuning Tip</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>There have been cases when multiple copies of jQuery are being loaded, unnecessarily.</td>
<td>• Be careful not to create heavyweight back end triggers that can cause REST APIs to slow down.</td>
</tr>
<tr>
<td>Service worker scripts cause performance degradation.</td>
<td>Ensure that there are no files being loaded unnecessarily.</td>
</tr>
<tr>
<td></td>
<td>Disable service workers if they are enabled.</td>
</tr>
<tr>
<td></td>
<td>You can completely disable the loading of the service worker script by adding the following to your index.html file:</td>
</tr>
<tr>
<td></td>
<td>&lt;!-- visualBuilderScripts --&gt;:</td>
</tr>
<tr>
<td></td>
<td>&lt;script type=&quot;text/javascript&quot;&gt;</td>
</tr>
<tr>
<td></td>
<td>window.vbInitConfig.SERVICE_WORKER_CONFIG = {</td>
</tr>
<tr>
<td></td>
<td>disabled: true</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>&lt;/script&gt;</td>
</tr>
<tr>
<td>When a record is created or updated performance is degraded with the back and forth from the server which calculates all fields each time.</td>
<td>Turn off unnecessary responses for POST and PATCH operations.</td>
</tr>
<tr>
<td></td>
<td>Most create and update operations don’t require a response from the server so the responsiveness of both the CSP and CSE applications could be improved by turning them off.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Limit the size of response payloads by using the fields= parameter in the request.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Use the onlyData parameter and set it to True.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Combine multiple API requests into single requests when possible</td>
</tr>
<tr>
<td></td>
<td>• When many fields are needed in the response, use the expand= parameter on child settings.</td>
</tr>
<tr>
<td></td>
<td>• Use the fields= parameter to return the children and grandchildren records with identified field of interest.</td>
</tr>
<tr>
<td></td>
<td>• Use Upsert-Mode: true command to update or insert during POST to avoid multiple calls to check for an update versus an insert operation.</td>
</tr>
<tr>
<td>Slow performance</td>
<td>Configure bundle modules</td>
</tr>
<tr>
<td></td>
<td>You can minimize what needs to be loaded on initial load by loading only the bundle that contains files needed on initial startup.</td>
</tr>
</tbody>
</table>
Optimize Your Application for Deployment

Your Digital Customer Service application can be optimized for deployment.

You can optimize the performance of your published Digital Customer Service application by using node and Grunt to build them locally or to set up build jobs on Oracle Developer Cloud Service. For more information about optimizing your application, refer to the Optimize Your Builds topic in the Developing Applications with Oracle Visual Builder guide.
## 13 Troubleshooting

Troubleshooting

The following table lists issues to consider when troubleshooting your implementation.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Source</th>
<th>Error Message</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP Status: 401</td>
<td>Apps log</td>
<td>[2019-08-27 23:14:968+00:00] [ServiceServer_1] [ERROR] [oracle.apps.appslogger] [tid: 30] [userld: anonymous] [ecid: 005^H09G#V5EH5rtlf0002u5] [APP: ORA_CRM_SERVICESAPP#V2.0.m] [APPS_USER_NAME: DCS_Proxy_Anon_User] [APPS_SESSION_ID: 90DOESC0BF61D1E053D711F10] [APPS_THREAD_NAME: [ACTIVE].ExecuteThread: '15' for queue: 'weblogic.kernel.Default (self-tuning)'] [APPS_AUTO_LOG: false] [APPS_USER_ID: null] [APPS_DB_CONNECTION_URL: jdbc:oracle:thin:@FA_DEFAULT] [APPS_SOURCE: crm.service.css.pojo.utils.CssLogger</td>
<td>oracle.apps.crm.service.css.pojo.proxy.helpers.FARestHandler] [The response status was 403, Reason: Forbidden]</td>
</tr>
<tr>
<td>HTTP Status: 401</td>
<td>Apps log</td>
<td>[2020-05-07 23:14:968+00:00] [ServiceServer_1] [ERROR] [oracle.apps.appslogger] [tid: 36] [userld: anonymous] [ecid: 005dtH9F50303035RnX8b0004E] [APP: ORA_CRM_SERVICESAPP#V2.0.m] [APPS_USER_NAME: PUDS_ANONYMOUS_USER] [APPS_SESSION_ID: 96CFACB2A95123E03594E3C0] [APPS_THREAD_NAME: [ACTIVE].ExecuteThread: '21' for queue: 'weblogic.kernel.Default (self-tuning)'] [APPS_AUTO_LOG: false] [APPS_USER_ID: null] [APPS_DB_CONNECTION_URL: jdbc:oracle:thin:@FA_DEFAULT] [APPS_SOURCE: crm.service.css.pojo.utils.CssLogger</td>
<td>oracle.apps.crm.service.css.pojo.proxy.helpers.FARestHandler]</td>
</tr>
</tbody>
</table>
Error Code | Error Source | Error Message | Suggestions
--- | --- | --- | ---
 | Browser Log | Access to fetch at 'https://acme-test.fa.us2.oraclecloud.com/proxy.crmRestApi/11.13.18.05/chatAuthenticate' from origin 'https://odcsmaster-odcs11ocipool1.builder.dev.ocp.ott.com' has been blocked by CORS policy: Response to preflight request doesn't pass access control check: No 'Access-Control-Allow-Origin' header is present on the requested resource. If an opaque response serves your needs, set the request's mode to 'no-cors' to fetch the resource with CORS disabled. | Check the value of profile option CORS_ACCESS_CONTROL_ALLOW_HEADERS which much include the following: kmauthtoken, puds-access-token, content-language, X-Oracle-ABCS-Sessionid, X-Oracle-ABCS-Userld.
 |  | response status was 403, Reason: Forbidden | Make sure that the Service Base URL is correct:
 | HTTP Status: 403 | | vb-catalog://backends/fa/proxy/crmRestApi/resources/11.13.18.05

The following table lists potential problems outside of error messages.

<table>
<thead>
<tr>
<th>Problem Description</th>
<th>Solution</th>
</tr>
</thead>
</table>
| There's an issue with the Google Chrome browser and user log in continually looping. Chrome has a 4k limit on cookie sizes. If the user has a very long first and last name that combination can cause the cookie that's generated to be larger than 4k. Chrome will only accept the first 4k of the cookie, making it incomplete. This results in the login process continually looping. Firefox doesn't have the 4k cookie limit and can be used to verify that this is the issue. For example the following details would cause the cookie to be too large: | Reduce the size of the First and last names. For example
- First name: Self
- Last name: user
- Email address: selfserviceuser@mycompany.com

**Note:** The email address can stay the same. This is performed in Identity Cloud Service by updating the user facing the issue.

Oracle CX Service
Implementing Digital Customer Service
Chapter 13
Troubleshooting
140
### Problem Description

- Last name: selfserviceuser@mycompany.com
- Email address: selfserviceuser@mycompany.com

### Solution

---

**Related Topics**

- Add Visual Builder Roles